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Trademarks 
Unigraf, UCD, UCD-400, UCD-411, UCD-422, UCD-412, UCD-424, UCD-451, UCD-452, UCD 

Console and TSI are trademarks of Unigraf Oy. 

DisplayPort™ and the DisplayPort™ logo are trademarks owned by the  

Video Electronics Standards Association (VESA®) in the United States and other countries. 

The Adopted Trademarks HDMI, High-Definition Multimedia Interface, the HDMI Logo and HDMI Port 

Logo are trademarks or registered trademarks of HDMI Licensing Administrator, Inc. in the United 

States and other countries. 

USB™, USB Type-C™ and USB-C™ are trademarks of USB Implementers Forum Inc. 

HDCP is a trademark of Digital Content Protection LLC. 

Altera and Intel FPGA are trademarks of Intel Corporation or its subsidiaries in the U.S. and/or other 

countries. 

Windows® is trademark of Microsoft Corporation. 

macOS® is a trademark of Apple Inc. 

Linux® is a trademark of Linus Torvalds. 

All other trademarks are properties of their respective owners. 

Limited Warranty 
Unigraf warrants its hardware products to be free from defects in workmanship and materials, under 

normal use and service, for twelve (12) months from the date of purchase from Unigraf or its 

authorized dealer. 

If the product proves defective within the warranty period, Unigraf will provide repair or replacement 

of the product. Unigraf shall have the whole discretion whether to repair or replace, and replacement 

product may be new or reconditioned. Replacement product shall be of equivalent or better 

specifications, relative to the defective product, but need not to be identical. Any product or part 

repaired by Unigraf pursuant to this warranty shall have a warranty period of not less than 90 days, 

from the date of such repair, irrespective of any earlier expiration of original warranty period. When 

Unigraf provides replacement, then the defective product becomes the property of Unigraf. 

Warranty service may be obtained by contacting Unigraf within the warranty period. Unigraf will 

provide instructions for returning the defective product. 

CE Mark 
UCD-4XX Series products meet the essential health and safety requirements, is in conformity with 

and the CE marking has been applied according to the relevant EU Directives using the relevant 

section of the corresponding standards and other normative documents. 
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 ABOUT THIS MANUAL 

Purpose 
This guide is a User Manual of UCD-4XX test devices, that are USB-connected video interface test 

units for use with a computer. 

The purpose of this guide is to 

• Provide an overview of the product and its features. 

• Provide instructions for the user on how to install the software and the drivers. 

• Provide instructions for the user on how to update the FW of the unit. 

• Introduce the HW features of the UCD-4XX units. 

• Provide instructions for the user on how to use UCD Console SW. 

Product and Software Version 
This manual explains features found in UCD Console SW Bundle 3.5. Please consult Unigraf for 

differences or upgrades of previous versions.  

Please consult the Release Notes document in the installation package for details of the SW and FW 

versions and changes to previous releases. 

Notes 
On certain sections of the manual, when important information or notification is given, text is formatted 

as follows. Please read these notes carefully. 

Note: This text is an important note 

 

Warning: This is a warning about a direct risk for the functionality of the device 
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 INTRODUCTION 

Product Description 

USB-Connected Test Equipment 

UCD-4XX devices are high speed, USB 3.0 connected video interface test units. UCD-4XX units 

include the following models: 

• UCD-400  DisplayPort 1.4a Analyzer and Generator 

• UCD-411  DisplayPort 1.4a Generator 

• UCD-412  HDMI 2.1 Generator 

• UCD-422  HDMI 2.1 Analyzer and Generator 

• UCD-424  USB-C DisplayPort Alt mode Analyzer and Generator 

UCD Console SW is a common graphical user interface (GUI) for Unigraf’s UCD test devices. The 

outlook and details of UCD Console SW will vary depending on the capabilities of the connected unit 

and will reflect the features enabled.  

UCD-4XX units feature a high-level Software Development Kit (SDK) called Test Software Interface 

(TSI) for use in automated testing. TSI allows for an easy integration of Production and R&D testing 

routines into an automated test system environment. Please refer to TSI documentation found in 

additional Unigraf manuals for more details. 

Stand-Alone Test Equipment 

In stand-alone UCD models the test equipment is built inside a PC and the control interface is a PCI 

bus instead of a USB connection. Please find below a list of available units: 

• UCD-451  Stand-alone DisplayPort 1.4a Generator 

• UCD-452  Stand-alone HDMI 2.1 Generator 
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UCD-400 and UCD-411 

Product Features 

• UCD-400: Reference Sink and Source for verifying DP connected devices. 

• UCD-411: Reference Source for verifying DP connected sinks. 

• DisplayPort 1.4a compliant with HBR3 support 

• High resolution video up to 8K 30 Hz, 4K / UHD 120 Hz uncompressed and audio. 

• Supports MST (4 streams), Adaptive-Sync, Forward Error Correction (FEC), Display Stream 

Compression (DSC) and Link Training Tunable PHY Repeater (LTTPR) 

• Compatible with HDCP versions 1.3 and 2.3 

• 2 GB on-board high-speed video frame buffer 

• High speed USB 3.0 host PC interface 

Please refer to Product Specifications in the appendix of this document for details. 

Functional Description 

UCD-400 units consist of a multimedia signal input stage with on-board frame buffer, an internal 

pattern generator, a control stage, and a PC interface stage. In the Input Stage the signal is 

conditioned and converted to desired format. The Interface and Control stages are either passing the 

captured data directly to the USB interface or storing it to the frame buffer. The internal pattern 

generator is able to source a signal for testing sink and branch units. The Interface & Control stages 

are receiving instructions from the host PC to configure and control the functionality of the unit. 

Delivery Content 

Product shipment contains: 

• The UCD-400 or UCD-411 unit 

• AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +12 Vdc output)  

• USB 3.0 compliant cable for host PC connection 

• Micro-USB type B compatible cable for FW programming 

• USB-C to DP Bi-directional Cable for testing USB-C sinks or sources 

USB Type-C Interface 

UCD-400 and UCD-411 delivery package includes a “C to DP Bi-directional Cable” to enable testing 

of Sink or Source devices with USB-C interface. 

UCD    
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Connections 

The image below indicates the connections in UCD-400 unit and their description. 

Name Description 

DP in DisplayPort™ 1.4a compliant input from the upstream Source 

(UCD-411 Not available) 

DP out DisplayPort™ 1.4a compliant output to the downstream Sink 

Power in +12 Vdc Power Supply Input 

Power On/Off Rocker power switch 

USB USB 3.0 connection to the host PC 

Programmer USB interface for configuring the device FW (behind a cover) 

Ethernet Ethernet interface for updating the device FW (behind a cover) 

 

Note: Capturing and sourcing high resolution video modes, especially 4K video modes and the 120 Hz 

frame rate set stringent requirements on the video cables and connectors.  

 

Warning: In order to avoid damage to the unit and the PC, please always attach the power cord (Power In) 

to the unit first, and after that connect the USB cable to the PC. 
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UCD-412 and UCD-422 

Product Features 

• UCD-422: Reference Sink and Source for verifying HDMI connected devices. 

• UCD-412: Reference Source for verifying HDMI connected sinks. 

• HDMI 2.1 compatible. Supports FRL and TMDS signaling. 

• Supports HDMI video and audio up to 10K@30 Hz, 8K@60 Hz (YCbCr 4:2:0),  

4K@120 Hz (YCbCr 4:2:0) 

• Supports Display Stream Compression (DSC), and Enhanced Audio Return Channel (eARC) 

• Compatible with HDCP versions 1.4 and 2.3 

• 2 GB on-board high-speed video frame buffer 

• High speed USB 3.0 host PC interface 

Please refer to Product Specifications in the appendix of this document for details. 

Functional Description 

UCD-422 units consist of a multimedia signal input stage with on-board frame buffer, an internal 

pattern generator, a control stage, and a PC interface stage. In the Input Stage the signal is 

conditioned and converted to desired format. The Interface and Control stages are either passing the 

captured data directly to the USB interface or storing it to the frame buffer. The internal pattern 

generator is able to source a signal for testing sink and branch units. The Interface & Control stages 

are receiving instructions from the host PC to configure and control the functionality of the unit. 

Please find below logical diagram of UCD-422 unit 

Delivery Content 

• Product shipment contains: 

• The UCD-422 or UCD-412 unit 

• AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +12 Vdc output)  

• USB 3.0 compliant cable for host PC connection 

• HDMI 2.1 grade HDMI cable 

• Micro-USB type B compatible cable needed for FW programming. 

• Ethernet cable needed for FW programming. 

 

UCD    
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Connections 

The image below indicates the connections in UCD-422 unit and their description. 

Name Description 

HDMI in HDMI 2.1 compliant input from the upstream Source 

HDMI out HDMI 2.1 compliant output to the downstream Sink 

Power in +12 Vdc Power Supply Input 

Power On/Off Rocker power switch 

USB USB 3.0 connection to the host PC 

Programmer USB interface used in device FW update (behind a cover) 

Ethernet Ethernet interface used in device FW update (behind a cover) 

 

Note: Capturing and sourcing high resolution video modes, especially 4K 8K and 10K video modes and the 

120 Hz frame rate set stringent requirements on the video cables and connectors.  

 

Warning: In order to avoid damage to the unit and the PC, please always attach the power cord (Power In) 

to the unit first, and after that connect the USB cable to the PC. 
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UCD-424 

Product Features 

• Reference Sink and Source for verifying DisplayPort™ Alt Mode over USB-C  

• USB-C v1.3 input and output with Power Delivery 3.0 

• DisplayPort 1.4a compliant with HBR3 support 

• High resolution video up to 8K 30 Hz, 4K / UHD 120 Hz uncompressed and audio 

• Supports MST (4 streams), Adaptive-Sync, Forward Error Correction (FEC), Display Stream 

Compression (DSC), and Link-Training Tunable PHY Repeater (LTTPR) 

• Compatible with HDCP versions 1.3 and 2.3 

• 2 GB on-board high-speed video buffer 

• High speed USB 3.0 host PC interface 

Please refer to Product Specifications in the appendix of this document for details. 

Functional Description 

UCD-424 units consist of a multimedia signal input stage with on-board frame buffer, an internal 

pattern generator, a control stage, and a PC interface stage. In the Input Stage the signal is 

conditioned and converted to desired format. The Interface and Control stages are either passing the 

captured data directly to the USB interface or storing it to the frame buffer. The internal pattern 

generator is able to source a signal for testing sink and branch units.  

USB Data bypass can be enabled between the USB-C connector attached to the DUT to an external 

device connected to the vacant USB-C connector. 

The Interface & Control stages are receiving instructions from the host PC to configure and control 

the functionality of the unit. 

Delivery Content 

Product shipment contains: 

• The UCD-424 unit 

• AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +12 Vdc output)  

• USB 3.0 compliant cable for host PC connection 

• USB-C to USB-C USB 3.2 Gen2 e-marked cable 

• USB-C to DP Bi-directional Cable for testing DP sinks or sources. 
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Connections 

The image below indicates the connections in UCD-424 unit and their description. 

Name Description 

USB-C DP Tx USB-C connection with DisplayPort™ 1.4a Alt Mode upstream 

Source capability 

USB-C DP Rx USB-C connection with DisplayPort™ 1.4a Alt Mode downstream 

Sink capability 

USB USB 3.0 connection to the host PC 

Power in +12 Vdc Power Supply Input 

Power On/Off Rocker power switch 

Programmer Optional USB interface for configuring the device FW (behind a 

cover) (Not used by default) 

Ethernet Optional Ethernet interface for updating the device FW (behind a 

cover) (Not used by default) 

 

Note: Capturing and sourcing high resolution video modes, especially 4K, 8K and 10K video modes and 

the 120 Hz frame rate set stringent requirements on the video cables and connectors.  

 

Warning: In order to avoid damage to the unit and the PC, please always attach the power cord (Power In) 

to the unit first, and after that connect the USB cable to the PC. 
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UCD-451 
UCD-451 is a stand-alone DisplayPort interface test unit with full featured Generator functionality. 

UCD-451 contains a built-in PC, a DisplayPort reference source, and software for configuring the test 

interface and running tests.  

UCD-451 is designed to specially facilitate Dolby Vision™ testing in DisplayPort interface. 

Product Features 

• DisplayPort 1.4a compliant with HBR3 support 

• 8K Dolby Vision™ Test Tool 

• High resolution video up to 8K 30 Hz, 4K / UHD 120 Hz uncompressed and audio. 

• Supports MST (4 streams), Adaptive-Sync, Forward Error Correction (FEC), Display Stream 

Compression (DSC) and Link Training Tunable PHY Repeater (LTTPR) 

• Compatible with HDCP versions 1.3 and 2.3 

• Extended video memory up to 32 GBytes 

• Embedded Windows PC 

 

Please refer to Product Specifications in the appendix of this document for details. 

Functional Description 

Part of the DDR memory in the PC motherboard is locked and reserved for storing the playback 

content. During playback, content is first loaded from hard disk (HDD) to the RAM memory of the PC 

(DDR). Video frames are then sequentially transferred from PC RAM to pattern generator’s internal 

playback memory via PCIe bus. Pattern Generator firmware triggers a PCIe transfer to request 

content when needed. 

Please find below logical diagram of UCD-451 unit. 
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UCD-452 
UCD-452 is a stand-alone HDMI interface test unit with full featured Generator functionality. UCD-452 

contains a built-in PC, a HDMI reference source, and software for configuring the test interface and 

running tests.  

UCD-452 is designed to specially facilitate Dolby Vision™ testing in HDMI interface. 

Product Features 

• HDMI 2.1 compatible Test Equipment. Supports FRL and TMDS signaling. 

• 8K Dolby Vision™ Test Tool 

• Supports HDMI video and audio up to 10K@30 Hz, 8K@60 Hz (YCbCr 4:2:0),  

4K@120 Hz (YCbCr 4:2:0) 

• Supports Display Stream Compression (DSC), and Enhanced Audio Return Channel (eARC) 

• Compatible with HDCP versions 1.4 and 2.3 

• Extended video memory up to 32 GBytes 

• Embedded Windows PC 

 

Note: Due to HW limitations, only 2 GBytes of video memory can be used with uncompressed deep color 

video at 3840x2160 p144 video timing. This allows for playing sequences containing up to 40 frames. 

Please refer to Product Specifications in the appendix of this document for details. 

Functional Description 

Part of the DDR memory in the PC motherboard is locked and reserved for storing the playback 

content. During playback, content is first loaded from hard disk (HDD) to the RAM memory of the PC 

(DDR). Video frames are then sequentially transferred from PC RAM to pattern generator’s internal 

playback memory via PCIe bus. Pattern Generator firmware triggers a PCIe transfer to request 

content when needed. 

Please find below a logical diagram of UCD-452 unit. 
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Safety and Operational Precautions 
Please find below the Safety Precautions for using the Unigraf UCD test instrument. Please also 

carefully read the Notes and Warnings within the text of this manual.  

These Precautions and Warnings are provided to enable a safe use of the UCD test equipment. 

Therefore, Unigraf assumes no liability when the user fails to follow the expressed Precautions and 

Warnings. 

• Use only Unigraf provided AC/DC Power Adapter. Please make sure that connectors and cabling 

to the Power Adapter are intact. In case there are any doubts about the condition of the Adapter 

or cabling, stop using it immediately. 

• It is important to ensure that the used AC input voltage is within the specified range (100 to 240 

Vac 50/60 Hz) and the fuses in the AC lines are of the specified type. If in doubt, do not connect 

the device. 

• UCD devices are rated for indoor use only. They are rated for Pollution Degree 2 as defined in 

IEC 61010-1. This classification corresponds to usage in a typical office or home 

environment. Under normal use, only dry, non-conductive pollution occurs. Occasionally, 

temporary conductivity caused by condensation can be expected. Temporary condensation 

occurs only when the product is out of service. 

• When installing the unit, connect the Power Adapter to the UCD device first, after that connect 

the AC plug. Please disconnect the USB cable to the controlling PC and remove cabling to DUT 

while connecting the power input cables. 

• It is forbidden to open the housing of the UCD device without written permission from Unigraf. 

Failure to comply with this rule will void the warranty of the unit. 

• UCD devices are intended for use as Electrical Test Instrument only. Use for other purposes is 

forbidden. 

• Use UCD equipment only in its specified ambient temperature and humidity.  

• In order to ensure that the UCD device and associated SW will operate properly, please ensure 

that the PC used for controlling the UCD device complies with the minimum requirement set by 

Unigraf. 

• Please keep UCD software updated by regularly checking the updates on Unigraf download page 

(https://www.unigraf.fi/downloads/). Please update the device firmware to match the installed 

software. 
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 INSTALLATION 

Installation Package 
The UCD software installation package can be obtained from Unigraf download page at 

https://www.unigraf.fi/downloads/. Please, note that there are separate packages for Windows and 

macOS. 

The installation package is a bundle between the components needed for UCD Console SW and for 

TSI SDK. The bundle contains the following items: 

Drivers (installed during set up)  

UCD Console SW (installed during set up) 

License Manager (installed during set up) 

Device configuration utility (installed during set up) 

Packet Editor (installed during set up) 

TSI SDK 

User Manuals including this document.  

In some cases, also the firmware of the unit needs to be updated. If in doubt, please contact Unigraf. 

Note: The software should be installed before connecting the UCD unit to the computer. 

 

Note: System administrator's privileges are required for performing installations. 

Software Installation 

Windows 

Install *.exe file from the package.  

Start installation by running application SoftwareBundle_X.X.XXXX. 

The welcome page is displayed and shows the software package release version. 

The user is also asked if he/she wants to: 

Create a desktop shortcut 

Install the Visual C++ redistributable (needs to be present on Windows) 

Install Unigraf USB drivers 

Confirm by selecting Next dialog button. Select Install to start the installation. 

Select Finish to exit the installation dialog. 

 

macOS 

Install *.pkg file from the package. This is a universal binary for ARM and Intel x86. 

Start installation by running application SoftwareBundle_X.X.XXXX. 

Confirm by selecting Next dialog button. Select Install to start the installation. 

Select Finish to exit the installation dialog. 

Note: If you are downgrading, please remove the Unigraf UCD Tools folder from the Applications 

folder before starting installation. 

Note: If installation fails, remove the Unigraf UCD Tools folder and any possible copies from the 

Applications directory and try again. 

 

https://www.unigraf.fi/downloads/
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Linux 

Linux extract the *.tar.gz file. You will find two install scripts (install-libfuse.sh and install.sh). 

In the Files app select each script in turn, right click and select Properties to open the 

Properties dialog. Toggle the Executable as Program button. 

In the Files app open a terminal window by unselecting any selected files and right clicking and 

selecting  Open in Terminal to run the scripts (order is important). 

In the terminal type:  sudo ./install-libfuse.sh 

You will be prompted for you password.   

Type: sudo ./install.sh  

You will be prompted with: 

Please proceed to 'Software & updates' application to tab 'Other Software' and uncheck 

checkboxes or remove 'cdrom' entry from /etc/apt/sources.list file. Otherwise you will have 

problems during UCD Console package installation. If you are already done, enter the key 'y'. If 

not - 'n' 

For Ubuntu just enter y. For debian follow instruction. 

You will then be prompted again with: 

Please proceed to 'Software & updates' application to the first tab and set check box 'Officially 

supported (main)'. Otherwise you will have problems during UCD Console package installation. 

If you are already done, enter the key 'y'. If not - 'n' 

For Ubuntu just enter y. For debian follow instruction 

Answer y for additional prompts. 

The Ucd Tool Installer Setup app should now be running. 

Select Next> 

Select radio button for Install for all users or Install just for me. 

You are asked to Choose Installation Directory. Do NOT choose the default 

(/root/Unigraf/Unigraf UCD Tools at time of writing). Select a directory that is easy to access 

and remember. 

Note the warning: Installing in existing directory. It will be wiped on uninstallation. 

Select Next> Install and Finnish. 

Navigate to the Unigraf UCD Tools directory under the installation directory and double click 

the app you want to run (UCDConsole.AppImage for example). 
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Firmware Update Procedures 
UCD Configuration Utility is used to load firmware to a UCD device. Optionally, the UCD Configuration 

Utility can be used to select firmware for specific operations. Contact Unigraf for details. 

Updating from Earlier FW Versions 

UCD Firmware versions prior to 1.8.52 (see Help > About on Consol) do not support the procedure 

described here. Follow the instructions in Appendix G Firmware Recovery Procedure with Quartus 

Prime in this manual. 

Note: Firmware update is a sensitive process. Please do not disconnect the device from the PC and do not 

power it off before the operation is completed unless specially requested. Avoid plugging and 

unplugging other USB devices when the firmware update is in progress. 

To update the firmware or create a new configuration on a UCD-4XX device, perform the following 

steps: 

Connect the UCD unit to a power supply and connect the USB cable. 

Open UCD Console.  

Select Tools > Firmware Update. 

 

 

The first page of the utility shows the firmware component versions present in the bundle package 

(or possible installed separately). Select Enable advanced mode checkbox if you want to custom 

install (possibly to downgrade firmware for ex.).  Select Next to proceed. 

The Enable patching (Internet connection is required) check box is not relevant for UCD-4XX devices. 

You are presented with a list of connected UCD devices. Select the device to update and Next.  
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Update UCD Modules 

 A dialog lists the FW components available in the UCD device, the currently programmed FW version, 

and the FW to be installed. Select Next. 

. 

You will be presented with a summary for the update procedure. Select Start. 

 

 

During the install you will be prompted to power cycle the device (power off, wait for 10 seconds 

and then power the device on again). Select OK to proceed. After the update finished select Next 

to see a summary and select Finish to complete. 

The update proceedure may take several minutes. 

 

Recovering Failures in FW Update Procedure 

If FW Update procedure fails (e.g., when updating from an earlier FW that does not support the 

procedure described here) refer to Appendix G of this manual for instructions in Firmware Recovery 

Procedure with Quartus Prime.  

Once FW Recovery procedure has been done and a FW version supporting UCD Firmware 

Configuration tool has been installed, all future updates can be done using this tool. 
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Firmware Downgrading 
Sometimes you may need an older bundle for which the firmware is a separate download.  

Follow the procedure below: 

1. Download the latest Console 2 SW Bundle (2.4.XX) from Unigraf download page at 

unigraf.fi/downloads. 

2. Run the application SoftwareBundle_2.4.XX.exe to install the package. Do not launch UCD 

Console application yet. 

3. Download Console 2: FW Package 2.3.38 from the same download page. 

4. Run the executable FirmwarePackage_2.3.38.exe to copy UCD device FW to the proper 

folder on your PC. 

5. Launch UCD Console. 

6. Select Tools > Firmware Update to start the UCD Config utility. 

7. In UCD Config select Enable advanced mode (see above). 

8. Select Next to proceed as described in Update UCD Modules above. 

9. Select the modules to be updated (see image below). 

10. Select Next to proceed as described above. 
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License Manager 

Licensing 

The features of UCD Console SW are divided into groups based on the target use of the device. Most 

basic features can be used by default, and more advanced feature groups are enabled by dedicated 

licenses. When the licenses are present, the related part of the GUI will be shown, or the related 

control will be enabled. 

Unigraf licenses are provided as strings of characters, License Keys. Each License Key enables a 

dedicated function in one device. Each device has its dedicated Seed Number. Each License Key is 

tied to one Seed Number. License Keys can be freely used in any number of PCs 

License keys are managed with UCD License Manager. The License Manager can be found in the 

Tools menu of UCD Console SW. 

Note: System administrator's privileges are required for accessing the licenses. 

License Manager GUI 

When run, License Manager will list the licensing enabled Unigraf devices. In the list of Devices please 

Select the device in question. The serial number and the seed number of your device are printed in 

a sticker attached to the bottom of the device.  

The Rescan… button will re-scan the system for installed hardware. 

Managing Licenses 

Seed Number 

Each license is tied to a hardware unit with the help of the Seed Number. Each unit has a unique 

Seed Number. Seed Number of the selected unit can be found in the top of the dialog. 

Seed Number of the selected device can be copied from dialog link for e.g., ordering Licenses. 

Adding New License Keys 

To add a new license key for a device, please enter the characters from the license sticker to the field 

for new licenses. The License Manager will automatically move the caret across the edit boxes during 

typing. If the key is given in text format, copy it and paste to the leftmost box. 

Once the license key is fully entered, click Install. The license is authenticated and if it is valid, the 

license will appear in the list of installed licenses. If the key fails to authenticate, an error message is 

displayed. If this happens, please make sure that the key has been typed correctly and that the seed 

number on the license key sticker matches the seed number displayed in UCD License Manager. 

Click the Search inverted triangle at the upper right to view the Find edit control. Enter a search 

keyword: The license list is updated to show names that contain the keyword.   
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Note that to avoid confusion, some letters will never appear in a license key because they resemble 

numbers: For example, capital 'G' and number '6' are very similar when printed with small font. When 

in doubt, use numbers. 

Also, please note, that characters that cannot be part of valid license key are not accepted as input. 

When appropriate, an automatic conversion is applied while typing: For example, lower case letters 

are converted to upper case automatically. 

Managing Installed Licenses 

The Installed licenses list shows all installed licenses for the selected device. The list shows the name 

of the license and the actual license key characters. 

Import: Install licenses from an INI file for the currently selected device. 

Export: Save installed licenses for the currently selected device into an INI file for 

backup and distribution to other PCs.  

To export license(s), select the license(s) to be exported and then click the 

Export button. Please note that licenses from multiple devices can be 

exported into the same INI file. 

Remove Selected: Uninstall selected licenses. To uninstall a license, click on the license and 

then click the Remove Selected button 
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UCD Console 
UCD Console SW is graphical user interface (GUI) for UCD family test equipment for desktop use. 

UCD Console provides the user access to all features of the unit. UCD Console also includes powerful 

debugging and analysis tools enabling the user to monitor the status of the display interfaces and 

assist in problem detection.  

The various features of the UCD unit are divided into interface specific screens and tabs. Each tab 

contains data and controls for a specific feature.  

Device Selection 

A shortcut of UCD Console can be found by default under Start Menu.  

Once UCD Console is launched, the dialog provides a list of Unigraf UCD devices connected in the 

PC. Please select the target device by double clicking on the appropriate row. If your device cannot 

be found in the list, please confirm the power and USB connection to the device and click the Rescan 

… button. 

Analyzer and Generator Operation 

Most UCD devices can be used with UCD Console as Analyzer (a Sink device) and as Generator (a 

Source device). The functionalities of the two operation modes can be found in separate tabs. This 

User Manual will explain both roles and all role functionalities. 
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Options 
Options can be found in Tools > Options. 

Image File Format 

You can save the captured frames either in PPM, BMP, JPG or PNG bitmap file format. In PPM format 

the files are stored with the captured color depth, with other formats the color depth is truncated to 8 

bits per color. 

Audio File Format 

Audio files are stored in WAV format. 

Displays HDCP Compliance 

Information if controlling PC is HDCP compliant, i.e. if preview of HDCP encrypted content can be 

enabled. If the display is non-HDCP compliant or when connected to the PC using RDP (Remote 

Desktop Protocol) then users will be presented with a blue background with a banner stating ‘HDCP 

unauthorized’. HDCP is currently only supported on Windows OS and not supported on MacOS and 

Linux. 

Folders 

Please select the directories in the PC for saving the captured images and audio. 

DSC 

DSC temp folder: Folder for DSC Work files. 

DSC test content folder: Folder where DSC source bitmap files, related configuration files and 

DSC conversion tools are stored. 

Keep auto-created DSC 

content files: 

By default, the DSC compressed content is deleted after use. If 

selected, the content is not deleted. 

Warning Keeping the automatically created DSC compressed content will shorten the time needed for running 

the DSC compliance tests.  

 Please note, that the space needed for storing the full library can be very large (appr. 400 GBytes). 

Please make sure that the content will be stored in a medium that has the required space available. 

 

DUT Testing Options 

Configure DUT Testing reports. 

Include time info in Report logs: Include system date and time in the beginning of each 

event line in created reports. 

Do not show again test sequence 

completed: 

Include system date and time in the beginning of each 

event line in created reports. 
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Detaching and Cloning Tabs 
Most of the UCD Console tabs can be detached into a separate window for monitoring and controlling 

separate features simultaneously. To detach a tab Right-click on a tab and select Detach Window. 

To glue the tab back to the main window, click on the red Close button in the top right-hand corner 

of the window or press <Alt> + F4 on the keyboard. 

Tabs can also be cloned (duplicated) in order to e.g., monitor various areas of DisplayPort DPCD 

simultaneously without swapping addresses. To clone a tab Right-click on a tab and select Clone 

Tab or Clone and Detach to the two actions simultaneously. 
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 ANALYZER OPERATION 
When used as an Analyzer, the UCD device acts as DisplayPort, HDMI or USB-C DisplayPort Alt Mode 

Sink or Receiver device. 

Analyzer functionality related controls and dialogs can be used by selecting DP RX or HDMI RX tabs.  

Please note that in most UCD-4XX Series units, Generator functionality is available simultaneously 

with Analyzer. Please find the description of Generator functionality later in this manual.  

Functionality Tabs 
UCD Console features are presented in tabs. Standard tabs are similar in all functional roles, Interface 

Specific tabs present features and controls that are only available for a particular interface. 

Some of the tabs are enabled by default, some only when an applicable license is included.  

Standard Tabs 

Analyzer role features six standard tabs: 

• Video preview and saving (Video) 

• Audio monitoring and saving (Audio) 

• EDID editor (EDID) 

• HDCP status monitor and control (HDCP) 

• Source DUT Testing tab 

• Event Log 

Interface Specific Tabs 

Depending on the connected UCD device, additional interface specific tabs will be available. 

UCD-400 and UCD-424: 

DP and USB-C DP Alt Mode Reference Sink 

• Status information and control of the upstream link (Link) 

• DPCD editor (DPCD) 

• SDP sent by the Source device (SDP) 

• Status and capabilities of the DSC feature (DSC) 

• Forward Error Correction (FEC) 

UCD-422: HDMI Reference Sink 

• Status information and control of the upstream link (Link) 

• Received InfoFrame packets (InfoFrame). 

UCD-424: USB-C Reference Sink 

• USB-C Monitoring (PDC)  

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to Appendix B Licensing of this document for description of features and licensing. 
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         T    

HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content Protection) status 

and controlling the HDCP capabilities of the UCD device. 
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Status 

The status field indicates the HDCP status of the UCD device. 

Active: The link between UCD and the upstream source has been encrypted. 

Authenticated: The HDCP handshake between the UCD and the sink unit has been 

completed successfully. 

Declared as HDCP 

capable: 

The UCD unit recognizes HDCP handshake messages. 

Keys loaded: The HDCP keys are loaded to the UCD unit. 

SST Mode Type Type when in SST mode (DP). 

Configuration 

HDCP Capable:  To inform source DUTs that TE (UCD device) is HPCD capable or not. 

Uncheck to disable. 

 Repeater Simulation 

For HDMI the UCD device can simulate a HDCP repeater. Check the Repeater Simulation box to 

enable the rest of the controls. 

Depth: Depth of Repeater (maximum 4). 

Device count: The number of devices that act as repeaters (maximum 32). 

KSV Value KSV value assigned to each device. 

Status Shows HDCP authentication of repeater. 

 

The Device count can be change via the spinbox or the +/- buttons. 

Inverted triangles are used to navigate the KSV rows. 

Use the Preset dropdown to Save, Load and Remove named (saved internally) sets. 

Use the Import and Export options to load and save to files. 

Press Apply to apply settings. 

Keys 

Select between Production or Facsimile HDCP keys. To remove the keys, select None.  

HDCP 1.3 / 1.4 and HDCP 2.3 Limitations 

DisplayPort currently only supports HDCP 2.X.  

See ReleaseNotes.txt, Known issues (Limitations) in bundle to see limitations: 

C:\Program Files\Unigraf\Unigraf UCD Tools\documents\ ReleaseNotes.txt on Windows.   
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Capture Tab 
UCD device has an internal frame buffer that can be used for continuous capture of video data. In 

addition, audio and metadata can be captured and saved for later analysis. 

For DP Events see DP Link Analyser Tab Events. For HDMI Events see HDMI Link Analyser Tab 

Events. 
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Start / Stop Start or stop capturing. Button label changes per action. 

Capture N frames: The number of video frames to capture. 

Format: Selection of the format of the saved video frame bitmaps. BIN, PPM, 

BMP, BIN + PPM, BIN + BMP. 

Buffer  capacity: The number of video frames that can be stored to UCD frame buffer 

using current video signal format. 

Align to MSB Store binary data aligned to the Most Significant Bit (MSB).  

When this is left unchecked the binary data is aligned to the Least 

Significant Bit (LSB).  

Create scenarios Define the length of the scenario. 

Events: Please refer to chapter Event Log for details of the captured events. 

Audio: Enable audio. 

Status: Status of the capture. 

Open Timeline Viewer Open Event Timeline Viewer to view the captured data. For detailed 

instructions refer to chapter seven of this manual. 

Open storage folder: Data save folder is defined in menu Tools > Options. Captured video, 

audio and data is saved in a subfolder of this folder. The name of the 

          i  “        _  p    _yyyy    _hh    ” (  g , 

buffered_capture_20210301_130532). 
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Video Tab 
Video tab is the Preview window for the captured video stream. 

Disable / Enable Preview 

Click the button to start or stop capturing video frames. 

Current Stream (UCD-400, UCD-424) 

When Multistreaming (MST) is enabled, the monitored stream can be selected here. 

Video Status 

The details of the captured video are presented below the preview window. 

First row: Cursor location, pixel value at cursor location in YCbCr and RGB  

Second row: Time stamp, Color mode, color depth, frame counter. 

Third row: Mvid, Nvid, Horiz Total, Vert Total, Horiz Active, Vert Active, Horiz Start,  

Vert Start, Hor Sync Width, Vert Sync Width. 

Fourth row: Live preview frame rate. 

Note: HDCP preview is only available on UCD Console for Windows operating system. 

 Please note that UCD test equipment are able to capture video at full frame rate.  

Live preview frame rate indicates the rate of updating captured video on UCD Console preview 

screen. The rate is limited e.g by the USB communication between UCD test equipment and the PC. 



  Analyzer Operation 

UCD-4XX User Manual • UCD Console 3.6 34 

Override Color Detection 

The captured video will be by default automatically converted to RGB 8 bpc for preview and saving 

based on the information in video metadata.  

By clicking Auto button, a dialog opens for overriding the automatic conversion. Captured image data 

will be interpreted based on the values set in the dialog.  

Color space: Define as which format captured data will be interpreted. 

(Auto-detect, RGB, YCbCr4:4:4, YCbCr4:2:2, YCbCr4:2:0) 

Colorimetry: Define as which colorimetry captured data will be interpreted. 

(ITU-R BT.601, ITU-R BT.709, ITU-R BT.2020) 

Bits per color Define as which color depth captured data will be interpreted. 

(Auto-detect, 6, 8, 10, 12, 16) 

Note: Please note that the color mode selection applies to the preview window only. All internal functions 

use the raw image data as captured from the input channel. 

Frame recording 

 

Clicking the button opens a dialog for definition of number of frames recorded. Buffered mode can 

also be enabled in this dialog. 

Buffered When checked, all input frames are captured non-drop until the on-board frame 

buffer will be full. 

When not checked, only one input frame is buffered at a time. Frames will be 

skipped if the transfer of the data to the PC is slower than the input data rate. 

Capacity of the buffer Capacity of the on board frame buffer with the selected video and color mode. 

Note: Please note that buffered mode cannot be used when Audio preview is enabled. 

Recorded frames are stored by default in C:/Users/<Current user>/Pictures. Please refer to Tools > 

Options where the location of this folder can be customized. 

Open 

 

Open folder where captured frames are stored. Double click or click Open to select a frame file for 

viewing. Please refer to Tools > Options where the location of this folder can be customized. 
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Full Screen 

Preview captured video full screen, scaled to vertically fit the screen. 

Double-click on the screen to exit full screen mode. 

Snap Frame 

 

When clicked, one frame of the incoming video is captured and shown in a new tab. Each click 

captures a new frame and opens a new tab. 

Color Information of the captured frame can be evaluated by placing the mouse cursor on top of the 

preview image.  

Info field in the lower right side of the bottom panel lists: 

• Location of the cross cursor on the bitmap stating from the upper left corner 

• The intensity of the Red, Green and Blue components of the pixel on the cursor location in 

decimal values 

• The HTML HEX color code of the pixel on cursor location 

• In case of YCbCr color mode the intensity of the Y, Cb and Cr components of the pixel on the 

cursor location in decimal values 

Zoom  

Zoom level of the captured frame can be altered by right clicking on top of the preview image and 

selecting between 

• Fit Window 

• Zoom 25%, 50%, 100%, 200%, and 500% 
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Save Frame 

The captured frame current tab can be saved to a bitmap file in the PC by right clicking on top of the 

preview image and selecting Save as…. The format and storage location can be selected in the 

opening dialog. The available bitmap formats are BMP, JPG, PNG and PPM.  

Note: In PPM format the files are stored with the captured color depth, with other formats the color depth 

is truncated to 8 bits per color. 

The selections in Tools > Options menu define if the frame bitmap will be stored as captured from the 

display interface or if the color mode conversion selected for preview will be applied. 

Previewing DSC Decompressed Stream (UCD-400, UCD-422, UCD-424) 

In order to capture and preview DSC compressed video DSC must be enabled in Link Capabilities 

dialog in Link tab. 

Select Enable Preview to verify that DSC compressed stream is received. 
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Click Snap button to capture one frame and start the decompressor (offline in the PC). Once the 

decompression is ready, the frame is shown, and Log lists the details of the compressed image. A 

snapped DSC image can be saved as a DSC-file. 
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HDMI Link Analyzer Tab 
Capture Data Events for analysis with Link Timeline Viewer. See chapter Link Timeline Viewer for 

details. 

Link Analyzer buttons 

Start Start capturing main link data using Main Link Capture Options.  

Open Timeline 

Viewer 

Open Link Timeline Viewer. See Timeline Viewer. 

Open storage folder Open folder in the PC where capture data is stored. Folder is the video 

storage folder defined in Tools > Options.  

Captured video, audio and data is saved in a subfolder of this folder. The 

         h            i  “capture_yyyymmdd_hhmmss). (e.g. 

capture_20210215_093351). 

 

Main Link Capture Options 

Amount: The amount of data logged to buffer. Buffer size 2 GBytes maximum. 

Trigger Point Options 

Data capture start can occur with or without defined trigger criteria. 

Trigger criteria dropdown has four options: No active trigger, HDP assert, HDP deassert, I2C 

transaction, CEC transaction, Main Link video lock and Packet data. 
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When I2C transaction is selected, a drop down list box is enabled and visible with options: Write, Read 

and Any. Two spinboxs are enabled for I2C Device Address and I2C Register Address. 

 

When CEC transaction trigger is selected, available trigger options are shown below. 

Select trigger options via checkboxes OVERDATA_ERROR, START_TIMING_ERROR and/or by filling 

in the CEC Template Data (hex) values. 

 

When the Main Link video lock trigger is selected, available checkboxes are GXB_LOCK_RISE, 

VID_LOCK_RISE, VID_LOCK_FALL,  HDCP1_AUTH_RISE,  HDCP1_AUTH_FALL,  

HDCP1_ENC_EN_RISE, HDCP1_ENC_EN_FALL, HDCP2_AUTH_RISE,  HDCP2_AUTH_FALL,  

HDCP2_ENC_EN_RISE, HDCP2_ENC_EN_FALL, TMDS_CLK_LOCK_RISE, EXT_PIN_RISE, 

EXT_PIN_FALL. 
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When Packet data is selected: Checkbox BCH_ERROR, when checked, will start capture when a 

BCH_ERROR error occures (and only when one has occurred). Fill out packet Template Data (hex) to 

filter events to start capture. Shown below is a trigger for AVI Infoframes in general. 

 

Position 

Triggered capture timepoints available are: Start, 25%, 50%, 75%, End.  

Events 

The following events can be selected via checkboxes: 

HPD 

Status and status changes of Hot Plug Detect (HPD) signal 

Packets 

HDMI infoframes. Click the button to open the Event Filter Dialog. 

Packet events without checkboxes can be added via the Enter packet type edit control (0x2 for audio 

sample for example). 

 

I2C 

Capture I2C communication. Click the button to open the Event Filter Dialog. 
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Use edit control Enter packet type as hex separated by comma: to add packets manually. 

 

CEC 

Capture CEC communication. 

 

 

DP Link Analyzer Tab 
Capture Main-Link Data Events and AUX Transactions for analysis with Link Timeline Viewer. See 

chapter Link Timeline Viewer for details. 

 

Start Start capturing main link data defined by Main Link Capture Options.  

Open Timeline 

Viewer 

Open Link Timeline Viewer. For detailed description of Link Timeline 

Viewer, please refer to chapter six of this manual. 
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Open storage folder Open folder in the PC where capture data is stored. Folder is the video 

storage folder defined in Tools > Options.  

Captured video, audio and data is saved in a subfolder of this folder. The 

         h            i  “capture_yyyymmdd_hhmmss). (e.g. 

capture_20210215_093351). 

Main Link Capture Options 

Amount: The amount of data logged to buffer. Buffer size 2 GBytes maximum. 

Lane count: Auto, 1, 2 or 4 
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Trigger Point Options 

 

Start of data capture can occur without defined trigger of triggered by a predefined signal 

combination. 

In the dialog, first select the event block from the upper drop-down list and from the appearing sub-

menus select the detailed trigger.  

Trigger Source Position 

No active trigger — — 

Start of TPS1 / TPS2 / TPS3 / TPS4 TPS1, TPS2, TPS3, TPS4 Initial LT, 

After ALPM, 

Initial LT or After ALPM 

Exit of TPS1 / TPS2 / TPS3 / TPS4 TPS1, TPS2, TPS3, TPS4 Initial LT, 

After ALPM, 

Initial LT or After ALPM 

Trigger Source Mask (hex) 

VB-ID with the MASK – any change, match, 

selected bit transition 

Any VB-ID change, VB-ID 

match with VB-ID mask, 

Change of any bit in VB-

ID that is set in VB-ID 

mask 

Set mask value in hex 

format 

VB-ID on TYPE – BS/SR/CPBS/CPSR BS, SR, CPBS, CPSR — 

Trigger Options HB0 (hex), HB1 (hex) 

SDP Type received – HB0 and/or HB1 match Match on HB0, HB1 can 

be any value; Match on 

HB1, HB0 can be any 

value; Match on HB0 and 

HB1 

Set HB0/HB1 value in hex 

format 

Trigger Source Options 

MSA – any change, change by mask, match by 

mask 

Any MSA change, Change 

of any MSA attribute set 

in mask, Match of any 

MSA attribute set in mask 

MVid, NVid, HTotal, VTotal, 

HActive, VActive, HSyncW, 

VSyncW, HSyncP, VSyncP, 

HSyncS, VSyncS, MISC0, 

MISC1 

Any AUX transition — Initial LT, 

After ALPM, 

Initial LT or After ALPM 

Trigger Type Address (hex) 

AUX read or write of specific address AUX native, AUX natve 

read 

Set address in hex format 

 

Note:  If you want to capture during link training and you have set the trigger accordingly, you can initiate link 

training by clicking Pulse HPD at the bottom of the window. 

Events 

The following events can be included in the captured data. 

HPD 

Status and status changes of Hot Plug Detect (HPD) signal 
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AUX 

AUX Channel transactions. 

SDP 

Secondary-data Packets received in the Main-Link. Click the button to open the Event Filter Dialog. 

The dialog enables filtering of SDP packets. In the dialog, the reference to Packet Type Value is 

indicated in square brackets “[ ]”. 

VB-ID 

Vertical Blanking ID packets. Click the button to open the Event Filter Dialog. The dialog enables 

definition of which bit changes will be logged. 

MSA 

Log Main Stream Attributes. Click the button to open the Event Filter Dialog. The dialog enables 

definition of which events will be logged. 
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Link Pattern:  

Detect link patterns. Click the button to open the Event Filter Dialog. The dialog enables definition 

of which patterns will be logged. 

AUX_BW: 

Capture AUX Channel signal details. 

VFRAME INFO 

Dimensions of the catured frame measured by the Sink 
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Audio Tab 
Audio tab has a preview of the audio signal format and the controls for audio playback and recording. 

Up to eight channels will be shown based on the received audio stream. 

The audio signal format is shown in three ways. 

• The ‘oscilloscope’ panel displays the waveforms of the received audio channels.  

• The frequency spectrum of the audio is shown in the lower panel. The range of the spectrum 

display is from 0 to 1/2 of the input sampling rate. The amplitude scale of the spectrum display 

can be selected between ‘Linear’ to 100 dB. 

• The span of the oscilloscope preview window is defined with Playback buffer found in Tools > 

Options dialog. The value is given in ksamples (1024 samples). The relation between the preview 

window span in milliseconds (msec) and the value given in Playback buffer depends on the 

sampling frequency. Please do not exceed the Main buffer set in the same dialog. Please refer 

to description of the Video Audio and Misc Options earlier in this document. 

Enable Preview / Disable Preview 

This button controls capturing the audio data. 

Select Monitored Stream 

When Multistreaming (MST) is enabled, the monitored stream can be selected from Current Stream 

selection in the bottom of the dialog. 

Note: Please note that if the captured audio signal is constant, and audio signal frequency and audio 

sampling rate (e.g. 1000 Hz audio and 32 KHz sampling) match audio preview sampling rate, the 

‘oscilloscope’ panel will seem static. Signal capture can be verified by ensuring that Frame # below 

the panels is increasing. 
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Playback device selection 

The captured audio can be played back in the PC. The combo-box defines the audio device in the 

host PC through which the captured audio is played. By default, No audio playback is selected. 

Note: Please note that the audio capabilities of the audio playback device of the PC are not automatically 

reflected in the audio capabilities description in UCD-4XX EDID. Since UCD-4XX is not performing 

any audio format conversion, it might occur that the source provides an audio format that the selected 

playback device is not supporting. In case a conflict occurs, please change manually the EDID content 

or disable audio playback to monitor the waveforms in UCD Console. 

Refresh audio device list 

 

Click here to re-read the list of audio devices after making changes to the host PC configuration. 

Audio Buffer Size 

The amount of buffering used in the data transfer between the UCD-4XX unit and the PC in Audio 

buffer size in Tools > Options dialog, Main buffer. Increased buffer size will ensure a smooth audio 

output but will also increase the delay between the capture of the audio stream and its playback. 

Start audio recording 

 

The captured audio can be recorded in the PC using Waveform Audio File Format, WAV (*.wav) 

format. Recording duration is defined in milliseconds (ms). The folder where the audio file will be 

saved can be selected in Tools > Options. 

Input audio mode 

 

This field (in the bottom of the dialog) indicates detected audio mode in the input stream and the 

number of audio packets captured. 
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EDID/DisplayID Tab 
EDID/DisplayID Tab provides tools for accessing the EDID/DisplayID data of the UCD Sink presented 

to the connected Source Device. There are three basic functions: 

• Load and save data files on the host PC. 

• Edit contents in Editor Mode or the Hex Edit Mode. 

• Read and write to EDID/DisplayID memory for up to 4 virtual ports. 

EDID/DisplayID Files 
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With Load… and Save As… a file can be read or written to from a PC. Please note that the program 

does not alter the contents of the file or verify its integrity during load and save operations. 

Note: Four blocks (512 bytes) are read. If the device does not support all four blocks, the non-supported 

data is replaced with zeros. 

The Enable DisplayID checkbox, when checked, informs generator devices that DisplayID data is 

available. 

 

The Text EDID and Text DisplayID tabs allow viewing data in tree form. 

 

EDID/DisplayID Editor 

Please see the description of the EDID editor in Chapter EDID/DisplayID Editor later in this document. 
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Source DUT Testing Tab 
Please refer to Appendix E for descriptions of the tests available. The tests are presented in a split 

view, the right being test categories and the left being the tests in them. 

 

Select the tests for execution by checking checkboxes or by clicking the test name. All tests item on  

the left hand side is really just for viewing all tests available. Select the desired test category (ex. DP 

1 .4 LLCTS) when running tests. 

Run/Run 

Checked: 

Select to start selected/checked tests. Once tests are running the Run Checked 

button is relabeled Abort to stop the test sequence if desired. 

Select: Includes three sets of options: Select All, Clear All, Invert All for changing the tests 

current selections; Save (checked items), Load (and check relevant items), Remove 

(named tests list) for handling named templates; Import (check all items contained in 

file) and Export (save all checked items to file) for loading and saving file-based 

templates. Do not confuse Import and Export with those below: These are for setting 

and saving tests to run. 

Configure: Opens a test parameters dialog for the selected test set. Make sure a test category 

other than All tests is selected. Refer to Test Parameters below for details. 

Import: Load saved test parameter files (*.td or *.json) for into UCD Console. Select 

Configure to see current parameters.  Loading *.td files to UCD Console is currently 

unreliable. 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For saving 

parameters for TSI scripting, please use *.td files. For use with Python applications, 

use *.json files. 

Stop on Failure: Stops execution of tests if one fails.  

Repeats: Number of times to repeat the selected test sequence. 

Delay time: Delay in seconds between individual tests. 
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On completion of each test the result of the test is displayed in the table columns on the right. For 

each test the table lists the number Pass, Fail, Skips, Runs and Last Status (status of last run). 

Save Report: Select to generate a HTML report file. This will also open  a tab in the default 

browser and display the results. 

Clear Selected Clear the test results of the selected (not checked) tests results. A 

subsequently saved report will not include these test results. 

Clear All: Clear the test log view and the outstanding results. 



  Analyzer Operation 

UCD-4XX User Manual • UCD Console 3.6 52 

Test Parameters 

Each test suite has a dedicated set of test parameters. Select Configure to launch the parameters 

dialog for the selected tests. 

See Appendix E for parameter descritptions for each test category. 

Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Sink DUT Testing tab to a *.td file for later use in UCD Console, to run TSI 

scripts, or to share test parameters with someone. Presently importing *.td files into UCD Console 

is unreliable. 

• Export parameters in Sink DUT Testing tab to a *.json file for later use in UCD Console, to run 

Python scripts, or to load test parameters into UCD Console. 

• Save parameters in Configure dialog as Presets to be later used in UCD Console. See description 

below. 

Presets 

All Configure dialogs selected parameters can be saved and loaded via Presets dropdown menu. 

Select Save or Load for named internal configuration parameter sets. Select Remove to delete a 

named internal set. Select Import and Export for loading and saving parameter sets from and to  

external files. Note that Importing and Exporting *.json files here have a different format than importing 

those described above. 
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          A        R          i k 

Role: Product: 

DP Reference Sink (DP RX) UCD-400 

USB-C DP Alt Mode Reference Sink (DP RX) UCD-424 

 

When DP Reference Sink or USB-C DP Alt Mode Reference Sink role is in use, the following interface 

specific tabs are available. 

• Status information and control of the upstream link (Link) 

• DPCD editor (DPCD) 

• Analyze Secondary-data Packets received (SDP) 

• Display Stream Compression status and configuration (DSC)  

• Forward Error Correction (FEC) 

Link Tab 
Link tab contains four panels: Cable / HPD, Link Status, Link Capabilities HDCP Status and 

Configuration, Video Status and HPD. 
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Link Status 

Link Status displays the status of the link training and the link parameters negotiated between UCD 

Sink and the Upstream Source. It also lists status of other link modes. The data is retrieved from the 

DPCD status registers of the UCD Sink. The status is updated automatically.  

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt Mode. 

CR/SL/EQ: LED indicators for status of Clock Recovery / Symbol Lock / Channel 

Equalization for each of the four lanes 

VS/PE (level): Voltage Swing / Pre-emphasis level 

Error count: Content of DPCD Error Count registers 

ILA:   LE  i  i          ‘           A ig          ’  

Bit rate: Currently enabled link bit rate 

Link mode: Currently enabled channel coding (8b/10b only) 

Framing mode: Currently enabled Framing Mode (Normal or Enhanced) 

Scrambling: Status of link data scrambling (Enabled or Disabled) 

MST mode: Status of Multi-stream transport (Enabled or Disabled) 

SSC Status: Status of Spread-Spectrum Clock (Enabled or Disabled) 

DSC Status: Status of Display Stream Compression 

FEC status: Status of Forward Error Correction function (Enabled or Disabled) 

 

Link Training Result 

The result of the previous Link Training and values of some key parameters. 

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt Mode. 

CR/SL/EQ: LED indicators for status of Clock Recovery / Symbol Lock / Channel 

Equalization for each of the four lanes 

VS/PE (level): Voltage Swing / Pre-emphasis level 

ILA: Status LED for Inter-Lane Alignment 

Bit rate: Currently enabled link bit rate 

Link mode: Currently enabled channel coding (8b/10b only) 
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Link Capabilities 

Link capabilities allows the user to change the way the Sink capabilities are announced in the DPCD 

capability registers of the UCD Sink. To update the new status to the DPCD registers click Apply. 

 

 

Max lanes: Maximum lane count used 

Max Bitrate, Gbps Maximum link rate used in LT 

eDP Bitrate,Gbps Available eDP bitrates. 

Force Cable Status to 

Plugged: 

UCD-400 RX device supports source device detection via AUX by 

default. Checking this on DPRX disables this behavior. 

Enable Fast LT: Indicate support for link training without AUX transactions. 

eDP AUX 

Preamble,Gbps 

Use eDP AUX Preamble protocol. 

Sink count: Selects the number of sinks capable of to transmitter. 

MST: Indicate support for MST mode and Sideband MSG handling. 

FEC (8b/10b): Indicate support for Forward Error Correction (FEC) feature. 

TPS4, TPS3: Indicate support for Link Training Pattern Sequence 4 and 3 

correspondingly. 

DSC (8b/10b): Indicate support for Display Stream Compression (DSC) feature  

HPD pulse on Apply: Select to apply a Hot-Plug Detect (HPD) pulse automatically after 

updating the status. HPD pulse duration will be defined in the  

Pulse HPD field in HPD dialog in the bottom of the tab. 

Scrambler Seed 

Selection of the value to which the Linear Feedback Shift Register (LFSR) is reset during scrambler 

reset. Used only when 8b/10b link coding is enabled. 
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HDCP Status 

Copy of the status from HDCP Tab. Please refer to chapter HDCP Tab later in this document for 

detailed description. 

HDCP Configuration 

Enable and disable HDCP capability of UCD Sink. Duplicates of the controls found in HDCP tab. 

Currently, UCD-4XX devices support only HDCP 2.3 standard. 

Stream Info 

Stream Info is achieved from the Main-Stream Attributes (MSA) of the stream. 

The content of Stream Info table can be copied by right-clicking on the table and selecting Copy. 

Note that the MSA information used for Video Timing Details is provided by the Upstream Source. It 

is not measured by the UCD Local Sink. 

Framerate: Vertical refresh rate 

HTotal: Horizontal total of transmitted main video stream, measured in pixel count. 

HStart: Horizontal active start from leading edge of HSync, measured in pixel count. 

HActive: Horizontal active, number of active pixels in video line 

HSync: HSync width, measured in pixel count. (+)/(-) positive / negative sync. 

VTotal: Vertical total of transmitted main video stream, measured in line count. 

VStart: Vertical active start from leading edge of VSync, measured in line count. 

VActive: Vertical active, number of active lines in video frame 

VSync: VSync width, measured in line count. (+)/(-) positive v.s. negative sync. 

CEF: Used color mode: Color format + subsampling / colorimetry 

BPC: Color depth in bits per color (BPC) 

CRC (RGB/CrYCb): 16-bit Cyclic redundancy check (CRC) value per color component calculated 

from active pixels. Value order in YCbCr color format: Cr, Y, Cb. 

MVID/NVID: Mvid and Nvid video time stamp values 

 

 

 

16-bit Cyclic redundancy check (CRC) calculated from compressed pixel 

stream. Value order Engine 0, 1, 2. 
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VCP Table 

 

 

VCP table shows allocation of Virtual Channel Payload for active virtual MST channels. 

The content of VCP Table can be copied by right-clicking on the table and selecting Copy. 

Strem #: Port number where the virtual channel is directed. 

VCPID: Stream identification number of the virtual channel 

Req.PBN: Requested PBN (payload bandwidth) value for the virtual channel 

Alloc.PBN: PBN value allocated for the virtual channel 

First slot: Time slot where the first VC Payload for the virtual channel is stored 

Slot num: Number of VC Payload slots reserved for the virtual channel. 
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HDCP Stream Status 

 

Shows the MST HDCP Stream, Status and Type. 

HPD 

Cable LED: Indicates that the hardware has detected an upstream cable.  

HPD LED:    i       h    h       ig    i  A        (  gi    “high”)  

Deassert: Click                    i        gi    “  w” (  -asserted) and hence no HPD 

pulse can be generated.  

Assert: Click to re-   iv     h       i   (         gi    “high”)  

Pulse HPD: Click to apply an HPD Pulse with programmable duration. Set duration in 

milliseconds in adjacent edit control. 

Short Pulse: Click to apply a short pulse. Set duration in microseconds in adjacent edit control. 

Multistreaming 

When Multistreaming (MST) is enabled, the details of the received virtual channels is shown in 

Stream Info table and VCP Table . 
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DPCD Tab 
DPCD tab is a tool for monitoring and editing the DPCD registers of the UCD Sink. 

The DPCD Decoder panels on the right show the interpretation of the DPCD byte selected on the 

monitoring windows. The selected byte is shown with a green background.  

Save: Select DPCD content to the PC (please see below). 

Load: Retrieve previously saved DPCD data (please see below). 

Report: Save parsed content of selected DPCD register ranges as HTML file 

Refresh: Re-read the data from the DPCD registers to the window in question 

Write Changes: To program the data into the DPCD registers of UCD Local Sink  

Set Reference: Store currently shown data as a reference for comparison 

When the data is Refreshed from the DPCD registers the changed bytes will be highlighted with blue 

color. The fields edited by the user will be highlighted with red color. 

Saving and Loading DPCD Content 

DPCD data in the selected address areas can be saved as a file in your PC. There are three alternative 

formats listed below. Please select the intended format when saving: 

• Binary DPCD Data File format (*.DPD). This is Unigraf proprietary format. You can also load the 

DPCD content stored in this format. 

• Comma Separated Value format (.CSV) 

• HEX Dump (*.HEX) in a human readable text format. 

Note: - User controls like Link Training or mode changes will modify the content of the DPCD registers 

- During a reboot of UCD-4XX the DPCD registers will be returned to their default values 
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SDP Tab 
In SDP Tab shows the Secondary-Data Packets sent by the Source device. Click Refresh to re-read 

the data. Show / hide the parsed data by clicking Packets Info in the divider bar. 

The following packets are recognized: 

• Audio_TimeStamp 

• Audio_Stream 

• Extension 

• Audio_CopyManagement 

• ISRC (International Standard Recording Code) 

• Video Stream Configuration (VSC) 

• Camera Generic 0 … 7 

• Vendor-Specific Infoframe packet 

• AVI InfoFrame packet 

• Source Product Descriptor InfoFrame packet 

• Audio InfoFrame packet 

• MPEG Source InfoFrame packet 

• Dynamic Range and Mastering InfoFrame 

• Picture Parameter Set (PPS) 

Saving SDP Packets 

Packets can be saved in a file in binary format. Click Save and in the dialog select the packet types 

of choice. File name will be of format ATS_2022-07-28T15_54_24.bin, where ATS is the packet type 

and 2022-07-28T15_54_24 the time stamp.  

Saved packets can be evaluated and edited using Packet Editor. Please see section Packet Editor 

later in this document 
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DSC Tab 
DSC tab contains status of the Display Stream Compression (DSC) feature, and definition of DSC 

support capabilities that UCD defines in its DPCD register. 

Enabling DSC 

Enabling DSC feature is controlled by the connected source device. When connected, a source 

verifies corresponding registers in DPCD of UCD sink to find out if DSC capability is declared.  

DSC Capable (8b/10b): UCD is declared as DSC capable. Capability can be enabled or disabled 

in DP RX Link tab. 

DSC Enabled: LED indicating that the connected source has enabled DSC 

Apply: Write changes to UCD sink DPCD registers 

Refresh: Re-read the content of UCD sink DPCD and update the control status. 

Reset: Reset the content of UCD DSC related DPCD registers (0x00060 

through 0x0006F) to the default values as defined in UCD firmware. 
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FEC Tab 
FEC tab contains control of the FEC (Forward Error Correction) feature, Error Detection table and 

FEC Status Log. 

Enabling FEC 

Enabling FEC feature is controlled by the source device. When connected, source verifies 

corresponding registers in sink DPCD to find out if sink is FEC capable. This register in UCD-4XX sink 

can be controlled by FEC Capable checkbox. 

Since source normally polls sink DPCD mainly after a new connection, selecting Generate HPD on 

change will force a new connection after the change of the FEC capability status. 

Update: Read FEC Error Counters from DPCD 

Clear Counters: Clear FEC Error Counters in DPCD. 

 

FEC Status Log lists FEC events. 



  Analyzer Operation 

UCD-4XX User Manual • UCD Console 3.6 63 

     R          i k 

Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-422 

 

When HDMI Reference Sink role is in use, the following interface specific tabs are available. 

• Status information and control of the upstream link (Link) 

• Received InfoFrame packets (InfoFrames). 

Link Tab 
Link tab contains four panels: Behavior, Status, TMDS Status, FRL Capabilities, FRL Status, Audio 

Return Channel, HDCP Status and Configuration, Video Status and HPD. 

Behavior 

Selection of HDMI operation mode: HDMI 1.4, HDMI 2.0 or HDMI 2.1.  

Please perform HPD Deassert - Assert after change of mode. 

Status 

Channel lock: Status of Channel Lock in the four lanes and currently selected HDMI 

mode 

Error count: Contents of the SCDC Error counter registers of the UCD-422 Sink. 

Auto Adjustment Adjustment errors on lanes. 

Behavior: Assigned HDMI mode 
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TMDS Status (Only in TMDS Mode) 

Mode: Indication of HDMI / DVI mode 

TMDS Bit Clock Ratio: TMDS Bit Period / TMDS Clock Period ratio (1/10 or 1/40)  

Input Stream Lock: Indication of TMDS character lock 

FRL Capabilities (Only in FRL Mode) 

FRL Capabilities allows the user to change the way the Sink capabilities are announced in the SCDC 

capability registers of the UCD-422 Sink. 

Disable FRL: Disable FRL mode 

Capability Radio 

Buttons: 

Selection of the maximum link count and link rate capability of UCD-422 

sink. Written to FLR_Rate configuration register of UCD_422 Sink.  

Please click Re-train to apply  

FRL Start:             h        i k’   RL_       i  (1  ) 

FLT Ready:             h        i k’   LT_    y  i  (1  )  

FLT No Timeout:            h        i k’   LT_  _ i       i  (1  ) 

FRL Max:            h        i k’   RL_  x  i  (1  ) 

Check Patterns: If  h  k          i              h    h   ’     p       v  i i   i      i g 

link training 

LTP Add: Additional R q       Li k T  i i g p       i        i k’  L X_LT _  q 

(X=0-3) register. 

Re-Train: Request a new link training  

Apply: Store new settings 

 



  Analyzer Operation 

UCD-4XX User Manual • UCD Console 3.6 65 

FRL Status (Only in FRL Mode) 

FRL Status displays the status of the link training and the link parameters negotiated between UCD-

422 Sink and the Upstream Source. The status is updated automatically. 

FRL Data 0/1/2/3: Indication of data flow in FRL links 0 to 3  

FFE Level: Status of Feed Forward Equalizer Level that HDMI transmitter is using 

(only in FRL mode) 

LTP Request: Currently requested FRL link training pattern.  

FRL Mode: Lane count and link rate configuration used in FRL mode 

LT Status: Status of the FRL Link Training State 

FLT Update: Status of the UCD-422  i k’   LT_ p      i  (1  ) (   y i   RL     ) 

FLT No Retrain: Status of UCD-422  i k’   LT_  _     i   i  (1  ) (   y i   RL     ) 

HDCP Status 

Copy of the status from HDCP Tab. Please refer to chapter HDCP Tab later in this document for 

detailed description. 

HDCP Configuration 

Enable and disable HDCP 1.4 or HDCP 2.3 capability of UCD-422 Sink. Duplicates of the controls 

found in HDCP tab. 

Note:  HDCP is not supported in 3.5 release 

Video Status 

Video Timing and Color Details as retrieved from stream metadata. Frame rate is measured by UCD-

422 Local Sink.  
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CRC 

The 16-bit CRC (checksum, cyclic redundancy check) values of the three color components 

calculated by the Sink hardware. To re-calculate, click Update. Click Copy to store the information 

to the clipboard. 

HPD 

High: LE  i  i       h    h       ig    i  A        (  gi    “high”)  

Deassert: Click                    i        gi    “  w” (  -asserted) and hence no HPD 

pulse can be generated.  

Assert: Click to re-   iv     h       i   (         gi    “high”)  



  Analyzer Operation 

UCD-4XX User Manual • UCD Console 3.6 67 

InfoFrame Tab 
InfoFrame Tab displays received InfoFrames. Click Refresh to update the list. Show / hide the parsed 

data by selecting Packet Info.  

Received InfoFrames 

InfoFrames tab displays in hexadecimal format the following received InfoFrames: 

• ACR (Audio Clock Regeneration) 

• ASP (Audio Sample Packet) 

• GCP (General Control Packet) 

• ACP (Audio Content Protection Packet) 

• ISRC1 (International Standard Recording Code) 

• ISRC2 (International Standard Recording Code) 

• OBA (One Bit Audio sample packet) 

• DTS (DTS Audio packet) 

• HBR (High Bitrate Audio stream packet) 

• GMP (Gamut Metadata packet) 

• EMP (Extended Metadata Packet) 

• 3D ASP (3D Audio Sample packet) 

• 3D OBA (3D One Bit Audio sample packet) 

• AMP (Audio Metadata Packet) 

• MST_ASP (Multi-stream audio sample packet) 

• MST_OBA (One Bit Multi-stream audio sample packet) 

• VSI (Vendor Specific InfoFrame) 

• AVI (Auxiliary Video Information) 

• SPD (Source Product Descriptor) 

• AIF (Audio InfoFrame) 

• MPEG (MPEG Source InfoFrame) 

• DRM (Dynamic Range and Mastering InfoFrame) 

Saving InfoFrames 

Infoframe packets can be saved in a file in binary format. Click Save and in the dialog select the 

packet types of choise. File name will be of format EMP_2022-07-28T15_54_24.bin, where EMP is 

the packet type and 2022-07-28T15_54_24 the time stamp.  

Saved packets can be evaluated and edited using Packet Editor. Please see section Packet Editor 

later in this document 
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Infoframe Features 

Observe features found in infoframes by selecting Features.  
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CEC Tab 
The CEC Tab is used for sending and receiving CEC (Consumer Electronics Control) protocol 

messages and data. 

The CEC Tab is grouped into two panels: CEC Info and CEC Controls. 
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Use CEC Controls to send data a HDMI follower via CEC protocol. Select Add button to add an 

Operation code with parameters to be sent to various devices. 

 

 

 

Logical address Logical address of destination 

Phy address Physical address of destination 

Destination Destination device 

Operation code Operation code to send 

OP Parameter Operation code parameter to send 

Device type Sender device type 

 

Select the rows of items in the table (or press the Select AllI button) and press Send button to transmit 

via HDMI CEC protocol. 

Select the rows of items in the table (or press the Select AllI button) and press Rermove to delete 

items. 
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Select the Presets button  to Save… , Load, Remove, Import… , or Exportitem sets as shown above. 

 

CEC data and status received can be seen in the CEC info panel. 

 

 

CEC Status shows the CEC Version, Operation number and Buffer status. Press Refresh button to 

refresh. 

CEC Data shows the CEC data received. Select Reset All or Reset to remove all or selected rows. 

Select Refresh to check for new data. 
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         i   i g 

Role: Product: 

USB-C DP Alt Mode Reference Source (USB-C TX) or 

USB-C DP Alt Mode Reference Sink (USB-C RX) 
UCD-424 

 

When USB-C DP Alt Mode Reference Sink or Source role is in use, the following interface specific 

tabs are available. 

• USB-C Power Delivery (PDC) 

In USB-C Power Delivery tab (PDC) operator can evaluate the status of the USB-C connection and 

USB Power Delivery Contract, the various roles adopted, and the configuration of the DP Alternate 

Mode. The user can set the initial roles for the UCD-424 test equipment and the optional capabilities 

for UCD-424 in the USB-C PD Contract. Controls allow user also to swap Power and Data roles.  

USB-C Monitoring dialog is divided into four panels. The upper left panel is a Status List indicating 

statuses of both port partners, UCD-424 and the connected DUT. 

The tabs on the right panel configuration dialogs of various USB-C interface functions. 

The bottom panel indicates status of the cable connection and PD Control controls for role swaps 
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Status List 
In Status List the information is presented in foldable sections. Each section contains information 

related to one feature of USB-C interface or PD protocol. The user can fold out the sections needed 

for the task in question.  

TE Status: UCD-424 internal status (Data role, Power Role, VConn, E-marked cable, 

DP Alt Mode, PD Contract status) 

PD Contract: Details of the PD Contract (Power Source: PDO Type, PDO Voltage, PDO 

max current; Power Sink: RDO max current, RDO operating current, USB 

statuses) 

 

Available source PDO: (PDO 1, PDO 2) 

BUS Electrical Status: (Vbus voltage, Vbus current, CC1 voltage, CC2 voltage, VCONN voltage, 

VCONN current, SBU-1 voltage, SBU-2 voltage) 
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DUT Discovery: DUT information (data capable as host, data capable as device, product 

type, USB vendor ID, USB product ID, BCD device, SVID0, SVID1) 

DP Alt Mode support: Supported DisplayPort Alt Mode features (Supports DP v 1.3,  

Supports USB gen2, Pin Assignments supported as DFP_D, UFP_D, and 

DPAM Version) 

 

 

  
TE DP Alt Mode 

Status: 

UCD-424 internal DP Alternate mode status (Status, Multi-function 

preferred, HPD state, Select DP v1.3, Select USB gen2, Pin Assignment, 

Cable UHBR 13.5 Support, Cable Active Component, DPAM Version) 

DUT Alt Mode Status: Status of the connected USB-C port partner gained from status update 

messages (Status, Multi-function preferred, HPD State, Power low, No 

DPAM Suspend) 
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Capabilities 

Initial Role: Defines the role which UCD-424 presents itself in the start PD 

communication (both power and data role). 

Reject Swaps: Allow or reject mode swap requests from the connected port partner. 

CC Pull-up: Control of Rp that Source uses to advertise the initial current source 

capability using USB-C Current method. 

Try Behavior: Control the USB-C PD role that UCD-424 initially takes in the connection 

handshake. 

UCD-424 Identity: Status information provided by UCD-424. 

Accessories 

Audio Accessory: Enable simulation of Audio Accessory support 

Debug Accessory: Enable simulation of Debug Accessory support 

 

Enabling Audio Accessory and Debug Accessory extends USB Type-C Connection State Machine 

with *.Accessory states. (Please refer to USB Type-C specification for details). 

Note: Please note that UCD-424 does not support any physical connections for the Accessory functions. 

The selections enable only behavioral simulation. 
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DP Alt Mode 
Controls and capability settings for DisplayPort Alternate Mode. 

Enter 2 lane mode (D): Restart mode discovery and advertise support for mode D  

(2 DP lanes + USB SS). 

Enter 2 lane mode (C,E): Restart mode discovery and advertise support for modes C 

and D (4 DP lanes). 

Exit DP Alt Mode: Exit DP Alternate mode. 

Disable DP Alt Mode: Exit DP Alternate mode and advertise no DP Alternate mode 

support. 

Auto enter on connect: Start mode discovery after connection and enter DP Alternate 

mode if suitable configuration is found. 

“DP to Type-C Cable Adapter” 

mode: 

Perform an automated procedure for connecting a DP to 

USB-C bidirectional cable. Please find an abstract of the issue 

below. 

Multi-function preferred: When entering DP Alternate Mode, select mode D. 

 

DP to Type-C Cable Adapter 

USB-C to DP Bi-directional Cable contains an active converter microchip that needs to be 

powered from USB-C interface. Therefore UCD-424 must be initially configured in power 

source role for USB Default Operation where it applies vSafe5V on Vbus to power up the 

microchip in the cable. 

USB-C to DP Bi-directional Cable uses pin assignment E when acting as a source. In order to 

provide the “cable” a possibility to request the configuration it needs, UCD-424 has to initiate 

a Data Role Swap to be in UFP, Device, data mode. 

DP Alt Mode Capabilities 

Supported Pin Assignments declared in DisplayPort Capabilities discover message. Separate for 

UFP_D (DisplayPort sink) and DFP_D (DisplayPort source) 
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Power Source 
Definition of Power Data Objects (PDO) for UCD-424 when acting as Power Source Port. 

PDO Type: Definition of power source type (Mandatory, Disabled, Fixed, Variable or Battery) 

Note: The requirement is that Sources shall supply at least one fixed supply capable of supplying vSafe5V 

 

Note: Please note that UCD-424 is not able to simulate as Source the electrical behavior of Variable and 

Battery source types. 

Refresh Re-read status from UCD-424 

Apply Program new values to UCD-424 

Send PDO Send a Source Capabilities message 

Load PDO Load a stored Power Source PDO configuration from file. 

Save PDO Store current Power Source PDO configuration to a file 
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Power Sink 
 Controls and Definition of Power Data Objects (PDO) for UCD-424 when acting as Power Sink Port. 

Give back flag: UCD-424 sets GiveBack flag in its Request Data Object 

No USB suspend: UCD-424 sets No USB Suspend flag in its Request Data Object 

PDO type priority: Setting of the policy used for automatic selection from available PDOs 

advertised by Source Device. (Prefer higher current / Prefer higher 

voltage / Prefer higher power) 

Max Operation 

Current 

Setting the highest current UCD-424 will ever require when operating as 

a Power Sink. 

 

PDO Type: Definition of power source type (Disabled, Fixed, Variable or Battery) 

Note: The requirement is that Sources shall supply at least one fixed supply capable of supplying vSafe5V 

 

Refresh Re-read status from UCD-424 

Apply Program new values to UCD-424 

Load PDO Load a stored Power Source PDO configuration from file. 

Save PDO Store current Power Source PDO configuration to a file 
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Cable Info 
Cable Info tab displays the information received from the cable as a response to Discover Identity 

command sent to SOP’. 

Note: Please note that cable info can only be read when in DFP Data Role. 
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Controls 
Control tab includes miscellaneous controls related to UCD-424 behavior as a USB-C PD Port 

Partner. 

PD Contract Settings 

Automatically negotiate power contract: When selected UCD-424 will start power contract negotiation 

if suitable configuration is found.  

ET cable USB2.0 differential pairs 

There are two versions for Unigraf Electrical Test Cable. The difference is the number of USB D+/- 

pairs included in the cable. The reasoning is that if an unused pair is not terminated, it is a receiver of 

EMI and disturbs the electrical circuitry. 

Cable with P/N 546117 has two USB2.0 pairs (A6, A7 and B6, B7), while P/N 546114 has only one 

pair (A6, A7). Please update the control accordingly. 

If DUT has shorted USB2.0 pins A6 to B6 and A7 to B7 at the receptacle then choose cable One: In 

order to minimize in-cable signal coupling only one USB D+/- pair is included in the cable 

If DUT has shorted USB2.0 pins routed to mux or similar, then choose cable Two: In order to enable 

electrical cable flip in cases where USB D+ lines and USB D- lines correspondingly have not been 

shorted together on Device side, both USB D+/- pairs are included in the cable. This cable marked 

with a label “ xUSB  .  PAIRS”. 

USB Communication Capable 

You can control the USB Communication Capable bit in its Request Data Object. 

Note: Please click Apply to enable changes. 
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Bottom Panel 
Bottom panel includes statuses and controls for the USB-C connection 

Status 

PDC Status LED for USB-C Power Delivery Control 

Reset: Reset the PD Controller in UCD-424 to overcome abnormal situations. 

Orientation: Straight (CC1 terminated) or Flipped (CC2 terminated). 

DUT Attached: Indication that Attach is detected by the Source port in one of its CC lines. 

Reconnect: Restart USB-C Source-to-Sink attach procedure. 

PD Control 

Send PR_SWAP: Send PR_Swap message to request an exchange of power roles. 

Send DR_SWAP: Send DR_Swap message to request an exchange DFP and UFP operation 

between Port Partners while maintaining the direction of power flow over 

Vbus. 

Send VCONN_SWAP: Send VCONN_Swap message to request an exchange of Vconn Source. 

Send FR_SWAP: Send FR_Swap message to request a Fast Role Swap. 
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 GENERATOR OPERATION 
When used as a Generator, the UCD device acts as DisplayPort, HDMI or USB-C DisplayPort Alt 

Mode Source or Transmitter device. Generator functionality related controls and dialogs can be used 

by selecting DP TX or HDMI TX tabs.  

Please note that in most UCD-4XX Series units Analyzer functionality is available simultaneously with 

Generator functionality. Please find description of Analyzer functionality earlier in this manual.  

Functionality Tabs 
UCD Console features are presented in tabs. Standard tabs are similar in all functional roles, Interface 

Specific tabs present features and controls that are only available for a particular interface. 

Some of the tabs are enabled by default, some only when an applicable license is included.  

Standard Tabs 

Analyzer role features six standard tabs: 

• Video pattern generator (Pattern Generator). 

• Content Playback (Playback) 

• EDID editor (EDID) 

• HDCP status monitor and control (HDCP) 

• Sink DUT Testing 

• Adaptive-Sync 

 

Interface Specific Tabs 

Depending on the connected UCD device, additional interface specific tabs will be available  

UCD-400, UCD-411, UCD-451 and UCD-424: 

DP and USB-C DP Alt Mode Reference Source 

• Status information and control of the downstream link (Link). 

• DPCD monitor (DPCD) 

• Forward Error Correction (FEC) 

UCD-422, UCD-452 and UCD-412: HDMI Reference Source 

• Status information and control of the downstream link (Link). 

• SCDC monitor (SCDC) 

UCD-424: USB-C Reference Source 

• USB-C Monitoring (PDC) 

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to Appendix B Licensing of this document for description of features and licensing 



  Generator Operation 

UCD-4XX User Manual • UCD Console 3.6 83 

         T    

Pattern Generator Tab 
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Note: The video modes that can be used in MST streams are limited by the overall capability of the 

DisplayPort link and the capability of the connected DisplayPort Sink or Branch device.  

Auto-Apply (DP): New settings are being validated when the user is clicks Apply. 

Automatic validation is applied when Auto-Apply is checked. 

When Select DSC Image pattern is being streamed and an incompatible 

Horizontal and Vertical Active timings are set, the user is presented 

with a dialog: H-Active and V-Active don’t match with DSC data. Do you 

want to upload image? See Sourcing DSC Compressed Patterns. 

Apply All (DP): Apply recent changes to all streams. 

When Select DSC Image pattern is being streamed and an incompatible 

Horizontal and Vertical Active timings are set, the user is presented 

with a dialog: H-Active and V-Active don’t match with DSC data. Do you 

want to upload image? See Sourcing DSC Compressed Patterns. 

MST (DP) Enable multi-stream transport mode. In 8b/10b link mode, select 

between SST and MST transport modes. In 128b/132b link coding 

mode, enable single stream output without stream allocation using 

Sideband messages if checkbox is cleared. 

Number of streams 

(DP) 

Set number of steams via combo box. 

Force EDID preferred 

timing after LT 

UCD reads the EDID of the connected Sink and after next LT enables to 

Stream 0 the timing listed in 18-byte descriptor 1 in VESA block of the 

 i k’  E     

Use timings from EDID UCD reads the EDID of the connected Sink and lists only timings that 

are featured there. 

Manage Timings Please see chapter Manage Timings later in this manual. 

Total bitrate: Used link payload / Total link capability in Gbps (Pls see Note below). 

Auto-Apply (DP) To avoid sourcing invalid video mode combinations new settings are 

being validated when the user is clicking Apply. 

Automatic validation will be applied when Auto-Apply is checked. 

Apply Apply recent changes. 

 

Pattern Generator Status panel shows the Timing, Pattern (Name), CEF (color format and 

subsampling and colorimetry), BPC (bits per color), Status, and CRC value, for each active stream. 

Note: A full description of Minimum link configuration combinations for UCD standard video modes is 

available. Please contact Unigraf for details. 
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Pattern 

Configuration of the video sent in the corresponding stream  

(Controls vary between selected pattern type) 

Predefined Timings 

The list includes a set of common fixed video timings. Please find a list of the timings with their major 

details in Appendix C of this document. With Manage Timings function the user can add timings in 

the list and select which timings are shown in the selection. 

Color Depth 

Available color depths are: 6, 8, 10, 12 and 16 bpc. Color depth 6 bpc is only available when using 

RGB color format in DisplayPort or DisplayPort Alt Mode. 

Video Pattern 

The selection includes a set of predefined patterns and a possibility to load user defined custom 

patterns. Please find a description of the available predefined patterns in Appendix D of this 

document. By selecting Disabled you can have the links activated but no video data transferred. 

Note: When MST mode is selected, full selection of test patterns is available only in stream 0  

Filter 

Filter timings by specific vendors and resolutions. Timings can be sorted by Vendor ID or width. 

HDMI timings are sorted by VIC number by default. 

 

Custom Image Patterns 

BMP, PNG, and JPG files can be loaded from the PC to be used as custom images. 

Please refer to Link Pattern in description of DP and DP Alt Mode Reference Source Link tab later in 

this manual for sending special DisplayPort binary patterns in the link instead of video.  

Color Depth 

Predefined  

Timings 

Selected 

Pattern 

Color Format and Subsampling 

Pattern 

Option

s 
Colorimetry 

Load pattern file Loaded 

pattern file 

Bitmap scaling 

Quantization 

Range 

Filter 
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Bitmap Scaling 

When bitmap patterns are used, they can be used either in their original resolution, aligned to left top 

corner (=un-check Scale), or upscaled or downscaled to match the selected video resolution (=check 

Scale). 

Pattern Options 

Some of the predefined patterns include additional configuration parameters. The controls for the 

parameters appear below the pattern selection when the pattern in question has been selected. 

Please find a description of patterns options in Appendix D of this document. 
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Pattern Scrolling 

When Pattern Scrolling is enabled, the pattern is moved horizontally and vertically between display 

scans. The function is available for all patterns except the following: Color Bars, Chessboard, Solid 

Color, Solid colors (white, red, green, blue), White V-Strips, Motion Pattern, DSC Pattern. 

Enable: Enable or disable pattern scrolling 

Horizontally X pixels: Horizontal step of the pattern movement in pixels  

(values in range -127… …128,     Y     4:2:2  v   v     )   

0 = no movement, positive values = pattern moves to the right. 

Vertically Y pixels: Vertical step of the pattern movement in pixels  

(even values in range –127… …128,     Y     4:2:   v   v     )   

0 = no movement, positive values = pattern moves up. 

Every N frame:     y    p         v      i   i p  y        (v      i     g   … 255)   

0 = no movement, 1 = move every frame, n = move every n:th frame. 

Note: Please click Apply to enable changes or check Auto-Apply. 
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Sourcing DSC Compressed Patterns 

UCD Pattern Generator function can source DSC content originating from pre-created DSC 

compressed files. DSC compressed pattern files can be created with a separate tool called DSC 

Compressor. It can be launched from Tools > DSC Compressor. 

 

Select the source bitmap file in Source File field. Define the Output Resolution, the color depth, 

compression ratio and number of horizontal and vertical slices in the frame. 

Source File: Source bitmap file to be compressed (JPG, PNG, PPM) 

Sink DSC capability registers: Click Update to read DPCD registers 0x60 to 0x6f from the connected 

Sink device 

Color Space: Color space of the output compressed file (RGB, YCbCr 4:4:4, 4:2:2, 

4:2:0, Simple 4:2:2) 

Color depth: Color space of the output compressed file (8, 10, 12, 16) 

Output resolution: Resolution of the output compressed file 

Resize mode: The way the DSC image is created from the Source file 

Compression ratio: Used compression ratio 

Horizontal slices: Nr. of slices horizontally (1 to 24 Slices) 

Vertical slices: Vertical slices (1 to 24 Slices, Custom)  

Custom vertical slices size: minimum 1, recommended 108 

YUV Color range: Selection of color range between Full range (Full) (0 to 255 at 8 bpc) 

and Limited Range (CTA) (16 to 235 at 8 bpc) 

Refresh: Refresh the list after adding a custom resolution 

Custom: Create a custom output resolution  

DSC Version: DSC version used (1.1, 1.2) 

Line Buffer Depth: Line buffer bit depth used to generate the bitstream. (8 to 16 bits, 

default 9 bits) 

Open storage folder: Open DSC temp folder defined in Tools > Options 

Start Compression: Start the compression process 
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Result of the compression process is saved in the same folder as the source file. The start of the file 

name is the same as the source bitmap file; resolution and color format are added to the end of the 

file name. 

Example:  

unigraf_default_image_16k.ppm >> 

unigraf_default_image_16k_1920x1080_YUV422_FULL_bpc8_bpp6.dsc 

To use the created DSC file in Pattern Generator, select pattern: Select DSC Image and click Select 

… to open file selection dialog. 

When a DSC image is selected as the pattern, UCD Console will automatically enable DSC, provided 

that the connected Sink device declares support for DSC in its DPCD. 

When Select DSC Image pattern is being transmitted and incompatible Horizontal and Vertical Active 

timings are set (Via Apply or Apply All), the user is presented with a dialog: H-Active and V-Active 

don’t match with DSC data. Do you want to upload image? 

 

 

 

 

 

Above, “Do you want to upload image?” is misleading and will be changed to “Continue to transmit 

image?”. 

If you select No, the new settings will not be applied. 

If you select Yes, the Pattern will continue to be transmitted. DSC data is transferred in the active 

window. To transfer all DSC data without loss, active video should be large enough for DSC 

compressed data (DSC_pic_height * DSC_pic_lenght / compression_ratio). MSA H-active should also 

not be less than DSC pic_height. 

MSA V-active parameters can be reduced without DSC corruption until active video area is no longer 

large enough to pass all DSC data. 

MSA V-active and H-active can be increased until HW limitation (pixel clock limit) and link bandwidth 

are reached. 
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Preview DSC image 

 

To preview an DSC image before it is applied to the pattern generator, select the eye icon. CRC and 

DSC CRC values will be indicated in the preview image. 
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Manage Timings 

Custom timings can also be created and edited with pop-up Timing Editor. Launch the editor by 

clicking Manage Timings. 

Customizing Timings List 

The list of timings that are shown on the pull-down menu in Pattern Generator and Link tabs can be 

limited by un-checking the checkbox in the left edge of Name column. The timings will remain in the 

list and can be brought back to the pull-down menu, when needed. 

Editing Timings 

Video timing Name and Description are shown in the list. Lock icon  indicates that a timing is a 

fixed timing which cannot be edited or deleted. Custom timings are indicated with a head icon . 

New: Create a new custom timing based on the selected fixed timing. 

Delete: Delete the selected custom timing 

Save: Save changes in the selected custom timing. 

Revert: Undo all changes 

The dialog parameters will be sanity checked and will warnings issued for illegal combinations. 

HDMI Timing Generator (UCD-422, UCD-412) 

 

HDMI Timings can be generated and applied via the Timing Generator group. 
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To do this select CTA or OVT timings radio button. Select desire RID and FR or VIC in combo boxes 

and then click the Generate button. 

The generated values will be reflected in the Frame parameters. Click Apply to set timing.  
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Playback Tab 
Role: Product: 

DP Reference Source (DP TX) UCD-424, UCD-400, UCD-411 

HDMI Reference Source (HDMI RX) UCD-422, UCD-412 

 

Playback allows for running predefined Playlist files. Playlist contains a set of Scenarios with definitions 

of the timing, video pattern, audio content and related metadata packets and their duration. 

 

Term Functionality 

Playlist 

Playlists (text files) specify the UCD devices 

and output protocol for transmission. It lists 

scenarios to be transmitted. 

Scenario 

Scenarios (text files) allow users to select 

video frames, metadata packets and audio 

to be transmitted and their order. 

Advanced Playlists 

Unigraf UCD devices can also be used as a 

compatibility test tools for dedicated 

standards such as Dolby Vision™ and 

HDR10+. Contact Unigraf for details. 

Note: Note that Playlists and Scenarios are protocol dependent.  

Provided examples for HDMI and DisplayPort are somewhat different.  
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Common Tab 

The Import button is for importing *.json files into the common tab treeview. Sample content on 

windows can abe found at C:\Program Files\Unigraf\Unigraf UCD Tools\Resources\playback\ 

basic_library.json. Be warned that once imported, items cannot at present be removed. Actually you 

can but it involves using Windows Register Editor to remove values from (uninstall will not help): 

Computer\HKEY_CURRENT_USER\SOFTWARE\Unigraf\UCD Console\Playback 

Computer\HKEY_CURRENT_USER\SOFTWARE\Unigraf\UCD Console\MetadataScenario  

Sample playlists are included in UCD Console. Select a sequence (a scenario) from the playlists and    

press Run (or double click it) to play.  

The Run button lable changes to Stop as a Scenarios run. Press Stop to stop playing the scenario. 

Press Skip to skip to next scenario (available when there are multiple scenarios in a playlist) while 

playing. While the scenario is loading the Run button lable changes to Cancel to allow cancelation. 

Figure below shows a playlist being run that contains a prompt command which pops up a dialog. 

 

 

Status Log 

Scenario commands are listed in the Status Log  as they are run. 
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Selected Sequence 

Running scenario video and audio details and their sources are shown in the Selected Sequence 

group panel. 

Note that the triggered scenario or playlist to be run is the last selected: If an item was selected via 

the treeview, it is the triggered item to be run. If the Select button was used to select an item, it is the 

triggered item to be run (regardless of what is selected in the tree control). 

Press the Select button to load a playlist or scenario to be run (selecting a sample from the Sample 

Content treeview will load them as the playlist or scenario to be run). Also it will be the scanario used 

as a template if the Scenario Editor is launched: default scenario values will be set if a playlist is 

selected. 

Press the Editor button to launch the Scenario Editor (see below). 

The Selected Sequence parameters are the transmission stream parameters. 

 

  



  Generator Operation 

UCD-4XX User Manual • UCD Console 3.6 96 

Scenario Editor 

 Press the Select button above to select the scenario desired to use as a template for creating a new 

scenario. Press the Editor button to launch the Scenario Editor. The the dialog paramaters will be 

generated from the scenario file shown under the panel Source label (Philips FHD.txt as seen above). 

Press the Path :…for setting the Video, Packets or Audio paths. 

Press OK to save. Your are presented with a save dialog. You need to navigate to a directory you can 

save to. Run Conssole 2 with administration rights if you want to save to default locations on 

windows such as: C:\Program Files\Unigraf\Unigraf UCD Tools\Resources\playback\content. 

Refer to Appendix H: Playlists and Scenarios later in this manual for details. 
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Metadata Tab 

The Metadata  tab is for creating scenarios with metadata. 

 

 

Select the Delete button to delete a scenario or the Generate button to launch the Custom Metadata 

Scenario dialog (shown below). 

 

Current Pattern Generator timing details are shown at the top. You can change the color mode 

(RGB444, YUV444, YUV422, YUV420) and color depth (8 bpc, 10 bpc, 12 bpc, 16 bpc) via the 

dropdown combo boxes. 

Select the Add or Delete buttons to add or remove metadata from the scenareio. 

Check the Audio checkbox and then the Browse… button to add an audio file. Sampling, channels 

and bits can be selected via the combo boxes. 

The scenario Comment can be added in line edit box after the three dashes (---). 

Use the Content folder Browse… button to select save location. 

You can press Play to run the scenario, Export to save it or Cancel to cancel. 

Export will  create a folder something like Metadata1920x1080@60-RGB444-8bpc in the Content 

folder. In it you will find  generated files frame.svg (displaed while running), the metadata files you 

selected and a scenario.txt file. You may edit and rename these files. 

. 
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HDR10+ Test Tab 

Please refer to HDR10+ CTS User Manual for detailed description of the tab. 

VRR/QMS tab 

 

Click Generate to generate custom VRR and QMS scenarios. Custom Scenario Generator window 

will open. 

 

First you are asked to select the folder where the generated content will be stored. 

 

Click Browse… to select the folder. 

 

Timing details 

The uppermost part of the window shows the timing details. Please, note that the timing is set on the 

pattern generator tab. You can change the color mode (RGB444, YUV444, YUV422, YUV420) and 

color depth (8 bpc, 10 bpc, 12 bpc, 16 bpc). 
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VRR settings 

In the VRR tab you can set the transition and scenario duration parameters. Different transition types 

are Fixed frame rate, Min and max and Gradual. When fixed frame rate is selected, the scenario is 

played at the minimum frame rate set in the first field. Please, note that when the fixed frame rate is 

selected, you can only select the number of times the frame is repeated. 

 

When min and max is selected, the output sceario will alter the framerate between the specified 

values. You can also set the duration for step in seconds and select how many times frames are 

repeated. 

 

When gradual is selected, the frame rate is changed with each frame. For example, when min frame 

rate is set at 20 and max is set at 60 and the scenario has 40 frames, frame rate would be incremented 

by 1 with each frame. 

Info at the bottom of the segment shows the minimum and maximum values for VRR framerate defined 

in EDID, and the base frame rate set in the pattern generator. 

 

QMS settings 

In the QMS settings dialogue you find all the frame rates included in the QMS specification. Select 

which frame rates you want to inlcude in your scenario. Also select the step duration in cycles. In the 

lower left corner details of the scenario as shown. 
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Video 

 

The section at the bottom shows details of the output video. The default pattern is a spinner. You can 

select the speed of the spinner video from the predefined options in the drop-down menu or you can 

set a number of frames it takes for the spinner to rotate a full circle. You can also select a custom 

video. The supported file types are .jpg, .png, .gif, .bmp, .tiff, .ppm and .tif 

Available memory is shown in bytes and frames. Below, the folder selected for the sequence is shown. 

You can change the folder by clickin Browse… Lastly, the duration of the sequence is shown in 

frames. 

You can export the scenario by clicking Export. When exporting, you are asked to select a location 

for the export. The content folder will be automatically created in the chosen location. The folder 

inlcudes the image files, packets and scenario parameters. 

You can play the scenario by clicking Play. When the scenario is ready for playing, the scenario 

generator window will close. You can now inspect the progress in the log in the playback tab as shown 

below. 

Adaptive-Sync tab 

 

Click Generate to generate custom Adaptive-Sync scenarios. Custom Scenario Generator window 

will open. 
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First you are asked to select the floder where the generated content will be stored. 

 

Click Browse… to select the folder. 

 

Timing details 

The uppermost part of the window shows the timing details. Please, note that the timing is set on the 

pattern generator tab. You can change the color mode (RGB444, YUV444, YUV422, YUV420) and 

color depth (8 bpc, 10 bpc, 12 bpc, 16 bpc). 

 

Adaptive-Sync settings 

In the Adaptive-Sync section you can set the transition and scenario duration parameters. Different 

transition types are Fixed frame rate, Min and max and Gradual.  

When fixed frame rate is selected, the scenario is played at the minimum frame rate set in the first 

field. In scenario duration, select how many times frame is repeated. 
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When min and max is selected, the output scenario will alter the framerate between the two values 

set in the drop down menus. You can also set the duration for step in seconds and select how many 

times frames are repeated. 

 

When gradual is selected, the frame rate is changed with each frame. For example, when min frame 

rate is set at 20 and max is set at 60 and the scenario has 40 frames, frame rate would be incremented 

by 1 with each frame. 

Info at the bottom of the segment shows the minimum and maximum values for VRR framerate defined 

in EDID, and the base frame rate set in the pattern generator. 

 

 

Video 

 

The section at the bottom shows details of the output video. The default pattern is a spinner. You can 

select the speed of the spinner video from the predefined options in the drop-down menu or you can 

set a number of frames it takes for the spinner to rotate a full circle. You can also select a custom 

video. The supported file types are .jpg, .png, .gif, .bmp, .tiff, .ppm and .tif 

Available memory is shown in bytes and frames. Below, the folder selected for the sequence is shown. 

You can change the folder by clickin Browse… Lastly, the duration of the sequence is shown in 

frames. 

You can export the scenario by clicking Export. When exporting, you are asked to select a location 

for the export. The content folder will be automatically created in the chosen location. The folder 

inlcudes the image files, packets and scenario parameters. 

You can play the scenario by clickin Play. When the scenario starts playing, the scenario generator 

window will close. You can now inspect the progress in the log in the palyback tab as shown below. 
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Audio Generator Tab 
Audio generator allows the user to play LPCM audio generated internally or from files in WAV format. 

Audio is played to all active ports. 

To load internally generated audio, select Generate Audio, and adjust the controls to the desired 

audio format. 

To load an audio file from your PC, select Load Audio from File, click the Open WAV file… button, 

browse and select the file and Open. 
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The Compressed checkbox indicates that the audio loaded from the selected file is compressed. 

To play the selected audio content, click the Play. 

The content will be transmitted until the Stop button is clicked.  

Audio Status displays current audio content status.  

Audio Content 

Sent audio can be generated internally or used a WAV file loaded from the PC. 

In case of a WAV audio file, the parameters stored in the file will be used. When generating audio 

internally, the user sets the details of the LPCM Audio signal. 

Waveform Selection of audio waveform: Sine, Sawtooth, Square, or Incremental 

Signal Frequency Setting audio signal frequency in Hz. 

Sample Rate (Hz) Selection of audio sampling rate: 32000, 44100 (default), 48000, 

88200, 96000, 176400, 192000. 

Bits/Sample Selection of sample bit depth: 16, 20, 24. 

Amplitude(%)       i         i    p i    : 1 %, 2 %, …, 9 %, 1  %. 

Channels Audio channels available: 1, 2, …, 7, 8  

Channels transmit LPCM (uncompressed) Audio. 

HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content Protection) status 

and controlling the HDCP capabilities of the UCD device. 
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Status General 

The status fields indicate the HDCP status of the UCD device. 

Active: The stream between UCD and the downstream sink has been encrypted. 

Authenticated: HDCP handshake between the UCD and the sink unit has been completed 

successfully. 

Keys loaded: HDCP keys are loaded to the UCD unit. 

Km is stored: Master Key (Km) is stored. 

SST Mode Type Type when in SST mode. 

Status By stream 

Stream status (DP) shows HDCP status on each stream. 

Configuration Control 

Enable encryption: Check to enable the encryption of the stream between UCD and the 

downstream sink. 

Authenticate: Perform the HDCP initiation handshake between the UCD and the sink unit. 

Use stored Km: Use stored Master key (Km). 

Configuration type 

Select to configure HDCP (DP) or All streams at once or By stream. 

By stream 

Select and configure streams (DP). 
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Type Value 

Select Type 0 or Type 1. Type 1 ensures that content encryption is done with HDCP version 2.2 or 

higher. 

Configuration Keys 

Select Production or Facsimile HDCP keys. To remove the keys, select None.  

HDCP 1.3 / 1.4 and HDCP 2.3 

DisplayPort currently only supports HDCP 2.X.  

See ReleaseNotes.txt, Known issues (Limitations) in bundle to see limitations: 

C:\Program Files\Unigraf\Unigraf UCD Tools\documents\ ReleaseNotes.txt on Windows. 
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EDID/DisplayID Tab 
EDID/DisplayID Tab provides tools for accessing the EDID/DisplayID data of the connected sink 

device. There are three basic functions: 

• Load and save the data files in the host PC. 

• Edit the data contents either in Editor Mode or in Hex Edit Mode. 

• Read and write data to the connected sink. Up to 4 virtual channels can be accessed. 

EDID/DisplayID Files 

With Load… and Save As… a file can be read into the editor or written to a file from the PC.  
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At top the DisplayID tab dialog are radio buttons to control how DisplayID data is read: Disabled, Try 

DisplayID, else EDID, and Read both DisplayID and EDID.  These have no effect when downloading 

from the sink unless the sink supports DisplayID. 

 

The contents of the device EDID/DisplayID file are not modified, or integrity checked during load and 

save operations. 

Note: Four blocks (512 bytes) of EDID/DisplayID code are read. If the device does not support all four 

blocks, the non-supported data values are set to zero. 

In the Editor Panes (upper right pane), the Text EDID and Text DisplayID tabs allow viewing data in 

tree form. 

EDID/DisplayID Editor 

Please see the description of the EDID editor in Chapter EDID/DisplayID Editor later in this document. 
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Panel Replay Tab 

 

Current Pattern Capabilities panel displays what features are supported. Selecting different 

patterns in the Pattern Generator will affect supported features shown here. For example Patter 

Generator pattern Color Bars will disable Early Transport capability wheras Color Squares will enable 

it. 

 

Command panel has the following functions (reflected in the Status panel below it): 

Disable Disable Panel Replay. 

Inactive mode Set mode to inactive. 

Active mode Set mode to active. 

Full-screen update Transmit Full-screen update. 

Selective update Transmit selective update (shown in Command Status and History). 

 

Status panel reflects the Command Status, Status and Error. 

Command Status will show Selective update when Active mode and Selective update buttons have 

been selected (see above); otherwise it will display No command. 

Status will show state: Disable, Inactive mode or Active mode. 

Error will show  No error, Incorrect command or an error message. 

 

History panel displays results from applying commands in the command panel (see above). 

 

  



  Generator Operation 

UCD-4XX User Manual • UCD Console 3.6 110 

The Configuration panel allows users to configure Panel Replay behavior. 

The  Mode combo box allows mode selection: PR, PSR1, PSR2. 

Configuration checkboxes available are: 

Early transport: can be set when  supported in Current Pattern Capabilities  

HPD_IRQ on missing AS SDP 

HPD_IRQ on uncorrectable VSC SDP error 

Enable CRC check 

HPD_IRQ on RFB storage error 

HPD_IRQ on actaive frame CRC error 

Main-link remains ON during PSR1/PSR2 

Self refresh unlock 

SU extended Y granularity 

Frame Capture 

SU:Region scan line capture 

 

The available parameters for Frame1 and Frame 2 for Region 1 and Region 2 are: 

X coordinate X coordinate of region 

Y coordinate Y coordinate of region 

Width Width of region 

Height Height of region 

 

These are the transmitted blocks sent when command Selective update is pressed (see above). 

 

The  Apply button is used to set the Configuration panel state. 
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Sink DUT Testing Tab 
Refer to Appendix E for descriptions of the tests available. The tests are presented in a split view, the 

left being test categories and the right being the tests within.  
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Select the tests for execution by checking checkboxes or by clicking the test name. All tests item on  

the left hand side is really just for viewing all tests available. Select the desired test category (ex. DP 

1 .4 LL CTS) when running tests. 

Run/Run 

Checked: 

Select to start selected/checked tests. Once tests are running the Run Checked 

button is relabeled Abort to stop the test sequence if desired. 

Select: Includes three sets of options: Select All, Clear All, Invert All for changing the tests 

current selections; Save (checked items), Load (and check relevant items), Remove 

(named tests list) for handling named templates; Import (check all items contained in 

file) and Export (save all checked items to file) for loading and saving file-based 

templates. Do not confuse Import and Export with those below: These are for setting 

and saving tests to run. 

Configure: Opens a test parameters dialog for the selected test set. Make sure a test category 

other than All tests is selected. Refer to Test Parameters below for details. 

Import: Load saved test parameter files (*.td or *.json) for into UCD Console. Select 

Configure to see current parameters.  Loading *.td files to UCD Console is currently 

unreliable. 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For saving 

parameters for TSI scripting, please use *.td files. For use with Python applications, 

use *.json files. 

Stop on Failure: Stops execution of tests if one fails.  

Repeats: Number of times to repeat the selected test sequence. 

Delay time: Delay in seconds between individual tests. 

 

On completion of each test the result of the test is displayed in the table columns on the right. For 

each test the table lists the number Pass, Fail, Skips, Runs and Last Status (status of last run). 

Save Report: Select to generate a HTML report file. This will also open a tab in the default 

browser and display the results. 

Clear Selected Clear the test results of the selected (not checked) tests results. A 

subsequently saved report will not include these test results. 

Clear All: Clear the test log view and the outstanding results. 
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Test Parameters 

Each test set has its dedicated set of test parameters. To open a dialog for defining the parameters 

click Configure. 

Description of parameters for each test set can be found within the description of tests in Appendix E 

of this document. 

Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Sink DUT Testing tab to a *.td file for later use in UCD Console, to run TSI 

scripts, or to share test parameters with someone. Presently importing *.td files into UCD Console 

is unreliable. 

• Export parameters in Sink DUT Testing tab to a *.json file for later use in UCD Console, to run 

Python scripts, or to load test parameters into UCD Console. 

• Save parameters in Configure dialog as Presets later to be used in UCD Console. See description 

below. 

Presets 

All Configure dialogs selected parameters can be saved and loaded via Presets dropdown menu. 

Select Save or Load for named internal configuration parameter sets. Select Remove to delete a 

named internal set. Select Import and Export for loading and saving parameter sets from and to  

external files. Note that importing and Exporting *.json files here have a different format than importing 

those described above. 
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     A  p iv   y   T   

Adaptive-Sync feature is available for Stream 0. 

 

 

 

Auto enabled if supported by Sink: The feature is enabled based on connected Sink status 

Disabled: Feature is disabled unless Auto Enabled … box is 

checked. Please see the note below. 

Adaptive Total, constant refresh rate: Added blank lines 

Adaptive Total, Square pattern: Added blank lines, min; Added blank lines, max; Period, 

frames. 

Adaptive VTotal, Zigzag pattern: Added blank lines, min; Added blank lines, max; Increase, 

lines; Decrease, lines. 

Fixed Average VTotal: Target refresh rate, Hz; Increase, lines; Decrease, lines 

Note: Please note that in case Auto enabled if supported by Sink is selected and the connected Sink device 

supports Adaptive-Sync, but the selected mode is Disabled, then Adaptive-Sync is enabled in mode 

“Adaptive Total, constant refresh rate” with   (zero) added blank lines. Control dialog will be updated 

to indicate the status. 
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Role: Product: 

DP Reference Source (DP TX) UCD-400, UCD-411, UCD-451 

USB-C DP Alt Mode Reference Source (DP TX) UCD-424 

 

When roles DP Reference Source or DP Alt Mode Reference Source are in use, the following interface 

specific tabs are available. 

• Status information and control of the downstream link (Link). 

• DPCD monitor (DPCD) 

• Forward Error Correction (FEC) 

Link Tab 
Link tab shows the status and control items for the DisplayPort link. 
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Link Status 

Link Status displays the status of the link training and the link parameters negotiated between the 

connected Sink and UCD Source. It also lists status of other link modes. The data is retrieved from 

the DPCD status registers of the connected Sink. The status is updated automatically.  

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt Mode. 

CR/SL/EQ: LED indicators for status of Clock Recovery / Symbol Lock / Channel 

Equalization 

VS/PE (level): Voltage Swing / Pre-emphasis level 

Error count: Content of DPCD Error Count registers 

ILA: Status LED for Inter-Lane Alignment 

Bit rate: Currently enabled link bit rate 

Link mode: Currently enabled channel coding (8b/10b only) 

Framing mode: Status of Enhanced Framing symbol sequence 

Scrambling: Status of link data scrambling (Enabled or Disabled) 

MST mode: Status of the Multistreaming (MST) mode 

SSC status: Status of down spreading of link frequency (SSC) function 

DSC Status: Status of Display Stream Compression (DSC) function 

FEC status: Status of Forward Error Correction (FEC) function. 

 

Send ACT: Force sending an Allocation Change Trigger (ACT) sequence over the Main-Link  

 

HPD 

Asserted: LED indicates status of Hot Plug Detect (HPD) signal 
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Link configuration 

Set target capabilities for the link training. Click Link Training or Fast LT to apply.  

 

Number of Lanes Lane count used when 8b/10b link coding is selected in LT 

 Bitrate, Gbps Link rate used when 8b/10b link coding is selected in LT 

Additional DP Bitrate 

(8b/10b), Gbps 

Additional bit rates available. 

eDP Bitrate, Gbps Bitrates available for eDP. 

Enhanced Framing Mode Enable Enhanced Framing Mode. 

FEC (8/10b) Enable Forward Error Correction feature (only in 8b/10b coding). 

Try eDP Try to link with eDP. 

Force eDP Force eDP linking. 

eDP AUX Preamble Use eDP AUX Preamble protocol when linking. 

LTTPR Mode Select LTTPR mode; Default, Ignore, Transparent, Non-Transparent.  

EQ pattern (8b/10b) Pattern (8b/10b) to be used for equalization: auto, TPS2, TPS3 or TPS4.  

Enable SSC Enable Downspread of link frequency (SSC). 

Amp (‰) SSC Spreading Amplitude (0.1% to 2.5% in 0.01% steps).  

Freq (Hz) SSC Modulation frequency (30 to 33 kHz). 

 

Link Overrides 

Override Voltage Swing and Pre-emphasis levels selected during link training. Click Apply to validate 

changes. Overrides are applied immediately to DPTX transceiver when 'Apply' is clicked. Please note, 

that It affects main link signal amplitude and pulse shape only. No AUX exchange takes place. The 

change can be checked only with a scope. Overrides are removed at the beginning of the next link 

training. 
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Link Pattern 

 

Select between Active video and audio, Idle pattern, or special bit patterns.  

Active Video Transmit Video Pattern, Audio and Metadata. 

Idle Pattern Link is active but no stream data is being transmitted. 

Training Pattern 1 Send Link Training Pattern Sequence 1 (TPS1 same as D10.2). 

Training Pattern 2 Send Link Training Pattern Sequence 2 (TPS2). 

Training Pattern 3 Send Link Training Pattern Sequence 3 (TPS3). 

Training Pattern 4 Send Link Training Pattern Sequence 4 (TPS4 same as  

CP2520 3). 

PRBS7 Send PRBS7 Link Quality Test Pattern. 

HBR2 (CP2520 1) Send HBR2 Compliance pattern CP2520 1. 

SER (Symbol Error Rate) Send Symbol Error Rate Measurement pattern 

Force Video Character error messages from sink will not interrupt video 

transmission. 

Force Idle Link Training and Active Video will not be initiated even after a 

re-plug. 

HBR2 (CP2520 2) Send HBR2 Compliance pattern CP2520 2. 

Note: Please note that except for Active Video and Idle Pattern, Link Training will NOT be initiated on such 

events as cable re-plug, Long HPD pulse and IRQ_HPD pulse due to link loss. 

 After using the special bit patterns, in order to return to the default operation mode, please select 

Active Video and click Apply. 

Stream Info 

Stream Info is achieved from the Main-Stream Attributes (MSA) of the stream. 

The content of Stream Info table can be copied by right-clicking on the table and selecting Copy. 

Framerate Vertical refresh rate 

HTotal Horizontal total of transmitted main video stream, measured in pixel count. 

HStart Horizontal active start from leading edge of HSync, measured in pixel count. 

HActive Horizontal active, number of active pixels in video line 

HSync HSync width, measured in pixel count. (+)/(-) positive / negative sync. 

VTotal Vertical total of transmitted main video stream, measured in line count. 

VStart Vertical active start from leading edge of VSync, measured in line count. 

VActive Vertical active, number of active lines in video frame 

VSync VSync width, measured in line count. (+)/(-) positive v.s. negative sync. 
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CEF Used color mode: Color format + subsampling / colorimetry 

BPC Color depth in bits per color (BPC) 

CRC (RGB/CrYCb) 16-bit Cyclic redundancy check (CRC) value per color component calculated 

from active pixels. Value order in YCbCr color format: Cr, Y, Cb. 

MVID/NVID Mvid and Nvid video time stamp values 

DSC CRC 16-bit Cyclic redundancy check (CRC) calculated from compressed pixel 

stream. Value order Engine 0, 1, 2. 

VCP Table 

VCP table shows allocation of Virtual Channel Payload for active virtual MST channels. 

The content of VCP Table can be copied by right-clicking on the table and selecting Copy. 

Stream #: Stream number where the virtual channel is directed. 

VCPID: Stream identification number of the virtual channel. 

Req.PBN: Requested PBN (payload bandwidth) value for the virtual channel 

Alloc.PBN: PBN value allocated for the virtual channel 

First slot: Time slot where the first VC Payload for the virtual channel is stored 

Slot num: Number of VC Payload slots reserved for the virtual channel. 

 

Scrambler Seed 

Selection of the value to which the Linear Feedback Shift Register (LFSR) is reset during scrambler 

reset. Used only when 8b/10b link coding is enabled. 

HDCP Status & Configuration 

Copy of HDCP status and controls on HDCP tab. 

HDCP Stream Status 

Shows HDCP stream status for each stream. 
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SDP Configuration 

 

Enable SDP Splitting. 

Note Selecting this configuration option does not guarantee that SDP splitting will occur for a given 

configuration of the Video and Audio pattern generators. SDP splitting will take place when it makes 

sense and required for SDP splitting conditions are met. 

 

DPCD Tab 
DPCD tab is a tool for monitoring and editing the DPCD registers of the connected DisplayPort or 

DisplayPort Alt Mode Sink. 

The DPCD Decoder panels on the right show the interpretation of the DPCD byte selected on the 

monitoring windows. The selected byte is shown with a green background.  

Save: Select DPCD content to the PC (please see below). 

Load: Retrieve previously saved DPCD data (please see below). 

Report: Save parsed content of selected DPCD register ranges as HTML file 

Refresh: Re-read the data from the DPCD registers to the window in question 

Write Changes: To program the data into the DPCD registers of the connected Sink  

Set Reference: Store currently shown data as a reference for comparison 
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When the data is Refreshed from the DPCD registers the changed bytes will be highlighted with blue 

color. The fields edited by the user will be highlighted with red color. 

Saving and Loading DPCD Content 

DPCD data in the selected address areas can be saved as a file in your PC. There are three alternative 

formats listed below. Please select the intended format when saving: 

• Binary DPCD Data File format (*.DPD). This is Unigraf proprietary format. You can also load the 

DPCD content stored in this format. 

• Comma Separated Value format (.CSV) 

• HEX Dump (*.HEX) in a human readable text format. 

FEC Tab 
Forward Error Correction (FEC) can be enabled if connected sink supports it. For debug purposes, 

error injection to Main-link is possible. There is an error type for each standard sink DPCD error 

counter.  

Enable FEC UCD will verify if connected sink supports FEC and begins the 

handshake for enabling FEC. 

Disable FEC UCD will start the FEC disable handshake. 

Prefer FEC Enabled If selected, and the connected sink supports FEC, UCD will start the 

FEC Enable Sequence after a successful connection. 

Error Generator 

Selections will set how many errors will be inserted into one FEC block and to which link symbols. 

There are five options: 

Uncorrected block 3 symbol errors with 3 error bits together 

Corrected block 2 symbol errors with 2 error bits together 

Corrected parity 2 parity byte errors with 2 error bits together 

Corrected block 1 error 1 symbol error with 1 error bit together 

Corrected parity 1 error 1 parity byte error with 1 error bit together 
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Note:  FEC must be enabled and running before errors can be added. 

Link training will reset sink FEC error counters. 

Each lane can have its individual error amount. When only one lane is enabled, errors can be injected 

to even and odd decoders by using lane #0 and lane #1 counters. 

Apply Start error injection 

Update Read sink DPCD FEC error counter registers 

Clear counters Clear sink DPCD FEC error counter registers 

Send FEC Enable Sequence UCD-4XX will start adding FEC Enable Sequence in its main link data. 

Send FEC Disable Sequence UCD-4XX will start adding FEC Disable Sequence in its main link data. 

ALPM Tab 

 

 

Link Status panel shows current ALPM status. 

Link Control panel is for enabling ALPM and for setting ALPM state. 

Power-off entering offers two modes via radio buttons ML_PHY_SLEEP and ML_PHY_STANDBY.  

Additional sequences and PHY hold pattern length, symbols can be set via the combo boxes. 

Power-off exiting offers two methods via the AUX-less and AUX_wake radio buttons. Parameters for 

each can be set via the widgets in the respective groups. 

If the AUX_wake method is selected and AUX_PHY_WAKE_ACK is checked and the sink does not 

respond with AUX_PHY_WAKE_ACK, the Errors group  AUX_PHY_WAKE_ACK not received indicator 

will be lit. 

ML_PHY_LOCK_1  and ML_PHY_LOCK_2 times may be set along with their patterns: TPS1 – TPS4. 

ML_PHY_LOCK_2 is available if TPS1 is selected for ML_PHY_LOCK_1. 
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Role: Product: 

HDMI Reference Source (HDMI TX) UCD-422, UCD-412, UCD-452 

 

When roles HDMI Reference Source is in use, the following interface specific tabs are available. 

• Status information and control of the downstream link (Link) 

• SCDC monitor (SCDC) 

Link Tab 
Link tab shows the status and control items for the HDMI link. 

HDMI Behavior 

Selection of the HDMI version to be used (HDMI 1.4 / HDMI 2.0 / HDMI 2.1). 

Status 

Channel lock: Status of Channel Lock in the four lanes.  

Error count: Contents of the SCDC Error counter registers of the connected Sink. 

Behavior: Assigned HDMI mode. 

Video Video signal status. 
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TMDS Status (only in TMDS mode) 

Mode: Status of the HDMI/TMDS mode (HDMI/DVI) 

TMDS Bit Clock Ratio: Status of TMDS_Bit_Clock_Ratio bit in SCDC – TMDS Configuration 

(1/10 or 1/40) 

Scrambling: Status of TMDS_Scrambler_Status bit in SCDC – TMDS Scrambler 

Status (1=LED on; 0=LED off) 

TMDS Control (only in TMDS mode) 

Mode: Selection of the HDMI/TMDS mode (HDMI/DVI) 

Link Mode: Selection of TMDS Bit Period / TMDS Clock Period ratio (1/10 or 

1/40) (3G / 6G) 

Enable Scrambler: Control of Scrambling_Enable bit 

FRL Control 

Disable FRL: Disable FRL mode 

Capability Radio Buttons: Selection of the link mode used for FRL link training.  

FFE Max: Set the maximum FFE level (0 to 4) supported for each FRL rate 

LT Timeout: The time used for FLT Timer (default = 200 ms) 

LT Poll Timeout: Poll interval for FLT_update flag (default = 2 ms) 

 

Please click Link Training to apply 
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FRL Status 

FRL Mode: FRL Mode used by UCD-4XX HDMI source 

LT Status: FRL link training status of UCD-4XX HDMI source 

FLT Update: Status of FLT_update flag in SCDC Update Flags register of the connected 

HDMI sink. 

FLT Ready:  Status of FLT_ready flag in SCDC Status Flags register of the connected 

HDMI sink. 

FRL Start: Status of FLT_start flag in SCDC Update Flags register of the connected 

HDMI sink. 

FLT No Timeout: Status of FLT_no_timeout flag in SCDC Source Test Configuration register 

of the connected HDMI sink. 

FRL Max: Status of FRL_Max flag in SCDC Source Test Configuration register of the 

connected HDMI sink. 

 

Lane Status Matrix 

LTP: Status of Lnx_LTP_req (x = 0 to 3) fields in SCDC Status Flags register of 

the connected HDMI sink 

Pattern: Link Training Pattern used (0 to 8) 

FFE Level: FFE level used (0 to 3) 

HDCP Status 

Copy of the status from HDCP Tab. Please refer to chapter HDCP Tab later in this document for 

detailed description. 

HDCP Configuration 

Enable and disable HDCP 1.4 or HDCP 2.3 capability of UCD-422 and UCD-412 Sink. Duplicates of 

the controls found in HDCP tab. 

Note:  Currently HDCP is not supported 

HPD (Bottom panel) 

The status LED indicates the state of the HPD signal Asserted (logical “high”) or De-asserted (logical 

“low”). 
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SCDC Monitor 
SCDC monitor presents content of HDMI Status and Control Data Channel (SCDC) structured by its 

address range. 

The SCDC Monitor panel on the right hand side shows the interpretation of the SCDC byte selected 

on the monitoring windows. The selected byte is shown with a green outline.  

Save: Select SCDC content to the PC (please see below). 

Load: Retrieve previously saved SCDC data (please see below). 

Report: Save parsed content of selected SCDC register ranges as HTML file 

Refresh: Re-read the data from the SCDC registers to the window in question 

Write Changes: To program the data into the SCDC registers of the connected Sink  

Set Reference: Store currently shown data as a reference for comparison 

When the data is Refreshed from the DPCD registers the changed bytes will be highlighted with blue 

color. The fields edited by the user will be highlighted with red color. 

Saving and Loading SCDC Content 

SCDC data in the selected address areas can be saved as a file in your PC. There are three alternative 

formats listed below. Please select the intended format when saving: 

• Binary SCDC Data File format (*.DPD). This is Unigraf proprietary format. You can also load the 

DPCD content stored in this format. 

• Comma Separated Value format (.CSV) 

• HEX Dump (*.HEX) in a human readable text format. 
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Cable Info Tab  
The Cable Info tab displays cable specifications. 

 

 

 

CEC Tab 
Source CEC Tab functions in exactly the same manner as for Sink CEC Tab CEC Tab. 
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Role: Product: 

USB-C DP Alt Mode Reference Source (USB-C TX) or UCD-424 

 

When USB-C DP Alt Mode Reference Source role is in use, the following interface specific tabs are 

available. 

• USB-C Power Delivery (PDC) 

USB-C Power Delivery Tab  
When UCD-424 is used in DP Alt Mode Reference Source role, USB-C Power Delivery tab is available. 

The content of USB-C Power Delivery tab is similar to the tab available when in UCD-424 is used in 

DP Alt Mode Reference Sink role. 

Please refer to chapter USB-C Monitoring in section 4. Analyzer Operation earlier in this document. 
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 HDMI LINK TIMELINE VIEWER 

Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-422 

 

HDMI Link Timeline Viewer is a tool for evaluating the content and timing of data captured via HDMI 

Link Analyzer functionality of UCD Console. 

HDMI Link Timeline Viewer has three tabs (for three modes):  

FrameView tab is the primary tab for analyzing captured events on the timeline. 

Reports tab can be used to summarize events (AUX at present). 

Images tab lets the user view captured video frame images. 

 

 The FrameView tab and its views are shown below. 
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Wave Form View zoomed out and zoomed in views are shown below. Event periods are shown under 

the timeline (at the top) in their proper row as period rectangles with text descriptions (or abbreviations 

or no text, space permitting). Double-clicking a period rectangle will highlight the timeline portion of 

the rectangle and the row header(s) as shown below. To zoom the Wave Form View, position the cursor 

and use the mouse wheel to zoom in or out with respect to the cursor location. Drag to scroll the Wave 

Form View and the Symbols View horizontally.  
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Wave Form and Symbols View Settings 
Shown below are the WaveForms View and Symbols Views settings widgets. 

 

Gear Icon 

 

Select the Gear icon to select events to be displayed (+) or hidden (-). When Gear icon is selected, 

you can drag a row to reorder rows. 

 

 

Save Icon 

 

Select the Save icon to Save, Load or Remove named internal settings sets. You can also Import or 

Export named *.json files containing settings or Reset to default. 
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Zooming 

 

Select  Zoom + or – icons to zoom in and out or use the mouse wheel. The zooming in/out option 

applies to Wave Form View only. 

Scrolling 

 

Use the arrow keys to navigate the timeline. One arrow moves the timeline one page, two arrows 10 

pages and three 100 pages. 

You can also scroll by dragging ( click and hold while dragging).  

Clock icon 

 

Move to a time point. Enter values and press OK. 

 

Eraser 

 

Removes all measurements on the timeline. 

 

Move to Previous or Next Frame 

 

Move back or forward to the same relative location in the previous or next frame. 

Sync Data 

   Not synchronized.     Synchronized. 
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Frame View tab has three tabs: Main Link Events, Symbols, and Log Events. 

The Main Link Events tab is the primary tab for analysis and is presented first. 

Main Link Events Tab 
Main Link Events tab consists of five panels: Event Selector View, Event Details View, Wave Form 

View, Symbols View and Frame Image View. 

Each of these views are synchronized and actions in one will be reflected in others. 
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Event Selector View 

Event Selector View events are presented as a folding list of FRAMEs. Each FRAME contains a set of 

BLANK LINEs followed by a set of ACTIVE LINEs and finally by another short set of BLANK LINEs. 

BLANK LINEs contain items such as CTR periods and DATA ISLAND periods. DATA ISLANDs contain 

HDMI data packets such as GCP and AVI packets.  ACTIVE LINESs contain CTRL and VIDEO DATA 

items. 

 

 

 

The timing format used in Link Timeline Viewer consists of two timings based on time and bits. 

The time format is as follows:  

seconds:milliseconds.microseconds.nanoseconds.picoseconds 

In the image above you can see the time format on top and the bit format underneath (smaller grey 

font). 

When clicking on a Main Link Event, both Wave Form View and Symbol View are focused, and the 

time stamp block of the item is highlighted as shown below. 
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Event timing details are shown in the columns are the following: 

Type: Type of item. 

Id: Items occurrence number. 

Position: Start of the event from start of the captured data 

Duration: Duration of the event 

End: End of the event from start of the captured data 

Search 

You can search events by typing its name in the Search bar and pressing enter or by 

clicking the enter icon. The events are highlighted and shown in Wave Form View and 

Symbol View. 

 

 

 

 

Aa: Makes search function case sensitive. 

RExp: Use regular expressions. 

 

Click the enter icon to apply filters. 

 

 

Click Find Prev and Find Next icons to navigate. Also shown is the instance (here 

instance 2 out of 77). 
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The gear icon opens Configure search dialog. In addition to settings described above, 

you can select which colums are shown in Main Link Events window. 

 

 

 

   Not synchronized.     Synchronized. 

Click icons to synchronize data for view. 
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Symbols Tab 
Symbols View lists all PERIODS. 

 ‘ 

 

 

Selection and multiview highlighting behavior is as for Main Link Events above. 

Search criteria are the same as for Main Link Events above. 

Each column has a sort and filter icon. Shown below is for the Type sort and filter icon. 
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Event Details View 
The event details are shown in the lower left panel. The event details consists of two tabs: Image tab 

and Details tab. 

Details Tab 

The information shown in the Details tab depends on the selected item. A FRAME item is shown 

below. 

  

Images Tab 

 

Image for currently selected FRAME can be viewed (only when FRAME is selected). 
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Wave Forms View 
Wave Form View consists of two tabs: Wave Forms and Spatial View. 

Wave Forms Tab 

Wave Form View looks different depending on zoom level. Images below show the views in zoomed 

out and zoomed in states. 

Event periods are shown under the timeline (at the top) in their proper row as period rectangles with 

text descriptions (or abbreviations or no text, space permitting). Double-clicking a period rectangle 

will highlight the timeline portion of the rectangle and the row header(s). To zoom the Wave Form 

View, position the cursor and use the mouse wheel to zoom in or out with respect to the cursor 

location. Drag to scroll the Wave Form View and the Symbols View horizontally. 
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Columns are: 

HPD Hot Plug Detect signal. 

I2C I2C Events and signals sda and scl 

CEC: CEC Events and Signal 

Link Link type (TMDS SCRAMBLED for ex.) 

Periods INVALID, CTL, DATA, VIDEO, SSCP, HDCP, KEEP_OUT 

Sync HSYNC and VSYNC periods and signals 

Frame Frame number. 

Lines ACTIVE and BLANK lines 

Packets GCP and AVI packets 

PHY Lane 0 Lane 0 data 

PHY Lane 1 Lane 1 data 

PHY Lane 2 Lane 2 data 

 

The scroll bar at the top shows all captured frames. Select a frame by double-clicking. 

 

 

As you hover over the timeline, a timestamp for that position is displayed on the timeline at the cursor 

horizontal location. 

Popups show details of events as you hover over them in Wave Form View. 

Below illustrates how the different views align when you double click in the Wave Form View or the 

Symbols View. 
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Measuring 

The ruler tool allows users to measure the time between two points on the timeline. When you right 

click on the timeline, a point willl appear. Right click again on the timeline and the distance between 

the two points will be shown as illustrated below. Use the eraser tool to remove measures. 

 

Spatial View Tab 

Frame pixel images are shown in Spatial View. 

Drag to scroll Frames. 

Double-clicking the timeline when Spatial View Tab is active will select the event in Event Selector 

View. 

A popup showing details will be shown when hovering over a Frame or HDMI data packets such as 

GCP and AVI. 

Hover over an event to see event details in a popup window. Double-click an event will to select it in 

and see details in Event Details View. 
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Symbols View 
Like Wave Form View, Symbol View presents HDMI transmission data and periods. As with Wave 

Form View, drag to scroll horizontally or use the settings ribbon arrow keys. 

Periods Transmission PERIODs 

Sync Horiz and Vert periods 

Frame/Lines Frame and Line number 

Packets HTML GCP and AVI packet identifiers 

Symbols HDMI transmission symbols. 

Phy Lane 0  TMDS Channel 0 data. 

Phy Lane 1  TMDS Channel 1 data. 

Phy Lane 2  TMDS Channel 2 data. 

 

Illustrated below are the TMDS channel values for PIXELs for the color white. Note from the tool tip 

that the value has been scrambled. 

 

 

Illustrated below are the values for a SSCP period. Note from the tooptip that this is not scrambled. 

 

 

Each individual block contains the following information (tooltiup also shown). 

First row 10b/8b symbol in HEX format 

Second row Descrambled value. 
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Frame Image View 
Frame Image View can be used to select Frames and GCP or AVI periods and synchronizing with 

other views. 

As shown below, selecting the AVI event in Frame Image View also selects it in Event Selector View 

and synchronizes the other views. Hovering over the Active0 area will show the frame geometry 

details. 

Mode can be Image or Rect (shows just a green rectangle to save processing time). 

Stream combobox and Simple view checkbox do not work at present. 
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 DP LINK TIMELINE VIEWER 

Role: Product: 

DP Reference Sink (DP RX) UCD-400 

USB-C DP Alt Mode Reference Sink (DP RX) UCD-424 

 

Link Timeline Viewer is a tool for evaluating the content and timing of data captured with Link Analyzer 

function of UCD Console. 

Link Timeline Viewer main panel contains two tabs:  

• FrameView provides the user ability to evaluate events within the captured data and their 

occurrence in time scale. 

• Reports shows AUX channel activity at present. 

• Images lets the user view frame images from the captured data. 
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Note: When using Link Timeline Viewer with MST, it’s possible that all information for all streams are not 

visible. Different streams are shown below in the Wave Form View and the Symbols View. The view 

handle may be use to adjust visibility. Remove rows via the gear icon optimize screen real estate.  

(See the next chapter for instructions.) 
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Wave Form and Symbols View Settings 

 

Gear 

 

The gear icon under the scroll bar allows users to select which events are shown in Wave Form and 

Symbol Views. Click the red circle to remove events. You can select which VBID events are shown 

by clicking the pen tool. 

 

You can select which VBID bits are shown using the pen tool. 

 

  



  DP Link Timeline Viewer 

UCD-4XX User Manual • UCD Console 3.6 149 

Save 

 

By clicking the Save icon you can save, load, and remove settings selected via the gear icon. You 

can also import and export .json files and reset settings to default. 

 

Zoom 

 

You can zoom in/out with the magnifying glass icons. The zooming in/out option applies to Wave Form 

View only. 

Scroll 

 

You can use the arrow keys to move in the timeline. A single arrow shifts the timeline one interval, 

two arrows by 10 intervals and three arrows by 100 intervals. 

Alternatively, you can scroll via mouse drag (clicki and hold).  

Clock 

 

With the clock icon you can move to a time point. Enter the values and press OK. 

 

Eraser 

 

The eraser icon deletes all made measurements on the timeline. 

Move to Previous or Next Interval 

Move back interval and Move next interval. 

 

l 
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Sync Data 

Sync data for views. 

 

   Do not synchronized.     Synchronize. 
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Frame View tab consists of four areas shown below. 

• Event Selector View 

• Event Details View 

• Wave Form View 

• Symbols View 

• Frame Image View 

These will be described in detail. Note that all these views are synchronized (when the synchronize 

icons are blue). 
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Event Selector View  

Main Link Events Tab 

Main Link Events lists captured data: events, packets and symbols. Selecting items in Main Link 

Events, you can easily locate the items of interest and focus get the Wave Form View and Symbols 

View for items. Event Selector events are presented via a tree control. When expanded, each FRAME 

lists video LINES and their events. 

 

The timing format used is text and bits formats.  

The text time format is as follows:  

seconds:milliseconds.microseconds.nanoseconds.picoseconds 

The timing format is shown below. You can see the text format on top and the bit format below (small 

grey font). 
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Selecting a Frame, Line, Event, or Symbol will focus the Wave Form View and the Symbols View. The 

time stamp of the item is highlighted in light blue. 

 

Event Selector View timing details columns are: 

Type: Type of item. FRAME, LINE, or name of Event 

Id: Identification number 

Position: Start of the event from start of data capture 

Duration: Duration of the event 

End: End of the event from start of data capture 
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Under Main Link Events, there are two types of event categories: Lane events and SST/MST Stream. 

 

Lane Events 

These are events occuring for each lane (such as SST, TPS1, TPS3 and TPS4).  

SST Stream 

You can find all captured frames under SST Stream. When selecting a frame in the Event Selector 

View, it is highlighted and also focused in the Wave Form View and the Symbols View as shown 

below. Event details are shown in Event Details View in the lower left corner. 
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MST Stream 

When using Link Timeline Viewer in MST mode, streams are displayed in the Event Selector View as 

shown below. Select a stream to inspect its events. All stream events and their handling are as for 

SST mode described previously. 

 

Search 

Search for events in Event Selector View by typing the event name in the search bar and pressing 

enter. The events found are highlighted and shown in the Wave Form View and the Symbol View. 
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Click the enter icon to search. 

 

Use Case Sensitive and/or Use regular expressions. 

 

Arrows navigate to next or previous filtered event. 

 

The gear icon opens the Configure search dialog. Select which columns are used for 

searching and what criteria (Case Sensitive or Use regular expression) are used. Click 

the Apply to refresh. 

 

 

Click to synchronize views. 

Symbols Tab 

Symbols tab lists PHY level events found. 

Type: Type of item: FRAME, LINE or Event name 

Id: Identification number 

Position: Timestamp from start of the capture 

Lane: The main link Symbol lane 

Value: Symbol value 

 

Search 

Search and filter symbols as described above for the Main Link Events Tab. Each column additionally 

has a drop down filter dialog (down arrow icon): Use these to sort and select events. The screenshots 

below show a VBID event search and a column filter dialog.  
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Searching will highlight all found event symbols. When selected, it will also be selected in the Wave 

Form View, the Symbols View and the Event Details View. You can browse through symbols using 

the next or previous arrow buttons. 
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Event Details 
The event details are shown in the lower left corner. The event details are presented in two tabs: 

Details tab and Image tab. 

Details tab 

The information shown in the Details tab depends on the event selected. 

Frame 

 

Details shown above are FRAME details. 

Line 

  

In the image above the selected Line is part of blanking (VerticalBlanking is TRUE). Audio is not being 

streamed (AudioMute is FALSE). 
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MSA 

 

SDP  

 

Different SDP events have individual details. An audio stamp event is shown above.  
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PHY Symbol 

 

Events such as BS, VBID and MVID are shown as [PHY _SYMBOL]. A VBID event is shown above. 

 

PHY Area 

 

[PHY Area] events are TPS events. A TPS1 event is  shown. 

 

 

Image tab 

Image tab shows the captured FRAME active area. Images are shown only shown when a FRAME is 

selected. 
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Wave Forms View 
Wave Forms View consists of two tabs: Wave Forms and Spatial View. 

Wave Forms 

AUX: AUX channel events 

Log Aux Log packets for AUX 

Log MSA Log packets for MSA 

Log VB-ID Log packets for VB-ID 

Log Link Log packets for Link (TPS1, TPS2, TPS3, TPS4 detection) 

Log VFRAME INFO Log video frame data 

Link: Link state (TPS1, TPS2, TPS3, TPS4, SST, MST etc.) 

SST Frame SST frame number 

SST Lines SST Line number 

SST VBID SST vertical blank 

SST MSA SST MSA period 

SST SDP SST SDP period 

SST SR SST SR symbol period 

SST BS SST BS symbol period 

SST BE SST BE symbol period 

Lanes (0-3): Data and control symbols 

  

Captuared FRAMEs  are shown at the top. As no triggers were set on the example below, the first 

FRAME is not fully captured.  

 

 

Select a frame by double-clicking it: It turns light purple and the Wave Form View will be focused. 
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As the cursor moves over the view, the timestamp is displayed. 

 

Move the mouse over an event period in Wave Form View to see details via a popover. 
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Double-clicking anywhere in the Wave Forms View  synchronizes the Symbols View and the event is 

selected in Event Selector when as shown below. The green vertical area in Wave Form View shows 

the position within an event. 

 

 

The image below shows you how the different areas of the Link Timeline Viewer synchronize when 

you double-click a FRAME in Wave Form View. 
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Measuring 

The ruler tool allows users to measure distance between two points on the timeline. Two right-clicks 

on the timeline (or on the same row) will display the distance between the two points as shown below. 

 

Zooming 

Zoom happens via the mouse wheel. When zooming it is important to keep the cursor centered on 

your point of interest. Various events appear as vertical lines or solid areas when zoomed out. As you 

zooming in, spans begin to appear and finally text begins to appear. Images at various stages of zoom 

are shown below. 

Original view. 
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Zooming in so spans with text can be seen. Note that views are synchronized. 

 

 

Spatial View 

Spatial view shows the geometry of the frame. 
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Selecting a FRAME in Event Selector View will display it in Spatial View. 

 

Double-clicking on the timeline, will select the LINE in the Event Selector View as shown below. 

  

When you hover a cursor on top of the frame, its details will be shown. Frame details include the start, 

end and duration of the frame. 
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If you double-click an event label in the Spatial View (MSA label shown here), it is selected in the 

Event Selector View and details are shown in the Event Details View. Details of the event will also be 

shown in a popover when hovering over the label. 
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Symbols View 
Symbol View shows symbols from the PHY lanes in addition to those shown in Wave Form View. 

Scroll Symbols View via drag or by using the arrow keys. 

AUX: Events of the AUX channel 

Link: Link state (TPS1, TPS2, TPS3, TPS4, SST, MST etc.) 

Log Aux Log packets for AU 

Log MSA Log packets for MS 

Log VB-ID Log packets for VB-ID 

Log Link Log packets for Link (TPS1, TPS2, TPS3, TPS4) 

Log VFRAME INFO Log video frame data 

Link: Link state (TPS1, TPS2, TPS3, TPS4, SST, MST etc.) 

Lines: Frame and line number 

VBID Vertical blanking 

MSA MSA period 

SDP SDP (secondary data packets) 

Symbols: Control and special symbols periods 

Lanes (0-3): Decoded data and control symbols 

PHY Lanes (0-3): Binary bit stream, 10b/8b scrambled symbols, symbol code and 

descrambled values 

  

 

Link Symbols 

 

The lower part of the Symbols View displays the values of link symbols on the physical link lanes. You 

can see the individual bits above the symbol blocks. When you hover your mouse over a symbol, a 

popover shows details of the symbol: 

10b symbol: Link symbol as sent (in this case 8b/10b link coding) 

8b symbol: Link symbol after conversion to 8 bits 

Symbol code: Link symbol K or D code 

Descrambled: Link symbol value after de-scrambling 

Start: Start of the item from start of the captured data 
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End: End of the item from start of the captured data  

Duration: Length of the symbols 
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A ink symbols is shown below. 

 

Each block contains the following information 

First row: 10b/8b link symbol in HEX format 

Second row: Link symbol K or D code. 

Third row: Descrambled value if available 

 

Scrambling 

The result of scrambling can be seen in Symbols View. The first row of each block below shows 

different 10b/8b link symbols. 

 

Forward Error Correction (FEC) 

FEC parity codes are highlighted in Symbols View in light green. CD_ADJ symbols are highlighted in 

light red. 
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SDP 

SDPs are highlighted in turquoise. You can see the start of the SDP event marked as SS and the end 

of the SDP event marked as SE. 

  

Pixel data 

Grey area is fill symbols (scrambled 00). Light yellow area is actual pixels (surrounded by fill end 

symbol and fill start symbol). K30.7 is fill start and K23.7 is fill end. 

  

MSA 

MSA symbols are highlighted in purple color. 
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VBID 

The Event Details will show information of what the line will contain. In the image below you can see 

that the line is vertical blanking without pixel data. 

 

TPS Events 

The image below shows how the events are shown for each lane in Event Selector, Symbol View and 

Event details. The image below shows a TPS1 event. 

 

The image below illustrates the transition from TPS1 to TPS4. 
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Frame Image View 
Frame Image View can be used to select frames and GCP or AVI periods in related views. 

As shown below selecting the MSA event in Frame Image View also selects it in Event Selector View 

and synchronizes the other views. Hovering over the Active0 area will show the frame geometry 

details. 
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Video frames decoded from Main Link Data Capture can be previewed in Images tab. Frames are 

listed on the left-hand side of the window. Each frame has two lines. The first line shows the frame 

with its active area only. 

 

The second line is a structure frame, which shows total and active area. 
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 EVENT TIMELINE VIEWER 
Event Timeline Viewer is an application for inspecting data captured in capture tab. 

Event Timeline Viewer consists of four areas. 

1. Frame View 

2. Event View 

3. Event Log 

4. Details / Image 

 

Frame View 

 

The uppermost panel shwos the captured frames. The selected frame is highlighted in purple. You can select a 

frame by double-clickin it. The area highlighted in green indicates the area shown in the Events view. Please, note 

that you cannot zoom in or out in the frame view. 

Event View 

 

The view below shows all frames and events selected in the capture tab. The are highlighted in green in frame view 

indicates the are shown in events view. 

  

1 

2 

3 

4 
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Tools 

Tool Function 

 Gear Icon Hide / add events on the timeline 

 Save Icon 
Save, load, remove, import, export and 

remove presets 

 Magnifying Glass Icons Zoom in/out on the timeline 

 Arrow Icons 

Move on the timeline. More arrows moves 

the timeline more. You can also move by 

clicking and dragging on the timeline. 

 Move to a time point 

Move to a certain time point on the timeline 

by double clickin on the timeline. The 

selected event is highlighted in the event 

log. By right clicking on the timeline and 

right clicking again you can measure 

distance between two time points. 

 Erase all rulers Erase all measurements made. 

 

Zooming on the timeline

 

Went the timeline is zoomed out, you can see events as grey lines. When you zoom in you can see 

the event block. You can zoom in either with the magnifying glass icons or by scrolling with your 

mouse. 

 

When you double click on event or frame, the correseponding event or frame is selected in the event 

log and highlighted in purple. 
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Event Log 

 

Event log shows all captured events and frames. The following info is presented in the table: 

Type Function 

ID Number of captured frame 

Start Start of the event 

Duration Duration of the event 

End End of the event 

Info Additional information about the event. 

 

Event Log Tools 

 Search  
Search events from the event log. Search 

results are highlighted in purple. 

 Apply search filters Apply filters. 

 Search filters 
Aa filter: Make search case sensitive 

RExp: Use regular expressions in search 

 Search results 

Shows search results. Move from one 

search result to another by clicking the 

arrows. 

 Configure 
Selec which columns are shown in event 

log. 
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Details / Image 

 

Details tab shows details of the selected event. When the selected event is a frame, the image tab 

shows the captured frame. 
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 EVENT LOG 
Event Log dialog is divided into two panels: the left panel lists all transactions, and the right panel 

shows the parsed transaction data for the line selected in the list on the left. 
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Role Logged Events 

DP Sink (UCD-400) 

DP Alt Mode Sink (UCD-424) 

HPD, AUX, SDP, VB-ID, MSA, Link Pattern, AUX_BW, 

VFRAME INFO 

HDMI Sink (UCD-422) HPD, Packets, I2C, CEC 

DP Source (UCD-400, UCD-411, 451) 

DP Alt Mode Source (UCD-424) 

HPD, AUX 

HDMI Source (UCD-422, UCD-412, 452) HPD, I2C, CEC 

DP Alt Mode Sink (UCD-424) 

DP Alt Mode Source (UCD-424) 

PD, LSE 

 

Start Starts event logging and stop it by clicking Stop. 

Save Save transactions as Event Log data. 

Loa Load Event Log data. 

Repor Store event logs as reports in HTML format. 

Open Timeline Viewer Open Event timeline Viewer to inspect the captured data. For detailed 

instructions refer to chapters 6 and 7 of this manual. 

AutoScroll When selected, transaction list is scrolled vertically. The latest transaction 

is shown as the last item of the list. When not selected, the items shown 

before clicking Start will be shown. 

Events Number of events detected. 

Colors Open configure colors dialog. 

Clear/Clear on Start Click to clear transaction list. When Clear on Start is selected, the list is 

cleared when clicking Start. 
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Logged Events  

HPD 

Status and status changes of Hot Plug Detect (HPD) signal, power detection status and cable 

connection status. 

AUX 

DP Log DP AUX Channel transactions and Sideband Messaging. 

SDP 

Log DP Secondary-data Packets. Click the button to open the Event Filter Dialog. The dialog 

enables filtering of SDP packets. In the dialog, the reference to Packet Type Value is indicated in 

square brackets “[ ]”. 

VB-ID 

Log Vertical Blanking ID packets sent in DP stream. Click the button to open the Event Filter Dialog. 

The dialog enables definition of which events will be logged. 

MSA 

Log Main Stream Attributes sent in DP stream. Click the button to open the Event Filter Dialog. The 

dialog enables logging of all MSA:s or just changes to selected parameters. 
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Link Pattern 

Click the button to open the Event Filter Dialog. 

Log link patterns. Event filter dialog sets the type of link patterns that will be captured.  

Custom Pattern (80 bit) is a squence that either splits into 10 bytes or 8b/10b encoded symbols. For 

10b symbols, either K/D codes or hex values must be provided. For bytes, hex values must be 

provided. 

 

AUX_BW 

Log AUX_Bitwise transactions as a series of Manchester II codes. 

VFRAME INFO 

Dimensions of the catured frame measured by the Sink.  

Packets 

Log metadata sent by Source device in HDMI stream. 
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I2C 

Log data sent over I2C communication lines of HDMI interface. Click the button to open the Event 

Filter Dialog (either HDMI RX or HDMI TX dialogs). 

 

PD 

Log USB-C PD communication messages. 

 

 

CEC 

Log HDMI CEC communication messages. 

LSE 

Low Speed Electrical logger captures the Voltage and Current on the low-speed lanes of the  

USB-C connector including CC, VBUS, VCONN, and SBU. 

Event Filter Dialog sets the threshold values for capturing the changes. Parsed transaction data shows 

the captured data with indication of the changed values. 
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Event Transaction List 
Transaction data in Transaction List is ordered in columns. Each column provides additional 

information about the data line, facilitating its viewing and interpretation. 

You can search events by typing its name in the Search bar and pressing enter or selecting the 

Search button. Pressing F3 (Ctrl+G on macos) takes you to the next found and Shift+F3 (Shift+Ctrl+G 

on macOS) takes you to the previous found. 

 

Source: The communication port: DP RX, DP TX, HDMI RX, HDMI TX or HDCP 1.X, HDCP 2.3 

Type: The logged item:  

HPD, AUX, SDP, VB-ID, MSA, Link Pattern, AUX_BW, VFRAME INFO (DP or DP Alt 

Mode) 

HPD, Packets, I2C, CEC (HDMI) 

Start: Each line is identified by its timestamp, marking the instant when an event or error was 

detected, or when a data transaction got started.  

The timestamp can be displayed as a time delay from the start of the acquisition 

(absolute) or from the previous line (relative). The timestamp can be displayed in 

milliseconds or in minutes, seconds, and microseconds. 

Info: This column provides a short description of the message content 

 

When hovering the mouse over the transaction list, a mouse-over window will open. It provides a brief 

list of the content in the transaction under the mouse. 

 



  Event Log 

UCD-4XX User Manual • UCD Console 3.6 187 

Customizing Transaction List 
User Can change what data is shown in the transaction list by adding and removing columns or 

limiting the transaction types in the list. User can also color highlight various types of transactions for 

better readability. 

Right-click on the list to open the menu. 

Configure Start 

The time indicated in column Start can be either: 

• Time from device reboot 

• Time from previous event 

The time can be expressed either: 

• In microseconds (1/1 000 000 Second) 

• Hours : minutes : seconds : milliseconds : nanoseconds 

Configure Colors 

Configure colors dialog allows the user to highlight various types of transactions in the list by changing 

character color and background color of the transaction line. 

Add: Add a new color highlight rule 

Config: Modify the selected rule 

Remove: Delete the selected rule 

Clone: Duplicate the selected rule 

▲: Change order where rules are applied.  

The rules are applied from the bottom to the top of the list. 
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Adding Rules 

The color highlight rules are set by transaction type. The content of Add rules dialog is dependent on 

the type of item selected. 

Configure Columns 

In the dialog there are two columns: Available and Active. An item from Available list can be included 

in Active columns by selecting it and clicking on the right arrow [>] in the middle of the two columns. 

The order of Active items can be changed by selecting an item and moving its position in the list with 

up ▲and down ▼ arrows. 

Type Filter 

Type filter dialog lists the types of transactions found in the list and allows the user to select which 

transaction lines are currently shown. 

Quick Filter 

By entering a DPCD address in the Quick Filter field on top of the transaction line, the user can limit 

the list to show only the reads or writes to this DPCD address. 
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Event Details 

HPD 

HPD transactions include the following statuses: 

Hot-Plug-Detect Level: Status of HPD signal: HIGH (Asserted), LOW (De-asserted) 

PWD Level: Status of source device detection: High (DP Tx detected),  

LOW (DP Tx not detected) 

Cable Detect Level: Status of cable detection HIGH (Cable connection detected) LOW 

(Cable connection not detected) 

AUX (UCD-400, UCD-411, UCD-424, UCD-451) 

Transaction list includes the following DP AUX Channel transactions. Parsed transactions panel 

provides details for each transaction. 

RD: Native AUX Request Transaction for read 

WR: Native AUX Request Transaction for write 

I2C RD: I2C-over-AUX Request Transaction for read 

I2C WR: I2C-over-AUX Request Transaction for write 

AUX_ACK: AUX Reply Transaction (Request accepted) 

AUX_NACK: AUX Reply Transaction (Request not accepted) 

AUX_DEFER: AUX Reply Transaction (Delayed, new request needed) 

Sideband REQ: Sideband down request message (DOWN_REQ_MSG) 

Sideband REP: Sideband down reply message (DOWN_REP_MSG) 

EDID Trace: Accumulated EDID content from I2C or sideband down messages 

DisplayID: Accumulated DisplayID content from I2C or sideband down messages 

HDCP Trace 1.X or  

HDCP Trace 2.3: 

HDCP Transmitter and HDCP Receiver communicate DPCD values 

over AUX Channel. Transactions are listed as DPCD Address Range 

Traces where HDCP Port name is indicated. 
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Native AUX Transaction Example 

 Sideband Message Example 

HDCP Trace Example 
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SDP (UCD-400, UCD-424) 

DP Secondary-data Packets.  

VB-ID (UCD-400, UCD-424) 

Vertical Blanking ID packets sent in DP stream.  

 

MSA (UCD-400, UCD-424) 

Main Stream Attributes sent in DP stream. 
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Link Pattern (UCD-400, UCD-424)  

 Status of link pattern detected in which lane. 

 

AUX_BW (UCD-400, UCD-424) 

Status of captured binary Manchester II codes. The duration of the preamble and postamble is 

presented.  

 

VFAME INFO (UCD-400, UCD-424) 

Measure dimensions of capture video frame. 
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PD (UCD-424) 

USB-C PD communication messages 

LSE (UCD-424) 

Status of USB-C Low Speed Electrical signals 
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Packets (UCD-422, UCD-452) 

Log metadata sent by Source device in HDMI stream 

 

I2C (UCD-422, UCD-452) 

 Log data sent over I2C communication lines of HDMI interface 

CEC (UCD-422, UCD-452) 

CEC messages 
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 EDID/DISPLAYID EDITOR 
The EDID/DisplayID Editor main window is divided into three views. The bottom area additionally has 

command buttons. The top left tree view selection determines the blocks to be edited. The top right 

view shows data for the currently selected item in the top left view. These values may be edited when 

the Editor Mode checkbox is checked,  The bottom right hex view shows that data as hex values. The 

hex values of the currently selected item in the top left view are highlighted. Values can be edited 

when the HEX Edit Mode checkbox is checked. 

Add Item Add a new EDID or DisplayID block. Available when in Editor Mode 

exclusivly and a top node in treeview (CTA or VESA) is selected. 

Remove Item Delete the selected EDID or DisplayID block. Available when in Editor 

Mode exclusivly and a top node in treeview (CTA or VESA) is selected. 

Filter Show only items having the filter string in the field name. 

Editor Mode See below. 

Show Read Only Automatically generated non-editable fields are additionally shown. 

Read mode Data read mode: 

I2C (using I2C protocol) or SBM (MST mode only): virtual channels read 

via SBM protocol. 

Recurse All subitems of the selected item are presented in Editor View. 

Virtual Sink #1 (DP) Dropdown labled with the currently selected virtual sink (MST). 
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The buttons at the bottom of the dialog differ based on role:  Analyser (Read fromTE and Write to TE)  

or Generator (Download from Sink and Upload to Sink). 

  

Read from TE (Analyzer) Read device local EDID/DisplayID blocks into editor (HEX Edit 

Mode must be unchecked). 

Write to TE (Analyzer Write editor data to device local EDID/DisplayID blocks. 

Download from Sink (Generator) Read EDID/DisplayID blocks from connected sink device into 

editor. 

Upload to Sink (Generator) Write editor EDID/DisplayID blocks to connected sink device.  

See note below. 

Editor Mode Enable editing EDID/DispslayID content in top right view. For 

example, for testing purposes, i ’  p   i            i v  i  

EDID/DisplayID data and write it to TE without modifications. 

Once Editor Mode is enabled, the validator corrects errors 

such as invalid checksums.  Top right view name-value paiars 

can be edited. 

HEX Edit Mode Enable editing EDID/DisplayID content in bottom right HEX  

view. When enabled, HEX values may be edited. Click Apply 

to validate changes and update other views. 

Save As… Save the current editor data to disk in various formats: 

binary, hex, ecd, txt and xml. 

Load … Load EDID/DisplayID data from disk. Same formats as above 

available. 

  

Note: A source device is always able to read EDID data of the connected Sink device. A source device can 

read the DisplayID data of the sink device if the sink device permits. The connected sink device may 

or may not allow its EDID/DisplayID content to be modified. 
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Select the Main Features button to view items of common 

interest. For example, whether the sink is capable of HDR, or 

Dolby Vision, etc.  

 

 

 

The Main Features view CTA v3 tab (avalable only in EDID tab 

not DisplayID tab) allows enabling/disabling features. You 

enable/disable a feature by selecting the Value field with 

Editor Mode enabled  (AND HEX Edit Mode disabled). When a 

value is disabled and you want to enable it, the Editor View 

will be blank as focus has been set on the values to be 

enabled (and are zero when disabled). New highlighted hex 

values will be added and highlighted in the lower right Hex 

View. New node data will also appear under the CTA node in 

the top left tree view. 

 

 

 

EDID Editor Features 
A practically unlimited number of extension blocks may exist in a single collection. The number of 

blocks is limited by VESA Specifications and possibly by available system resources. Most 

EDID/DisplayID blocks contain a structure that is very similar to a tree structure. The Editor decodes 

each block into a tree view of the block. The tree view then contains all values within the data block. 

Contents can be browsed. The Editor has a support for automatic variables, such as the block 

checksum. When a value in a block is modified, the checksum will be updated. Automatic variables 

are read only. A log print will be made when an automatic variable is updated by the editor.  

Editing Tips 
Editing is straightforward: 

Select property fields to edit. 

Red values in HEX View show that values have been modified. 

Press Enter to apply edit values and combo box selections. 
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In CTA-861 blocks, you can add and remove 18-byte descriptors and CEA data blocks by 

setting the values “18-byte Descriptors in this block” and “CEA Data block count”.  

Enter hex values with prefixes “0x” or “$”.  No prefix represents a decimal value. 

Values may be entered as hexadecimal or decimal regardless of  presentation. 

Floating point values must have a period “.” decimal separator. 

Click Set after changing a bit-value presented as a single checkbox if you want the new value 

applied. 

Note: EDID Editor does not have an Undo function. Therefore, it is highly recommended that you back up 

un-edited EDID contents to a file before editing it. 
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 PACKET EDITOR 
Packet Editor enables creation and editing metadata packets. 

The types of supported packets are: 

• Audio InfoFrame (Audio) 

• AVI InfoFrame (AVI) 

• Custom InfoFrame (Custom) (HDMI) 

• Custom Packet (Custom) (DP) 

• DR&M InfoFrame (DR&M) (HDMI) 

• DR&M Packet (DR&M) (DP) 

• EMP-VRR (EMP-VRR) 

• GCP InfoFrame (GCP) 

• SBTMEM Source-Based Tone Mapping Extended Metadata (HDMI) 

• SPD InfoFrame (SPD) 

• Vendor-Specific InfoFrame (VS) (HDMI)* 

• Vendor-Specific SDP (VS) (DP)* 

 

*) Please select from available VS packet types in field “ : Type” in the packet editor. 
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 PATTERN EDITOR 
Pattern Editor is a tool for editing and debugging Unigraf Custom VTP Pattern scripts. 

Please refer to APPENDIX F: VTP PATTERN LANGUAGE later in this document for description of the 

VTP Pattern Language syntax. 

Pattern Editor consists of three tabs: 

Image Tab 

Monitoring the rendering of the VTP pattern script. 

Source Tab 

Tool for editing VTP Pattern Language script. Click Apply to render the code in the resolution of the 

preview image in Image tab. 
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Logs Tab  

Log of the pattern code parsing indicating the values assigned to logical variables and the actual 

parameter values used for render instructions. 

Saving and Recalling the Script 

In File pull-down menu the user can save his work. 

Open: Open a VTP language script from PC 

Save Script: Save the script currently in Source tab to PC 

Save Image: Save a rendered pattern in PNG, BMP, JPG or PPM format 

Select Save Resolution: Select from six common resolutions the size in which the pattern script will 

be rendered when saved. 
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 IMAGE CONVERTER 
Image Converter is a tool for converting images from one color format to another. This kind of 

conversion is typically needed when creating YCbCr test images from RGB bitmaps. 

Image Converter has two operating modes: Standard mode and Advanced mode. In Standard mode 

typical image file formats are used as Source image and the user sets basic color formats for the 

Destination image. In Advanced mode, the user is able to define the Source and Destination image 

parameters in detail. 

Click Select to load the Source image. Click Convert to store the Destination image. File name for 

the Destination image is of form: 

Source_image_1920x1080_8bits_yuv444_lsb.bin 

  

Source_image Name of the image file used as Source image 

1920x1080 Resolution of the Source Image 

8bits Bit depth of the Destination image 

yuv444 Color space and sampling of the Destination image 

lsb Data alignment of the Destination image 
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APPENDIX A: PRODUCT SPECIFICATION 

UCD-400 and UCD-411 
Input DisplayPort™ 1.4a compliant (DP Rx) (UCD-400 only) 

Output DisplayPort™ 1.4a compliant (DP Tx) 

Max video mode 7680 × 4320 p30 input and output 

3840 × 2160 p120 input and output 

Audio LPCM, 2 – 8 channels, 44.1 to 192 kHz 

Content Protection HDCP 2.3, HDCP 1.3 

DSC Capability DSC Sink with off-line decompression 

DSC Source using pre-compressed content 

Additional features FEC, LTTPR, DSC 

DP 1.4a LL CTS, DP DSC CTS 

HDCP 2.3 CTS 

Computer interface USB 3.0 

Operating System Debian 11.0 or higher. 

Ubuntu 20.04.4 LTS or higher. 

MacOS Big Sur 11.7.10 or higher. 

Windows 10 10.0.19045 or higher. 

Power supply AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +12 Vdc output) 

Environmental 

Operating temperature: 15 to 35 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 280 × 200 × 80 mm 

Weight 1.2 kg w/o power supply 

UCD-422 and UCD-412 
Input HDMI 2.1 (10K@30Hz) (HDMI Rx) (UCD-422 only) 

Output HDMI 2.1 (10K@30Hz) (HDMI Tx) 

HDMI 2.1 Features FRL, TMDS, ALLM, VRR, QMS-VRR, SBTM 

Content Protection HDCP 2.2, HDCP 2.3 

Additional features eARC, DSC*, FEC* 

Computer interface USB 3.0 

Operating System Debian 11.0 or higher. 

Ubuntu 20.04.4 LTS or higher. 

MacOS Big Sur 11.7.10 or higher. 

Windows 10 10.0.19045 or higher. 

Power supply AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +12 Vdc output) 

Environmental 

Operating temperature: 15 to 35 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 272 × 170 × 60 mm 

Weight 1.2 kg w/o power supply 

*) Please contact Unigraf for detailed availability 
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UCD-424 
Input USB-C DP Alt Mode 1.4a compliant (USB-C Rx) 

Output USB-C DP Alt Mode 1.4a compliant (USB-C Tx) 

Max video mode 7680 × 4320 p30 input and output 

3840 × 2160 p120 input and output 

Audio LPCM, 2 – 8 channels, 44.1 to 192 kHz 

Content Protection HDCP 2.3, HDCP 1.3 

DSC Capability DSC sink with off-line decompression 

DSC source using pre-compressed content 

Additional features FEC, LTTPR*, DSC 

DP 1.4a LL CTS, DP DSC CTS 

HDCP 2.3 CTS 

Computer interface USB 3.0 

Operating System Debian 11.0 or higher. 

Ubuntu 20.04.4 LTS or higher. 

MacOS Big Sur 11.7.10 or higher. 

Windows 10 10.0.19045 or higher. 

Power supply AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +12 Vdc output) 

Environmental 

Operating temperature: 15 to 35 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 280 × 200 × 80 mm 

Weight 1.2 kg w/o power supply 
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UCD-451 
Output DisplayPort™ 1.4a compliant (DP Tx) 

Max video mode 
7680 × 4320 p30  

3840 × 2160 p120 

Content Protection HDCP 2.3, HDCP 1.3 

Additional features FEC, LTTPR, DSC 

DP 1.4a LL CTS, DP DSC CTS* 

HDCP 2.3 CTS* 

DSC Capability DSC source using pre-compressed content 

User Interface Computer with monitor, keyboard and mouse 

Operating System 

Debian 11.0 or higher. 

Ubuntu 20.04.4 LTS or higher. 

MacOS Big Sur 11.7.10 or higher. 

Windows 10 10.0.19045 or higher. 

Video memory Extended video memory up to 32 GBytes 

Connections 6 x USB 3.0, 2 x Ethernet, 1 x HDMI 

Power supply 
AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +12 Vdc output) 

Environmental 

Operating temperature: 15 to 35 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 329 × 188 × 215 mm 

Weight 3.9 kg w/o power supply 

*) Please contact Unigraf for availability 

UCD-452 
Output HDMI 2.1 (HDMI Tx) 

Max video mode 
10240 x 4320 @ 30Hz  

10240 x 4320 @ 60Hz with DSC 

HDMI 2.1 Features 
FRL, TMDS, ALLM, VRR, QMS-VRR, SBTM 

DSC 1.2a, FEC, eARC* 

Content Protection HDCP 2.3, 1.4 

User Interface Computer with monitor, keyboard and mouse 

Operating System 

Debian 11.0 or higher. 

Ubuntu 20.04.4 LTS or higher. 

MacOS Big Sur 11.7.10 or higher. 

Windows 10 10.0.19045 or higher. 

Video memory Extended video memory up to 32 GBytes 

Connections 6 x USB 3.0, 2 x Ethernet, 1 x HDMI 

Power supply 
AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +12 Vdc output) 

Environmental 

Operating temperature: 15 to 35 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 329 × 188 × 215 mm 

Weight 3.9 kg w/o power supply 

*) Please contact Unigraf for availability 
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APPENDIX B: PRODUCT FEATURES 

UCD-400, UCD-411, UCD-424 and UCD-451 Features 
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DP Reference Sink (UCD-400 and UCD-424)             

Video status, preview and saving ●           ▲ 

Buffered capture ●            

Audio monitoring, graphical preview and saving ●           ▲ 

Link status ●           ▲ 

Link control ●           ▲ 

HPD status and control ●           ▲ 

Fast Link Training (Link Training without AUX 

Transaction) 
●  

   
       

MST Feature (up to 4 streams) ●           ▲ 

FEC Feature ●           ▲ 

DSC Decoder, DSC Control  ●          ▲ 

Adaptive-Sync Feature ●           ▲ 

DPCD editor ●            

Monitor InfoFrame Status (SDP) ●           ▲ 

EDID read and write ●           ▲ 

EDID / DisplayID Editor ●            

HDCP 1.3 status and control ●           ▲ 

HDCP 2.3 status and control  ●           ▲ 

Event Log, AUX Analyzer ●           ▲ 

Source DUT Testing (Link and CRC test) ●           ▲ 

Playback ●            

Main Link Analyzer   ●          

eDP Reference Sink             

eDP Link Training & Link Rate Support     ●        

Alternate Scrambler Seed Reset (ASSR) ●            

Ability to Ignore Certain MSA Data Fields ●            

OUI Support ●            

GUID Register Support ●            

Source Device Detection by way of the AUX_CH ●            

Panel Replay, PSR, ALPM             

Panel Replay    ●         

PSR1     ●        

PSR2     ●        
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Early Transport    ● ●        

Selective Update    ● ●        

AUX-less ALPM    ● ●        

AUX-wake ALPM     ●        

DP 1.4 / 2.1 Link Layer CTS for testing Source DUT             

DP 1.4a LL, Audio, FEC CTS      ●       

DP 1.4a DSC CTS for testing Source DUT       ●      

DisplayID / EDID CTS for testing Source DUT        ●     

Adaptive-Sync CTS for testing Source DUT         ●    

HDCP 2.3 CTS for testing DP Source DUT          ● ●  

HDCP 2.3 CTS for testing DP Repeater DUT           ●  
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UCD-400, UCD-411, UCD-424 and UCD-451 Features 
(cont.) 
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DP Reference Source                      

Video pattern generator (fixed patterns and timings) ●           ▲ 

Custom video patterns and timings ●           ▲ 

Audio generator ●           ▲ 

Playback ●           ▲ 

Link status ●           ▲ 

Link control ●           ▲ 

HPD status ●           ▲ 

EDID read and write ●           ▲ 

EDID / DisplayID Editor ●            

Fast Link Training (Link Training without AUX 

Transaction) 
●   

  
       

MST Feature (up to 4 streams) ●           ▲ 

FEC Feature ●           ▲ 

DSC Encoder  ●           

Adaptive-Sync Feature ●           ▲ 

DPCD editor ●            

LTTPR Feature   ●         ▲ 

HDCP 1.3 status and control ●           ▲ 

HDCP 2.3 status and control ●           ▲ 

Event Log, AUX Analyzer ●            

Sink DUT Testing ●            

eDP Reference Source             

eDP Link Training & Link Rate Support     ●        

Alternate Scrambler Seed Reset (ASSR) ●            

OUI Support ●            

GUID Register Support ●            

Live Frame Mode ●            

Panel Replay, PSR, ALPM             

Panel Replay    ●         

PSR1     ●        

PSR2     ●        

Early Transport    ● ●        

Selective Update    ● ●        

AUX-less ALPM    ● ●        

AUX-wake ALPM     ●        
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DP 1.4 / 2.1 Link Layer CTS for testing Sink DUT             

DP 1.4a LL, Audio and FEC CTS for testing Sink DUT *      ●       

DP 1.4a DSC CTS for testing Sink DUT*       ●      

DisplayID / EDID CTS for testing Sink DUT*        ●     

Adaptive-Sync CTS for testing Sink DUT*         ●    

HDCP 2.3 CTS for testing DP Sink DUT*          ● ●  

HDCP 2.3 CTS for testing DP Repeater DUT*           ●  

* Check availability for UDC-451 from Unigraf.  
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UCD-422, UCD-412 and UCD-452 Features 

    Input / Output Role U
C

D
-4

X
X

 D
e
fa

u
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H
D
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I 
1
.4

 L
in

k 
A
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al

yz
e
r 

T
S

I 
B
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HDMI Reference Sink (UCD-422 only)      

Video status, preview and saving ●  ▲ 

Buffered capture ●   

Audio monitoring, graphical preview and saving ●  ▲ 

Link status ●  ▲ 

Link control ●   

HPD status and control ●  ▲ 

EDID read and write ●  ▲ 

EDID Editor ●   

HDCP 1.4 status and control* ●  ▲ 

HDCP 2.3 status and control* ●  ▲ 

FEC Feature ●  ▲ 

DSC Decoder, DSC Control ●   

ALLM, VRR ●  ▲ 

Event Log ●   

InfoFrame status ●  ▲ 

eARC ●  ▲ 

Source DUT Testing ●  ▲ 

HDMI 1.4 Link Analyzer  ●  

 

 

HDMI Reference Source      

Video pattern generator (fixed patterns and timings) ●  ▲ 

Custom video patterns and timings ●  ▲ 

Playback ●  ▲ 

Audio Generator ●  ▲ 

Link status ●  ▲ 

Link control ●  ▲ 

EDID read and write ●  ▲ 

EDID Editor ●   

DSC Encoder ●   

SCDC Editor ●   

Event Log ●   

Sink DUT Testing ●   

HDCP 1.4 status and control* ●  ▲ 

HDCP 2.3 status and control* ●  ▲ 
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UCD-424 USB-C Features 

    Input / Output Role U
C

D
-4

X
X

 D
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fa
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S

I 
B
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ic

 

USB-C Modes Common     

USB-C Data Role status & control ● ▲ 

USB-C Power Role status & control ● ▲ 

USB-C Vbus / CC / Vconn voltage / current monitoring ● ▲ 

Power Delivery protocol monitoring ● ▲ 

Cable Info (E-marker details) ● ▲ 

Event Logger ●  

Support for USB-C Power for 5V/3A ● ▲ 

Support for USB-C Power for 9V/3A ● ▲ 

DP Alt Mode Common   

USB-C DP ALT Mode status ● ▲ 

USB-C DP ALT Mode control ● ▲ 

 

Product Options 

UCD-400, UCD-411 and UCD-424 Product Options 

Product P/N Product P/N 

HDCP 2.3 CTS for testing Source DUT on DP MT6634 DSC Decoder for testing Source DUT on DP MT6670 

HDCP 2.3 CTS for testing Sink DUT on DP MT6636 DSC Encoder for testing Sink DUT on DP MT6671 

HDCP 2.3 CTS for testing Repeater DUT on DP MT6638 
DP 2.1 Adaptive-Sync CTS for testing Source DUT 

(8b/10b)  
MT6648 

DP 1.4a LL CTS for testing Sink DUT MT6635 
DP 2.1 Adaptive-Sync CTS for testing Sink DUT 

(8b/10b)  
MT6649 

DP 1.4a LL CTS for testing Source DUT MT6637 
HDR 10+ Display Device and SSTM Test for testing 

Sink DUT on DP 
MT6676 

DP 1.4a DSC CTS for testing Source DUT MT6642 
HDR 10+ Distribution Device for testing Source 

DUT on DP 
MT6678 

DP 1.4a DSC CTS for testing Sink DUT MT6643 DP 1.4a Link Analyzer MT6655 

DP 2.1 DisplayID / EDID CTS for testing Source 

DUT (8b/10b) 
MT6646 

DP 2.1 Panel Replay support for testing Sink & 

Source DUT 

MT6685 

DP 2.1 DisplayID / EDID CTS for testing Sink DUT 

(8b/10b) 
MT6647 eDP support for testing Sink & Source DUT MT6686 

 

UCD-412, UCD-422 Product Options 

Product P/N Product P/N 

DSC Decoder for testing Source DUT on HDMI MT6672 HDR10+ DD and SSTM Tests for HDMI Sink DUT MT6675 

DSC Encoder for testing Sink DUT on HDMI MT6673 HDR10+ DD and SSTM Tests for HDMI Source DUT MT6677 

HDMI 1.4 Link Analyzer MT6658   
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APPENDIX C: PREDEFINED TIMINGS 

Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CVT 640 × 480 @ 60 Hz   640 480 800 525 144 35 96 2 60 25,20 

CTA 640 × 480 @ 60 Hz (VIC 1) 640 480 800 525 144 35 96 2 60 25,17 

CTA 720 × 480 @ 60 Hz (VIC 2) 720 480 858 525 122 36 62 6 60 27,03 

CTA 720 × 480 @ 60 Hz (VIC 3) 720 480 858 525 122 36 62 6 60 27,00 

CTA 720 × 576 @ 50 Hz (VIC 17) 720 576 864 625 132 44 64 5 50 27,00 

CTA 720 × 576 @ 50 Hz (VIC 18) 720 576 864 625 132 44 64 5 50 27,00 

CTA 720 × 576 @ 100 Hz (VIC 42) 720 576 864 625 132 44 64 5 100 54,00 

CTA 720 × 576 @ 100 Hz (VIC 43) 720 576 864 625 132 44 64 5 100 54,00 

CTA 720 × 480 @ 120 Hz (VIC 49) 720 480 858 525 122 36 62 6 120 54,00 

CTA 720 × 480 @ 120 Hz (VIC 48) 720 480 858 525 122 36 62 6 120 54,05 

CTA 720 × 576 @ 200 Hz (VIC 52) 720 576 864 625 132 44 64 5 200 108,00 

CTA 720 × 576 @ 200 Hz (VIC 53) 720 576 864 625 132 44 64 5 200 108,00 

CTA 720 × 480 @ 240 Hz (VIC 56) 720 480 858 525 122 36 62 6 240 108,00 

CTA 720 × 480 @ 240 Hz (VIC 57) 720 480 858 525 122 36 62 6 240 108,00 

DMT 800 × 600 @ 60 Hz (ID Eh) 800 600 1056 628 216 27 128 4 60 39,79 

DMT 848 × 480 @ 60 Hz (ID 14) 848 480 1088 517 224 31 112 8 60 33,75 

DMT 1024 × 768 @ 60 Hz (ID 10h) 1024 768 1344 806 296 35 136 6 60 65,00 

CTA 1280 × 720 @ 50 Hz (VIC 19) 1280 720 1980 750 260 25 40 5 50 74,25 

CTA 1280 × 720 @ 100 Hz (VIC 41) 1280 720 1980 750 260 25 40 5 100 148,50 

CTA 1280 × 720 @ 24 Hz (VIC 60) 1280 720 3300 750 260 25 40 5 24 59,40 

CTA 1280 × 720 @ 25 Hz (VIC 61) 1280 720 3960 750 260 25 40 5 25 74,25 

CTA 1280 × 720 @ 30 Hz (VIC 62) 1280 720 3300 750 260 25 40 5 30 74,25 

CTA 1280 × 720 @ 24 Hz (VIC 65) 1280 720 3300 750 260 25 40 5 24 59,40 

CTA 1280 × 720 @ 25 Hz (VIC 66) 1280 720 3960 750 260 25 40 5 25 74,25 

CTA 1280 × 720 @ 30 Hz (VIC 67) 1280 720 3300 750 260 25 40 5 30 74,25 

CTA 1280 × 720 @ 50 Hz (VIC 68) 1280 720 1980 750 260 25 40 5 50 74,25 

CTA 1280 × 720 @ 60 Hz (VIC 69) 1280 720 1650 750 260 25 40 5 60 74,25 

CTA 1280 × 720 @ 100 Hz (VIC 70) 1280 720 1980 750 260 25 40 5 100 148,50 

CTA 1280 × 720 @ 120 Hz (VIC 71) 1280 720 1650 750 260 25 40 5 120 148,50 

CTA 1280 × 720 @ 48 Hz (VIC 108) 1280 720 2500 750 260 25 40 5 48 90,00 

CTA 1280 × 720 @ 48 Hz (VIC 109) 1280 720 2500 750 260 25 40 5 48 90,00 

CTA 1280 × 720 @ 60 Hz (VIC 4) 1280 720 1650 750 260 25 40 5 60 74,25 

CTA 1280 × 720 @ 120 Hz (VIC 47) 1280 720 1650 750 260 25 40 5 120 148,50 

CVT 1280 × 768 @ 60 Hz  [RB1] 1280 768 1440 790 112 19 32 7 60 68,26 

DMT 1280 × 768 @ 60 Hz (ID 17h) 1280 768 1664 798 320 27 128 7 60 79,67 

DMT 1280 × 800 @ 60 Hz (ID 1Bh) [RB1] 1280 800 1440 823 112 20 32 6 60 71,11 

DMT 1280 × 800 @ 60 Hz (ID 1Ch) 1280 800 1680 831 328 28 128 6 60 83,76 

DMT 1280 × 960 @ 60 Hz (ID 20h) 1280 960 1800 1000 424 39 112 3 60 108,00 

DMT 1280 × 1024 @ 60 Hz (ID 23h) 1280 1024 1688 1066 360 41 112 3 60 107,96 

DMT 1360 × 768 @ 60 Hz (ID 27h) 1360 768 1792 795 368 24 112 6 60 85,48 

DMT 1400 × 1050 @ 60 Hz (ID 29h) [RB1] 1400 1050 1560 1080 112 27 32 4 60 101,09 

DMT 1400 × 1050 @ 60 Hz (ID 2Ah) 1400 1050 1864 1089 376 36 144 4 60 121,79 

*) CVT: Coordinated Video Timings (CVT; VESA-2021-09-27 v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CTA 1440 × 240 @ 60 Hz (VIC 8) 1440 240 1716 263 238 18 124 3 60 27,00 

CTA 1440 × 240 @ 60 Hz (VIC 9) 1440 240 1716 263 238 18 124 3 60 27,00 

CTA 1440 × 480 @ 60 Hz (VIC 14) 1440 480 1716 525 244 36 124 6 60 54,00 

CTA 1440 × 480 @ 60 Hz (VIC 15) 1440 480 1716 525 244 36 124 6 60 54,00 

CTA 1440 × 576 @ 50 Hz (VIC 22) 1440 576 1728 625 264 22 126 3 50 54,00 

CTA 1440 × 288 @ 50 Hz (VIC 23) 1440 288 1728 314 264 22 126 3 50 27,00 

CTA 1440 × 288 @ 50 Hz (VIC 24) 1440 288 1728 314 264 22 126 3 50 27,00 

CTA 1440 × 576 @ 50 Hz (VIC 29) 1440 576 1728 625 264 44 128 5 50 54,00 

CTA 1440 × 576 @ 50 Hz (VIC 30) 1440 576 1728 625 264 44 128 5 50 54,00 

CVT 1600 × 1200 @ 60 Hz  [RB1] 1600 1200 1760 1235 112 32 32 4 60 130,42 

DMT 1600 × 1200 @ 60 Hz (ID 33h) 1600 1200 2160 1250 496 49 192 3 60 162,00 

CTA 1680 × 720 @ 24 Hz (VIC 79) 1680 720 3300 750 260 25 40 5 24 59,40 

CTA 1680 × 720 @ 25 Hz (VIC 80) 1680 720 3168 750 260 25 40 5 25 59,40 

CTA 1680 × 720 @ 30 Hz (VIC 81) 1680 720 2640 750 260 25 40 5 30 59,40 

CTA 1680 × 720 @ 50 Hz (VIC 82) 1680 720 2200 750 260 25 40 5 50 82,50 

CTA 1680 × 720 @ 100 Hz (VIC 84) 1680 720 2000 825 260 100 40 5 100 165,00 

CTA 1680 × 720 @ 48 Hz (VIC 110) 1680 720 2750 750 260 25 40 5 48 99,00 

CTA 1680 × 720 @ 60 Hz (VIC 83) 1680 720 2200 750 260 25 40 5 60 99,00 

CTA 1680 × 720 @ 120 Hz (VIC 85) 1680 720 2000 825 260 100 40 5 120 198,00 

DMT 1680 × 1050 @ 60 Hz (ID 39h) [RB1] 1680 1050 1840 1080 112 27 32 6 60 119,23 

DMT 1680 × 1050 @ 60 Hz (ID 3Ah) 1680 1050 2240 1089 456 36 176 6 60 146,36 

DMT 1792 × 1344 @ 60 Hz (ID 3Eh) 1792 1344 2448 1394 528 49 200 3 60 204,75 

DMT 1856 × 1392 @ 60 Hz (ID 41h) 1856 1392 2528 1439 576 46 224 3 60 218,27 

CTA 1920 × 1080 @ 50 Hz (VIC 31) 1920 1080 2640 1125 192 41 44 5 50 148,50 

CTA 1920 × 1080 @ 24 Hz (VIC 32) 1920 1080 2750 1125 192 41 44 5 24 74,25 

CTA 1920 × 1080 @ 25 Hz (VIC 33) 1920 1080 2640 1125 192 41 44 5 25 74,25 

CTA 1920 × 1080 @ 100 Hz (VIC 64) 1920 1080 2640 1125 192 41 44 5 100 297,00 

CTA 1920 × 1080 @ 24 Hz (VIC 72) 1920 1080 2750 1125 192 41 44 5 24 74,25 

CTA 1920 × 1080 @ 25 Hz (VIC 73) 1920 1080 2640 1125 192 41 44 5 25 74,25 

CTA 1920 × 1080 @ 30 Hz (VIC 74) 1920 1080 2200 1125 192 41 44 5 30 74,25 

CTA 1920 × 1080 @ 50 Hz (VIC 75) 1920 1080 2640 1125 192 41 44 5 50 148,50 

CTA 1920 × 1080 @ 60 Hz (VIC 76) 1920 1080 2200 1125 192 41 44 5 60 148,50 

CTA 1920 × 1080 @ 100 Hz (VIC 77) 1920 1080 2640 1125 192 41 44 5 100 297,00 

CTA 1920 × 1080 @ 120 Hz (VIC 78) 1920 1080 2200 1125 192 41 44 5 120 297,00 

CVT 1920 × 1080 @ 30 Hz  [RB1] 1920 1080 2080 1096 112 13 32 5 30 68,39 

CVT 1920 × 1080 @ 30 Hz  [RB2] 1920 1080 2000 1096 72 14 32 8 30 65,76 

CVT 1920 × 1080 @ 144 Hz  [RB3] 1920 1080 2080 1157 152 14 32 8 144 346,66 

CVT 1920 × 1080 @ 200 Hz  [RB3] 1920 1080 2080 1190 152 14 32 8 200 495,21 

CTA 1920 × 1080 @ 30 Hz (VIC 34) 1920 1080 2200 1125 192 41 44 5 30 74,25 

CVT 1920 × 1080 @ 60 Hz  [RB1] 1920 1080 2080 1111 112 28 32 5 60 138,65 

CVT 1920 × 1080 @ 60 Hz   1920 1080 2000 1111 72 14 32 8 60 133,32 

DMT 1920 × 1080 @ 60 Hz (ID 52h) 1920 1080 2200 1125 192 41 44 5 60 148,50 

CTA 1920 × 1080 @ 60 Hz (VIC 16) 1920 1080 2200 1125 192 41 44 5 60 148,50 

CVT 1920 × 1080 @ 120 Hz  [RB1] 1920 1080 2080 1144 112 61 32 5 120 285,54 

CVT 1920 × 1080 @ 120 Hz  [RB2] 1920 1080 2000 1144 72 14 32 8 120 274,56 

CTA 1920 × 1080 @ 120 Hz (VIC 63) 1920 1080 2200 1125 192 41 44 5 120 297,00 

*) CVT: Coordinated Video Timings (CVT; VESA-2021-09-27 v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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Description* HA VA HT VT HST VST HSYN VSYN FR 
Pixel Clock 

(MHz) 

CTA 1920 × 1080 @ 48 Hz (VIC 111) 1920 1080 2750 1125 192 41 44 5 48 148,50 

CTA 1920 × 1080 @ 48 Hz (VIC 112) 1920 1080 2750 1125 192 41 44 5 48 148,50 

DMT 1920 × 1200 @ 60 Hz (ID 45h) 1920 1200 2592 1245 536 42 200 6 60 193,62 

DMT 1920 × 1440 @ 60 Hz (ID 49h) 1920 1440 2600 1500 552 59 208 3 60 234,00 

CVT 2048 × 1536 @ 60 Hz  [RB1] 2048 1536 2208 1580 112 41 32 4 60 209,32 

CTA 2560 × 1080 @ 24 Hz (VIC 86) 2560 1080 3750 1100 192 16 44 5 24 99,00 

CTA 2560 × 1080 @ 25 Hz (VIC 87) 2560 1080 3200 1125 192 41 44 5 25 90,00 

CTA 2560 × 1080 @ 30 Hz (VIC 88) 2560 1080 3520 1125 192 41 44 5 30 118,80 

CTA 2560 × 1080 @ 50 Hz (VIC 89) 2560 1080 3300 1125 192 41 44 5 50 185,63 

CTA 2560 × 1080 @ 100 Hz (VIC 91) 2560 1080 2970 1250 192 166 44 5 100 371,25 

CVT 2560 × 1440 @ 60 Hz  [RB2] 2560 1440 2640 1481 72 14 32 8 60 234,59 

CVT 2560 × 1440 @ 60 Hz  [RB1] 2560 1440 2720 1481 112 38 32 5 60 241,70 

CVT 2560 × 1440 @ 144 Hz  [RB3] 2560 1440 2720 1543 152 14 32 8 144 604,57 

CVT 2560 × 1440 @ 200 Hz  [RB3] 2560 1440 2720 1586 152 14 32 8 200 863,09 

CTA 2560 × 1080 @ 48 Hz (VIC 113) 2560 1080 3750 1100 192 16 44 5 48 198,00 

CVT 2560 × 1080 @ 60 Hz   2560 1080 3424 1120 704 37 272 10 60 230,09 

CVT 2560 × 1080 @ 60 Hz  [RB1] 2560 1080 2720 1111 112 28 32 10 60 181,32 

CVT 2560 × 1080 @ 144 Hz  [RB3] 2560 1080 2720 1157 152 14 32 8 144 453,33 

CVT 2560 × 1080 @ 200 Hz  [RB3] 2560 1080 2720 1190 152 14 32 8 200 647,59 

CTA 2560 × 1080 @ 60 Hz (VIC 90) 2560 1080 3000 1100 192 16 44 5 60 198,00 

CTA 2560 × 1080 @ 120 Hz (VIC 92) 2560 1080 3300 1250 192 16 44 5 120 495,00 

DMT 2560 × 1600 @ 60 Hz (ID 4Dh) 2560 1600 3504 1658 752 55 280 6 60 348,58 

DMT 2560 × 1600 @ 60 Hz (ID 4Ch) [RB1] 2560 1600 2720 1646 112 43 32 6 60 268,63 

CTA 2880 × 240 @ 60 Hz (VIC 12) 2880 240 3432 263 476 18 248 3 60 54,00 

CTA 2880 × 240 @ 60 Hz (VIC 13) 2880 240 3432 263 476 18 248 3 60 54,00 

CTA 2880 × 288 @ 50 Hz (VIC 27) 2880 288 3456 314 528 22 252 3 50 54,00 

CTA 2880 × 288 @ 50 Hz (VIC 28) 2880 288 3456 314 528 22 252 3 50 54,00 

CTA 2880 × 480 @ 60 Hz (VIC 35) 2880 480 3432 525 488 36 248 6 60 108,00 

CTA 2880 × 480 @ 60 Hz (VIC 36) 2880 480 3432 525 488 36 248 6 60 108,00 

CTA 2880 × 576 @ 50 Hz (VIC 37) 2880 576 3456 625 528 44 256 5 50 108,00 

CTA 2880 × 576 @ 50 Hz (VIC 38) 2880 576 3456 625 528 44 256 5 50 108,00 

2880 × 1440 @ 60 Hz 2880 1440 2976 1456 48 8 8 1 60 259,98 

CVT 3440 x 1440 @ 60 Hz 3440 1440 4688 1493 992 50 368 10 60 419.951 

CVT 3440 x 1440 @ 60 Hz [RB1] 3440 1440 3600 1481 112 38 32 10 60 319.896 

CVT 3440 x 1440 @ 60 Hz [RB2] 3440 1440 3520 1481 72 14 32 8 60 312.787 

CVT 3440 x 1440 @ 120 Hz 3440 1440 4800 1545 1064 102 384 10 120 889.92 

CVT 3440 x 1440 @ 120 Hz [RB1] 3440 1440 3600 1525 112 82 32 10 120 658.80 

CVT 3440 x 1440 @ 120 Hz [RB2] 3440 1440 3520 1525 72 14 32 8 120 644.16 

CVT 3440 x 1440 @ 165 Hz 3440 1440 4832 1588 1080 145 384 10 165 1266.081 

CVT 3440 x 1440 @ 165 Hz [RB1] 3440 1440 3600 1559 112 116 32 10 165 926.046 

CVT 3440 x 1440 @ 165 Hz [RB2] 3440 1440 3520 1559 72 14 32 8 165 905.467 

CVT 3440 x 1440 @ 200 Hz 3440 1440 4848 1622 1088 179 384 10 200 1572.691 

CVT 3440 x 1440 @ 200 Hz [RB1] 3440 1440 3600 1586 112 143 32 10 200 1141.92 

CVT 3440 x 1440 @ 200 Hz [RB2] 3440 1440 3520 1586 72 14 32 8 200 1116.544 

CVT 3440 x 1440 @ 240 Hz 3440 1440 4848 1663 1088 220 384 10 240 1934.934 

CVT 3440 x 1440 @ 240 Hz [RB1] 3440 1440 3600 1619 112 176 32 10 240 1398.816 

CVT 3440 x 1440 @ 240 Hz [RB2] 3440 1440 3520 1619 72 14 32 8 240 1367.731 

CVT 3840 × 2160 @ 30 Hz  [RB1] 3840 2160 4000 2191 112 28 32 5 30 262,92 

CVT 3840 × 2160 @ 30 Hz  [RB2] 3840 2160 3920 2191 72 14 32 8 30 257,66 

CVT 3840 × 2160 @ 60 Hz  [RB1] 3840 2160 4000 2222 112 59 32 5 60 533,28 

CVT 3840 × 2160 @ 60 Hz  [RB2] 3840 2160 3920 2222 72 14 32 8 60 522,61 
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CVT 3840 × 2160 @ 60 Hz  [RB3] 3840 2160 4000 2222 152 14 32 8 60 533,47 

CTA 3840 × 2160 @ 60 Hz (VIC 97) 3840 2160 4400 2250 384 82 88 10 60 594,00 

CTA 3840 × 2160 @ 24 Hz (VIC 93) 3840 2160 5500 2250 384 82 88 10 24 297,00 

CTA 3840 × 2160 @ 25 Hz (VIC 94) 3840 2160 5280 2250 384 82 88 10 25 297,00 

CTA 3840 × 2160 @ 30 Hz (VIC 95) 3840 2160 4400 2250 384 82 88 10 30 297,00 

CTA 3840 × 2160 @ 50 Hz (VIC 96) 3840 2160 5280 2250 384 82 88 10 50 594,00 

CTA 3840 × 2160 @ 24 Hz (VIC 103) 3840 2160 5500 2250 384 82 88 10 24 297,00 

CTA 3840 × 2160 @ 25 Hz (VIC 104) 3840 2160 5280 2250 384 82 88 10 25 297,00 

CTA 3840 × 2160 @ 30 Hz (VIC 105) 3840 2160 4400 2250 384 82 88 10 30 297,00 

*) CVT: Coordinated Video Timings (CVT; VESA-2021-09-27 v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 

 

 

Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CTA 3840 × 2160 @ 50 Hz (VIC 106) 3840 2160 5280 2250 384 82 88 10 50 594,00 

CTA 3840 × 2160 @ 60 Hz (VIC 107) 3840 2160 4400 2250 384 82 88 10 60 594,00 

CTA 3840 × 2160 @ 48 Hz (VIC 114) 3840 2160 5500 2250 384 82 88 10 48 594,00 

CTA 3840 × 2160 @ 48 Hz (VIC 116) 3840 2160 5500 2250 384 82 88 10 48 594,00 

CTA 3840 × 2160 @ 100 Hz (VIC 117) 3840 2160 5280 2250 384 82 88 10 100 1188,00 

CTA 3840 × 2160 @ 100 Hz (VIC 119) 3840 2160 5280 2250 384 82 88 10 100 1188,00 

CTA 3840 × 2160 @ 120 Hz (VIC 120) 3840 2160 4400 2250 384 82 88 10 120 1188,00 

CVT 4096 × 2160 @ 60 Hz  [RB2] 4096 2160 4176 2222 72 14 32 8 60 556,74 

CVT 4096 × 2160 @ 60 Hz  [RB1] 4096 2160 4256 2222 112 59 32 10 60 567,41 

CVT 4096 × 2160 @ 60 Hz  [RB3] 4096 2160 4256 2222 152 14 32 8 60 567,61 

CTA 4096 × 2160 @ 60 Hz (VIC 102) 4096 2160 4400 2250 216 82 88 10 60 594,00 

CTA 4096 × 2160 @ 120 Hz (VIC 219) 4096 2160 4400 2250 216 82 88 10 120 1188,00 

CTA 4096 × 2160 @ 100 Hz (VIC 218) 4096 2160 5280 2250 384 82 88 10 100 1188,00 

CTA 4096 × 2160 @ 50 Hz (VIC 101) 4096 2160 5280 2250 216 82 88 10 50 594,00 

CTA 4096 × 2160 @ 48 Hz (VIC 115) 4096 2160 5500 2250 384 82 88 10 48 594,00 

CTA 4096 × 2160 @ 24 Hz (VIC 98) 4096 2160 5500 2250 384 82 88 10 24 297,00 

CTA 4096 × 2160 @ 25 Hz (VIC 99) 4096 2160 5280 2250 216 82 88 10 25 297,00 

CTA 4096 × 2160 @ 30 Hz (VIC 100) 4096 2160 4400 2250 216 82 88 10 30 297,00 

CVT 3840 × 2160 @ 120 Hz  [RB1] 3840 2160 4000 2287 112 124 32 5 120 1097,76 

CVT 3840 × 2160 @ 120 Hz  [RB2] 3840 2160 3920 2287 72 14 32 8 120 1075,80 

CTA 3840 × 2160 @ 120 Hz (VIC 118) 3840 2160 4400 2250 384 82 88 10 120 1188,00 

CVT 5120 × 2160 @ 30 Hz  [RB1] 5120 2160 5280 2191 112 28 32 10 30 347,05 

CVT 5120 × 2160 @ 30 Hz  [RB2] 5120 2160 5200 2191 72 14 32 8 30 341,80 

CTA 5120 × 2160 @ 30 Hz (VIC 123) 5120 2160 6000 2200 216 32 88 10 30 396,00 

CVT 5120 × 2160 @ 60 Hz  [RB1] 5120 2160 5280 2222 112 59 32 10 60 703,93 

CVT 5120 × 2160 @ 60 Hz  [RB2] 5120 2160 5200 2222 72 14 32 6 60 693,26 

CTA 5120 × 2160 @ 60 Hz (VIC 126) 5120 2160 5500 2250 216 82 88 10 60 742,50 

5120 × 2880 @ 60 Hz 5120 2880 5280 2962 112 79 32 5 60 938,36 

5120 × 2880 @ 60 Hz 5120 2880 5200 2962 72 14 32 8 60 924,14 

5120 × 2880 @ 60 Hz 5120 2880 5280 2962 152 14 32 8 60 938,69 

CTA 5120 × 2160 @ 48 Hz (VIC 124) 5120 2160 6250 2475 384 307 88 10 48 742,50 

CTA 5120 × 2160 @ 50 Hz (VIC 125) 5120 2160 6600 2250 384 82 88 10 50 742,50 

CTA 5120 × 2160 @ 100 Hz (VIC 127) 5120 2160 6600 2250 384 82 88 10 100 1485,00 

CTA 5120 × 2160 @ 25 Hz (VIC 122) 5120 2160 7200 2200 384 32 88 10 25 396,00 

CTA 5120 × 2160 @ 24 Hz (VIC 121) 5120 2160 7500 2200 384 32 88 10 24 396,00 

CVT 7680 × 4320 @ 30 Hz  [RB2] 7680 4320 7760 4381 72 14 32 8 30 1019,90 
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CVT 7680 × 4320 @ 30 Hz  [RB1] 7680 4320 7840 4381 112 58 32 5 30 1030,41 

CVT 7680 × 4320 @ 60 Hz  [RB2] 7680 4320 7760 4443 72 14 32 8 60 2068,66 

CVT 7680 × 4320 @ 100 Hz  [RB2] 7680 4320 7760 4529 72 14 32 8 100 3514,50 

CVT 7680 × 4320 @ 60 Hz  [RB1] 7680 4320 7840 4443 112 120 32 5 60 2089,99 

CVT 7680 × 4320 @ 100 Hz  [RB1] 7680 4320 7840 4529 112 206 32 5 100 3550,74 

CTA 7680 × 4320 @ 120 Hz (VIC 201) 7680 4320 8800 4500 768 164 176 20 120 4752,00 

CTA 7680 × 4320 @ 120 Hz (VIC 209) 7680 4320 8800 4500 768 164 176 20 120 4752,00 

CTA 7680 × 4320 @ 30 Hz (VIC 204) 7680 4320 9000 4400 768 64 176 20 30 1188,00 

CTA 7680 × 4320 @ 30 Hz (VIC 196) 7680 4320 9000 4400 768 64 176 20 30 1188,00 

CTA 7680 × 4320 @ 60 Hz (VIC 207) 7680 4320 9000 4400 768 64 176 20 60 2376,00 

CTA 7680 × 4320 @ 60Hz (VIC 199) 7680 4320 9000 4400 768 64 176 20 60 2376,00 

*) CVT: Coordinated Video Timings (CVT; VESA-2021-09-27 v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 

 

Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CTA 7680 × 4320 @ 100 Hz (VIC 208) 7680 4320 10560 4500 768 164 176 20 100 4752,00 

CTA 7680 × 4320 @ 100 Hz (VIC 200) 7680 4320 10560 4500 768 164 176 20 100 4752,00 

CTA 7680 × 4320 @ 25 Hz (VIC 203) 7680 4320 10800 4400 768 64 176 20 25 1188,00 

CTA 7680 × 4320 @ 25 Hz (VIC 195) 7680 4320 10800 4400 768 64 176 20 25 1188,00 

CTA 7680 × 4320 @ 50 Hz (VIC 198) 7680 4320 10800 4400 768 64 176 20 50 2376,00 

CTA 7680 × 4320 @ 50 Hz (VIC 206) 7680 4320 10800 4400 768 64 176 20 50 2376,00 

CTA 7680 × 4320 @ 24 Hz (VIC 194) 7680 4320 11000 4500 768 164 176 20 24 1188,00 

CTA 7680 × 4320 @ 48 Hz (VIC 197) 7680 4320 11000 4500 768 164 176 20 48 2376,00 

CTA 7680 × 4320 @ 24 Hz (VIC 202) 7680 4320 11000 4500 768 164 176 20 24 1188,00 

CTA 7680 × 4320 @ 48 Hz (VIC 205) 7680 4320 11000 4500 768 164 176 20 48 2376,00 

Unigraf 10240 x 4320 @ 30 Hz [RB1] 10240 4320 11000 4500 112 58 32 5 30 1485,00 

Unigraf 10240 x 4320 @ 30 Hz [RB2] 10240 4320 11000 4500 72 14 32 8 30 1485,00 

CTA 10240 x 4320 @ 24 Hz (VIC 210) 10240 4320 12500 4950 768 614 176 20 24 1485,00 

CTA 10240 x 4320 @ 25 Hz (VIC 211) 10240 4320 13500 4400 768 64 176 20 25 1485,00 

CTA 10240 x 4320 @ 30 Hz (VIC 212) 10240 4320 11000 4500 472 164 176 20 30 1485,00 

CTA 10240 x 4320 @ 48 Hz (VIC 213) 10240 4320 12500 4950 768 614 176 20 48 2970,00 

CTA 10240 x 4320 @ 50 Hz (VIC 214) 10240 4320 13500 4400 768 64 176 20 50 2970,00 

CTA 10240 x 4320 @ 60 Hz (VIC 215) 10240 4320 11000 4500 472 164 176 20 60 2970,00 

CTA 10240 x 4320 @ 100 Hz (VIC 216) 10240 4320 13200 4500 768 164 176 20 100 5940,00 

CTA 10240 x 4320 @ 120 Hz (VIC 217) 10240 4320 11000 4500 472 164 176 20 120 5940,00 

*) CVT: Coordinated Video Timings (CVT; VESA-2021-09-27 v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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APPENDIX D: PREDEFINED PATTERNS 

Fixed Patterns 

Selection Pattern Description 

Disabled 

 

The links are activated but no video data transferred 

Color Bar 

 

100% intensity color bars of all primaries and mixed combinations. 

Chessboard 

 

8 by 8 chessboard with black (0%) and 100% intensity white 

Solid Color 
 

Solid color. User selected RGB values 

Solid White 

 

100% white 

Solid Red 

 

100% red 

Solid Green 

 

100% green 

Solid Blue 

 

100% blue 

White V-Strips 

 

Vertical stripes of black (0%) and white (100%).  

Parameters set the widths of the black and white stripes in pixels 

respectively. Default black / white = 20 / 20 pixels. Parameter range 

1 to 1000. 

RGB Wide Strips 

 

16 pixels high horizontal red, green, blue and white stripes. 

Intensity is increased from 0 to 100% with steps defined by the 

given parameter (Color Step = cs) and selected color.  

(   p =   *     _  p h 256)  “ ”    g       5    (        1  )  

Color Ramp 

 

Color Ramp test pattern defined by VESA DisplayPort Link Layer 

Compliance Test Specification. 

Color Square 

 

Color Square test pattern defined by VESA DisplayPort Link Layer 

Compliance Test Specification. Color mode can be selected 

between RGB, YCbCr 4:4:4, 4:2:2, 4:2:0 (ITU Rec 601 / 709) 

Motion Pattern 

 

Horizontally moving color bar pattern. The pattern is shifted to left 

one pixel in each frame in a sequence. The length of the sequence 

is defined with parameter. Range 0 to 34 (default is 20) 

Square Window 

 

100% intensity white square horizontally and vertically centered. 

Height and width defined by parameter as the percentage of height 

and width of the frame (default 30). 
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Extended Patterns 

Selection Icon Description 

Select Image 
 

       i  g   p        y  h          i k           …       w    

Select DSC Image 
 

Custom DSC compressed image file uploaded by the user.  

  i k           …       w    

Unigraf PM5544 
 

Vpattern vector pattern based on PM5544 

Color Web 
 

Vpattern vector pattern. 

Chinese Town Full HD 
 

JPG Bitmap image (1920 x 1080 px) 

UG-2111 HLG Narrow 
 

Software generated pattern. HLG Narrow dynamic range. 

UG-2111 PQ Narrow 
 

Software generated pattern. PQ Narrow dynamic range. 

UG-2111 PQ Full 
 

Software generated pattern. PQ Full dynamic range. 

Multi 
 

Vpattern vector pattern. Multi-purpose pattern w square grid, cross-grids, 

1x1 cross-hatches, circles, and color bars 

SMPTE RP-133 
 

Vpattern vector pattern based on SMTPE RP-133 

SMPTE 303M 
 

Vpattern vector pattern. SMPTE 303M; Full Range; RGB values before 

gamma correction based on D65 and PAL primaries 

Blue 
 

Vpattern vector pattern. 100% Blue 

CirclesW 
 

Vpattern vector pattern. Concentric circles 

Complex 
 

Vpattern vector pattern. Complex Pattern w 64 steps 

Green 
 

Vpattern vector pattern. 100% Green 

Hor1W-Even 
 

Vpattern vector pattern. Horizontal 1 px wide White bars in even rows 

Hor1W-Odd 
 

Vpattern vector pattern. Horizontal 1 px wide White bars in odd rows 

Hor4W 
 

Vpattern vector pattern. Horizontal 4 px high White bars 

Hor10W 
 

Vpattern vector pattern. Horizontal 10 px high White bars 

Hor-10xB 
 

Vpattern vector pattern. 10 pcs horizontal Blue bars 

Hor-10G 
 

Vpattern vector pattern. 10 pcs horizontal Green bars 
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Extended Patterns (cont.) 

Selection Icon Description 

Hor-10xR 
 

Vpattern vector pattern. 10 pcs horizontal Red bars 

Hor-10xW 
 

Vpattern vector pattern. 10 pcs horizontal White bars 

HorRainbow-1024 
 

Vpattern vector pattern. Horizontal Rainbow Ramps 1024 steps 

HorRGBW-1024 
 

Vpattern vector pattern. Horizontal RGBW Ramps 1024 steps 

HorScale9 
 

Vpattern vector pattern. Nine Horizontal Color Ramps 

HorScaleW-64 
 

Vpattern vector pattern. Horizontal White ramp 64 steps 

HorScaleW-128 
 

Vpattern vector pattern. Horizontal White ramp 128 steps 

HorScaleW-X2 
 

Vpattern vector pattern. Horizontal White ramp w edges 128 steps 

InnerBox-BKtoB 
 

Vpattern vector pattern. InnerBox pattern from Black to Blue 

InnerBox-BKtoG 
 

Vpattern vector pattern. InnerBox pattern from Black to Green 

InnerBox-BKtoR 
 

Vpattern vector pattern. InnerBox pattern from Black to Red 

InnerBox-BKtoW 
 

Vpattern vector pattern. InnerBox pattern from Black to White 

InnerBoxMIX 
 

Vpattern vector pattern. InnerBox pattern mixed hues. 

InnerBox-RtoB 
 

Vpattern vector pattern. InnerBox pattern from Red to Blue 

Red 
 

Vpattern vector pattern. 100% Red 

Ver1W-Even 
 

Vpattern vector pattern. Vertical 1 px wide White bars in even columns 

Ver1W-Odd 
 

Vpattern vector pattern. Vertical 1 px wide White bars in odd columns 

Ver4W 
 

Vpattern vector pattern. Vertical 4 px wide White bars 

Ver10W 
 

Vpattern vector pattern. Vertical 10 px wide White bars 

Ver-10xG 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xR 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xB 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xW 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 
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Extended Patterns (cont.) 

Selection Icon Description 

VerBars75% 
 

Vpattern vector pattern. Vertical 75% intensity Color bars 

VerBars100% 
 

Vpattern vector pattern. Vertical 100% intensity Color bars 

VerRGBW-1024 
 

Vpattern vector pattern. Vertical RGBW Ramps 1024 steps 

X-HatchBK-C 
 

Vpattern vector pattern. Black 16 x12 Grid w Circle on White background 

X-HatchW 
 

Vpattern vector pattern. White 16 x12 Grid on Black background 

X-HatchW-C 
 

Vpattern vector pattern. White 16 x12 Grid w Circle on Black background 

X-HatchW-CC 
 

Vpattern vector pattern. White 16 x12 Grid w Ellipses, Circle and 100% 

color bars 

Gray Box 10 

 

Vpattern vector pattern. China 5.6 White Window 10% 

Gray Box 20 

 

Vpattern vector pattern. China 5.6 White Window 20% 

Gray Box 30 

 

Vpattern vector pattern. China 5.6 White Window 30% 

Gray Box 40 

 

Vpattern vector pattern. China 5.6 White Window 40% 

Gray Box 50 

 

Vpattern vector pattern. China 5.6 White Window 50% 

Gray Box 60 

 

Vpattern vector pattern. China 5.6 White Window 60% 

Gray Box 70 

 

Vpattern vector pattern. China 5.6 White Window 70% 

Gray Box 80 

 

Vpattern vector pattern. China 5.6 White Window 80% 

Gray Box 90 

 

Vpattern vector pattern. China 5.6 White Window 90% 

Gray Box 100 

 

Vpattern vector pattern. China 5.6 White Window 100% 

8 Level Gray 

 

Vpattern vector pattern. China 5.5 Ultimate 8 Level Grayscale 
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Extended Patterns (cont.) 

Selection Icon Description 

Black'n'White Window 

HDTV 
 

Vpattern vector pattern. China 5.8 Black and White Window(FOR HDTV) 

Black'n'White Window 

SDTV 
 

Vpattern vector pattern. China 5.8 Black and White Window(FOR SDTV) 

Black Line HDTV 

 

Vpattern vector pattern. China 5.10 Black Line HDTV 

Black Line SDTV 

 

Vpattern vector pattern. China 5.10 Black Line SDTV 

Black Window 

 

Vpattern vector pattern. China 5.7 Black Window 

Check Board 
 

Vpattern vector pattern. China 5.9 Check Board 

Line'n'Window 

 

Vpattern vector pattern. China 5.11 Line and Window 

Narrow White Window 

 

Vpattern vector pattern. China 5.19 Narrow White Window 

Single Dot 

 

Vpattern vector pattern. China Single Dot 

White Line HDTV 

 

Vpattern vector pattern. China 5.10 White Line for HDTV 

White Line SDTV 

 

Vpattern vector pattern. China 5.10 White Line for SDTV 

 

More test patterns can be downloaded e.g. from www.icdm-sid.org/ 

http://www.icdm-sid.org/
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APPENDIX E: SINK, SOURCE AND REPEATER TESTS 

Source DUT Testing 
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Audio Test 
Validate audio signal frequency and glitch-free audio 

reproduction 
●       

CEC Functional Test Set 

(HDMI) (UCD-422) 

CEC functional test, CEC PHY Addr test,  

CEC Complete test, CEC Wake up test,  

CEC Standby test 
●       

CRC Video Tests 

(UCD-400, UCD-422, UCD-424) 

Will be available in future UCD-4XX 

versions 

CRC based single frame reference video test, 

CRC based single frame stability test, 

CRC based sequence of frames reference video test 

CRC based continuous sequence of frames 

reference video test  

●       

Link Config Tests (DP) 

(UCD-400, UCD-424) 

Link Training at All Supported Lane Counts and Link 

Rates 
●       

Pixel Level Video Tests 
Compare video frame sequence with a single 

reference 
       

VRR Source DUT Tests (HDMI) 

(UCD-412, UCD-422) 
VRR static test, QMS Test, VRR Dynamic test ●       

DP 1.4a Link Layer CTS  

(UCD-400, UCD-424) 

4.2.1.1 – 4.2.1.5, 4.2.2.1 – 4.2.2.10, 4.3.1.1 – 

4.3.1.13, 4.3.2.1 – 4.3.2.5, 4.3.3.1, 4.4.1.1 – 

4.4.1.3, 4.4.2, 4.4.3, 4.4.4.1 – 4.4.4.6, 4.5.1.1 – 

4.5.1.2 

 ●      

DP 1.4 DSC CTS 

(UCD-400, UCD-424) 
4.6.1.1 – 4.6.1.9   ●     

DP 1.4 DisplayID-EDID CTS 

(UCD-400, UCD-424) 

4.7.1.1 – 4.7.1.4, 4.7.2.1 – 4.7.2.2, 4.7.3.1 – 4.7.3.3, 

4.7.4.1, 4.7.5.1, 4.7.6.1 - 4.7.6.4, 4.7.7.1 - 4.7.7.2 
   ●    

DP Adaptive-Sync CTS 

(UCD-400, UCD-424) 
4.8.1.1 – 4.8.1.2, 4.8.2.1 – 4.8.2.3     ●   

DP HDCP 2.3 CTS 1A Test Set 

(UCD-400, UCD-424) 
HDCP2.3 CTS 1A-01 –  HDCP2.3 CTS 1A-12      ●  

DP HDCP 2.3 CTS 1B Test Set 

(UCD-400, UCD-424) 
HDCP2.3 CTS 1B-01 –  HDCP2.3 CTS 1B-10      ●  

HDR10+ Distribution Device 

Tests (HDMI RX / DP RX)  

(UCD-400, UCD-422, UCD-424) 

Tests from: 

HDR10+ TEST SPECIFICATION, HDR10+ Distribution 

Device 

      ● 

HDR10+ SSTM Tests for 

Source (HDMI RX / DP RX) 

(UCD-400, UCD-422, UCD-424) 

Tests from: 

HDR10+ TEST SPECIFICATION, Source Side Tone 

Mapping for Source Device 

      ● 

*) Separate licenses for testing Sink, Source, Branch DUT (LL CTS, DSC, DisplayID, Adaptive-Sync) 
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Sink DUT Testing  
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VRR Sink DUT Tests (HDMI) 

(UCD-412, UCD-422) 
VRR static test, QMS Test, VRR Dynamic test ●      

 

DP 1.4a Link Layer CTS  

(UCD-400, UCD-411, 

UCD-424)** 

5.2.1.1 – 5.2.1.12, 5.2.2.1 – 5.2.2.9, 5.3.1.1 – 

5.3.1.9, 5.3.2.1 – 5.3.2.2, 5.4.1.1 – 5.4.1.4, 5.4.2, 

5.4.3.1 – 5.4.3.2, 5.4.4.1 – 5.4.4.6, 5.5.1.1 – 5.5.1.7 

 ●     

 

DP 1.4a DSC CTS 

(UCD-400, UCD-411, 

UCD-424)** 

5.6.1.1 – 5.6.1.26, 5.6.2.1 – 5.6.2.14   ●    

 

DP 1.4a DisplayID-EDID CTS 

(UCD-400, UCD-411, 

UCD-424)** 

5.7.1.1 – 5.7.1.2, 5.7.1.3.1 – 5.7.1.3.4, 5.7.1.4.1 – 

5.7.1.4.9, 5.7.1.5 - 5.7.1.6, 5.7.2.1 – 5.7.2.2, 

5.7.2.3.1 – 5.7.2.3.5, 5.7.2.4.1 – 5.7.2.4.2, 5.7.2.5.1 

– 5.7.2.5.2, 5.7.2.6.1 – 5.7.2.6.2, 5.7.2.7.1, 5.7.2.8, 

5.7.3.1 – 5.7.3.5, 5.7.4.1 – 5.7.4.3, 5.7.4.5, 5.7.5.1, 

5.7.6.1 – 5.7.6.5, 5.7.7.1 – 5.7.7.6, 5.7.8.1 – 

5.7.8.6, 5.7.9.1 – 5.7.9.3, 5.7.10.1 – 5.7.10.3, 

5.7.11.1 – 5.7.11.5, 5.7.12.1 – 5.7.12.4,5.7.13.1-

5.7.13.2, 5.7.14.1 – 5.7.14.6, 5.7.15.1 – 5.7.15.11, 

5.7.16.1 – 5.7.16.7, 5.7.16.9 - 5.7.16.10, 5.7.17.1 – 

5.7.17.5, 5.7.18.1, 5.7.19.1 - 5.7.19.6, 

5.7.20.1 - 5.7.20.3, 5.7.21.1 - 5.7.21.5, 5.7.22.1 - 

5.7.22.7 

   ●   

 

DP Adaptive-Sync CTS 

(UCD-400, UCD-411, 

UCD-424)** 

5.8.1.1 – 5.8.1.3     ●  

 

DP HDCP 2.3 CTS 2C Test 

Set 

(UCD-400, UCD-411, 

UCD-424)** 

HDCP2.3 CTS 2C-01 – HDCP2.3 CTS 2C-06      ● 

 

HDR10+ CTS Tests  

(HDMI & DP) 
HDR10+ Display Device and SSTM Tests       ● 

Cable test (UCD-422) Cable Test Check ●       

*) Separate licenses for testing Sink, Source, Branch DUT (LL CTS, DSC, DisplayID, Adaptive-Sync) 

**) Please check availability for UCD-451 from Unigraf 
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Repeater DUT Testing  
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DP HDCP 2.3 CTS 3A Test Set 

(UCD-400, UCD-411, UCD-424) 
HDCP2.3 CTS 3A-01 – HDCP2.3 CTS 3A-06  ● 

DP HDCP 2.3 CTS 3B Test Set 

(UCD-400, UCD-411, UCD-424) 
HDCP2.3 CTS 3B-01 – HDCP2.3 CTS 3B-07  ● 

DP HDCP 2.3 CTS 3C Test Set 

(UCD-400, UCD-411, UCD-424) 
HDCP2.3 CTS 3C-01 – HDCP2.3 CTS 3C-25  ● 

*) Separate licenses for testing Sink, Source and Repeater DUT (HDCP) 
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   p i     T     

Role: Product: 

DP Reference Sink (DP RX) UCD-400, UCD-424 

DP Reference Source (DP TX) UCD-400, UCD-411, UCD-424, UCD-451* 

 

*) Please check availability for UCD-451 from Unigraf 

 

Compliance test capability is a license enabled add-on to UCD Console.  

The tests are included in the GUI software, license codes enable the tests for use. Please refer to 

Appendix B Licensing for details. The list of compliance tests that UCD Console supports, please refer 

to document DP CTS Tool Options for Unigraf UCD-400.pdf. It can be downloaded in Unigraf 

Document Center at https://www.unigraf.fi/documents/. If you have any additional questions, please 

contact Unigraf or your local representative. 

Compliance tests (CTS Tests) are part of tests included in Source DUT Testing tab of DP RX and 

Sink DUT Testing tab of DP TX. 

The tests cases are divided to test categories as described in Appendix E of this document. Test 

categories are placed in sub-tabs. Test category tabs are enabled based on licenses present. Please 

refer to chapter 3 License Manager earlier in this document. 

Test Parameters 

Before running the tests, capabilities of the DUT have to be defined for the test engine. Each test 

category has its dedicated test parameter dialog. Click Configure in Source DUT Testing or Sink 

DUT Testing tab to open the parameter dialog. 

For a detailed description of capabilities listed on the tab please refer to Chapter 3 Compliance Test 

Operation of document VESA DisplayPort v1.4a Link Layer Compliance Test Specification. 

Note: Please make sure that the capability tables are completed before running the tests. The result of the 

test might be misleading if the DUT capabilities and the table do not match. 

https://www.unigraf.fi/documents/
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DSC Test Content 

When running DSC Compliance Tests, Console needs to have access to DSC content used as test 

patterns. This content will be automatically created during test execution. Creation of the test content 

takes time and considerably slows down the execution of the test. To avoid this after the first test run, 

users are able to save the created DSC content by selecting the option Keep auto-created DSC 

content files described below.  

Warning  Please note, that the space needed for storing the full library can be very large 

(appr. 400 GBytes). Please make sure that the content will be stored in a medium that has the 

required space available. 

Options 

In Tools > Options menu you can define DSC Work folder and DSC test content directory.  

DSC temp folder: Folder for DSC Work files. 

DSC test content folder: Folder where DSC source bitmap files, related 

configuration files and DSC conversion tools are stored. 

Keep auto-created DSC content files: By default, the DSC compressed content is deleted after 

use. If selected, the content is not deleted 
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Running CTS Tests 
Source DUT Testing and Sink DUT Testing tabs include the tests enabled with the set of licenses 

present in UCD Console grouped in test set tabs. In tabs the tests are listed by the test name and 

reference number as in applicable compliance test specification. UCD-400 firmware implements the 

test according to the test specification.  

For running a test, select it and click Run selected. For selecting multiple consecutive tests in the list 

hold down the Shift key of your keyboard while selecting the tests. For selecting multiple individual 

tests hold down the Ctrl key in your keyboard while selecting. 

Test flow parameters like Test timeout and Test cycle delay can be defined in Test Parameter dialog 

launched by clicking Configure. 

 

Run Selected Click to start selected tests. By clicking Abort the sequence is stopped. 

Select: Includes the following options for creating templates for tests execution: 

Select All, Clear All, Invert All, Save, Import and Export 

Configure Clicking opens a dialog for defining the test parameters for that set. Please 

refer to Test Parameters below for description. 

Import: Load saved test parameter files (*.td or *.json). 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For 

saving parameters for TSI scripting, please use *.td files. For use with 

Python applications, please use *.json files. 

Stop on Failure: Stops execution of the selected tests if one of the tests fail 

Repeats: Repeat the selected test several times. 

When repeating a sequence of tests, all selected tests are performed in 

each repetition. E.g., when you repeat tests 1, 2 and 3 two times, the 

sequence is: 1, 2, 3, 1, 2, 3. 

Delay time Delay in seconds between individual tests. 

 

Save Report: Click to generate a report file in HTML format for sharing the results with 

other parties for viewing without UCD Console. 

Clear Log Clear the test log and the results matrix 
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Saving Test Parameters 

Test parameters can be saved in various ways. 

Export parameters in Sink DUT Testing tab to a *.td file for later use in UCD Console or with TSI 

scripting or sharing. 

Export parameters in Sink DUT Testing tab to a *.json file for later use in UCD Console or with Python 

applications or sharing. 

Save parameters in Configure dialog as Presets to be later used in UCD Console. Please find a 

description below. 

Presets 

In all Configure dialogs the selected parameters can be saved as Presets. Please click Presets… to 

save or recall a configuration. Click Save first to assign the configuration a name, and after that you 

can e.g. Export it to a file. 

 

Operator Feedback 

In some compliance tests operator action or feedback is required for items that the test itself cannot 

perform or confirm. In these cases test opens a pop-up dialog. In the dialog the operator is instructed 

about items to do or to be verified and buttons for providing the “Proceed” instruction or “Pass” and 

“Fail” feedback. 

Clicking “Abort” stops execution of the test. 
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Evaluating CTS Test Results 

The test procedure advancement can be monitored in the Test Log panel. It describes the steps of 

each individual test in the way defined in the corresponding VESA Compliance Test Specification. 

Please use the Status Log and Specification side by side when interpreting the results. 

At the completion of each test the result of the test is indicated in the matrix on the right hand side of 

the test panel. For each test the matrix lists the number of occurrences of each result and the number 

of tries performed. 
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Test Report 
Results of the test can be saved as a report in HTML format by clicking Save Report.  

Viewing the CTS Test Report 

The report file can be viewed with any HTML browser. The report has built-in views for Report 

Summary, Test Summary 
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A  i  T        

Role: Product: 

DP Reference Sink (DP RX) UCD-400 

HDMI Reference Sink (HDMI RX) UCD-422 

DP Alt Mode Reference Sink (DP RX) UCD-424 

Validate audio signal frequency and glitch-free audio reproduction 

Perform frequency check on the digital audio content and verify the content to be glitch-free. This 

test assumes that a pure sine-wave audio signal content is being transmitted to the test equipment. 

The test will first capture minimum of one second of audio content. The audio is then analyzed in two 

stages.  

First, the power spectrum is calculated, and the highest peak must be within the defined window. 

Resolution of the peak frequency check is better than ±1 Hz.  

In the second stage, received audio is checked for random glitches, such as dropped or duplicated 

samples. This is achieved by examining how the RDV (“Relative Distortion Value”) changes over time 

within the sampled audio. 

The test is considered passed if power of audio content spectrum has its maximum within the defined 

window, and the number of detected audio glitches does not exceed programmed limit. 

 

Parameters in use 

• Expected sampling rate of audio signal (default 44 100 s/sec) 

• Expected audible (sine) frequency in Hz (default 1000 Hz) 

• Allowed deviation from expected frequency in Hz (default 1 Hz) 

• Number of audio glitches allowed per test (default 0) 

 

Click Location where the captured audio is to be saved to browse for the folder to store tests.  
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 E       i     T         

Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-422 

 

Parameters in use 

• Test timeout, in milliseconds 

• Local CEC physical address 

 

 

CEC Functional Test 

Test is intended to check that DUT does CEC initialization correctly after HPD. TE initialize EDID with 

configured address. Apply HPD and expected that Logical Physical addresses that presented in EDID 

will be applied with Report Physical Address message to inform TE about the mapping Logical and 

Physical addresses. That is expectation of CEC behavior. 

CEC Phy Address test. 
Test is intended to check that CEC line is working properly, and DUT can receive CEC Report Physical 

Address or customized OP Code. TE checks that HPD is high and CEC line available and send Report 

Physical Address (or customized OP Code) message in broadcast mode (or with specific destination). 

CEC Wake Up test 

Test is intended to check that CEC line is working properly, and DUT can send CEC Wake Up 

command. TE checks that HPD is high and CEC line available and wait for Wake Up message. 

CEC Stand By test 

Test is intended to check that CEC line is working properly, and DUT can send CEC Stand By 

command. TE checks that HPD is high and CEC line available and wait for Stand By message. 

CEC Complete test 

Test is intended to check that CEC line is working properly, and DUT can send sequence of 

commands from Stand By mode. TE checks that HPD is high and CEC line available. TE waiting for 

sequence of commands from DUT Wake UP and then again Stand By. 

 

Note: The default physical address in UCD EDID is 1:0:0:0. In order to simulate a change in the address, 

please use another address range 

 

Note: As a side effect, the CEC will also verify functionality of HPD and EDID reading if the test passes. 
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 R        Vi    T        

Role: Product: 

DP Reference Sink (DP RX) UCD-400 

HDMI Reference Sink (HDMI RX) UCD-422 

DP Alt Mode Reference Sink (DP RX) UCD-424 

Configuration 

 

 

Test timeout: If enabled test will abort when the time has elapsed 

Repeat until timeout:   i  “T       g h” p         

Test length (# frames): Number of captured frames to test 

Errors allowed (# frames): Number of failing frames allowed before test Fails 

Repeat “Sequence Test” until timeout: 
Repeat test sequence until the timeout set (length 

parameter below omitted) 

“Sequence Test” length R p              h  “  q      T   ” 

Expected Video Format Format of the signal expected 

Expected Frame Rate: 
Verify stability of the video signal. Verification 

 i       i  Exp            R    i         “ ” 

Number of captured reference 

frames: 
Number of frames stored as reference 

Capture Reference Frames: Capture reference frames for the test 

Folder to save failed frames: PC folder where failed frames are stored. 

Max number of saved frames: Maximum number of failed frames stored to PC 

Format of saved frames: 
Select saved image format (Binary file, PPM image, 

BMP image) 

Align 12 

12bpc values are be shifted to MSB of a 16bits 

container. If not checked, 12 LSB are used to store 

colour component values. 

Presets: Store and recall settings 
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CRC Based Single Reference Frame Video Test 

The test compares captured frames to a captured reference. In Configure dialog, please select 1 to 

CRC Capture length and click Capture Now. 

TE compares the video mode (Frame Width, Height, BPP and optionally Frame rate) to provided 

parameters and after that captures frames and compares the CRC (check sum) of their three color 

components to the provided reference until the number of bad frame limit provided is detected or the 

provided total number of frames is reached.  

The test is judged FAIL if video mode does not match, or the number of bad frames is exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

• Test Timeout (default 10 000 ms) 

• Total number of frames (default 2 00 ms) 

• Number of bad frames allowed (default 20) 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz, 1/1000 Hz) 

• Frame rate tolerance (mHz, 1/1000 Hz) 

• Reference CRCs (R, G, B) 

CRC Based Single Frame Video Stability Test 

The test verifies that the captured video is stable. 

TE captures a frame and sets the CRC of its color components as reference. After that TE captures 

frames and compares their CRC (check sum) to the reference until the number of bad frame limit 

provided is detected or the provided total number of frames is reached.  

The test is judged FAIL if the number of bad frames is exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

• Test Timeout (default 100 00 ms) 

• Total number of frames (default 200 ms) 

• Number of bad frames allowed (default 20) 
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CRC Based Sequence of Reference Frames Test 

The verifies that a sequence of frames is captured in the right order. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate) to provided 

parameters. After that captures frames to find a frame with matching CRC (check sum) of their three 

color components to the first provided reference. After the first matching CRC is found it compares 

the CRC of the following frames until the Number of frames tested parameter is reached.  

The test is judged FAIL if video mode does not match, the first frame in the list is not found or the 

CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

• Test Timeout (default 10 000 ms) 

• Number of frames to be tested (default 20) 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz, 1/1000 Hz) 

• Frame rate tolerance (mHz, 1/1000 Hz) 

• Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference frame list 

should be different. 

CRC Based Continuous Sequence of Reference Frames Test 

The test verifies that a sequence of frames is captured in the right order many times repeatedly. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate and Color format) 

to provided parameters. After that captures frames to find a frame with matching CRC (check sum) 

of their three color components to the first provided reference. After the first matching CRC is found 

it compares the CRC of the following frames until the Number of frames tested parameter is reached. 

After that it resets the list and starts from the first CRC. The list is repeated until timeout or until the 

provided number of repetitions is reached. 

The test is judged FAIL if video mode does not match, the first frame in the list is not found or the 

CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

• Test Timeout (default 10 000 ms) 

• Number of frames to be tested (default 20) 

• Number of iterations 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz, 1/1000 Hz) 

• Frame rate tolerance (mHz, 1/1000 Hz) 

• Expected color format 

• Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference frame list 

should be different. 
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 ix   L v   Vi    T     

Role: Product: 

DP Reference Sink (DP RX) UCD-400 

HDMI Reference Sink (HDMI RX) UCD-422 

DP Alt Mode Reference Sink (DP RX) UCD-424 

Compare video frame sequence with a single reference 

The test compares captured frames to the provided reference image at the pixel level by buffering 

the indicated number of captured frames first in the local UCD device frame buffer and after that 

downloads them to the PC for evaluation. 

 

The test compares the captured frames to a provided reference image on pixel level.  

• The color component values of each pixel in the captured frame is compared to the 

corresponding pixels in the reference image. 

• If the difference is larger than the provided tolerance, the pixel is considered failed. 

• If the number of failed pixels in a frame is larger than the provided tolerance, the frame is 

considered failed. 

• If the number of failed frames in the test is larger than the provided tolerance, the test is 

considered failed. 

• Failed frames can be stored for evaluation. 
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Browse image: Load reference image from disk 

Image width: Width expected 

Image height: Height expected 

Image format: Image format expected 

Bits per component: Bits per component expected 

Data format align: Video data alignment expected 

Frames count: Number of frames buffered for testing 

Maximum number of failed frames 

allowed per test: 

Number of failed frames allowed totally 

Maximum number of failed frames 

allowed per test: 

Number of failed pixels allowed per buffered frame 

Tolerance between pixel values: The allowed difference between a color component of 

pixel in the captured frame to the reference bitmap. 

Folder to save failed images: PC directory where failed frames are stored. 

Maximum number of exported frames: Maximum number of failed frames stored to PC 

Export format: Format of exported image: Binary file, PPM image,  

BMP image 

Align to  MSB 

12bpc values are be shifted to MSB of a 16bits 

container. If not checked, 12 LSB are used to store 

colour component values. 

Presets: Store and recall settings 

 

Capturing Reference Image 

User can capture received video as reference:  

1. In Settings dialog click the enable live preview icon . 
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2. When the preview has been enabled click the Capture reference icon  to store a frame and use 

it as reference. Before accepting the frame, stability of the video is verified with a CRC stability check. 

Captured CRC can also be verified by the user. 
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Li k     ig T     

Role: Product: 

DP Reference Sink (DP RX) UCD-400 

DP Alt Mode Reference Sink (DP RX) UCD-424 

Link Training at All Supported Lane Counts and Link Rates 

Test requests link training on all supported lane counts and link rates. Each link training must be 

successfully completed in order to pass the test. 

In Configure, please define the parameters for the test. 

Parameters in use 

• Test Timeout (default 5 000 ms) 

• Max lane count supported by DUT (default 4) 

• Max lane rate supported by DUT 

• Long HPD pulse duration (default 1 000 ms) 

• Link training start timeout (default 5 000 ms) 

• Delay between test cycles (default 3 000 ms) 
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VRR          T T     –      Rx 

Role: Product: 

HDMI Reference Sink (HDMI RX) UCD-422 

Configure 

VRR Max value: Maximum VRR frame rate 

VRR Min value: Minimum VRR frame rate 

VRR Static value: Static VRR frame rate 

VRR Step value: Change of current VRR value during a test 

VRR Time step value: Change of current VRR value during a test 

VRR Enable and M_Const: Click to open dialog for enabling VRR Enable and 

M_CONST 

VFront value: Click to open dialog for enabling Base VFront and RB 

Base Refresh Rate: Set Base Refresh Rate 

VRR Static Test 

Test verifies that DUT Source applies expected static VRR value. 

After configuring the parameters operator starts the test. Test waits until DUT Source starts VRR 

mode. When VRR mode is detected, test verifies that received timing matches the VRR Value 

parameter and the data in received EMP packets match the timing. 

Quick Media Switching (QMS) Test 

Verify that VRR is set correctly when frame rate is changing with a set time interval. For example, 

change VRR from 30 to 60 Hz with step for each 1 second. 

After configuring the parameters operator starts the test. Test waits until DUT Source starts VRR 

mode. When VRR mode is detected, test verifies that VRR is changed after each time interval set by 

VRR Time parameter, and the applied VRR change is as set in the parameter. Test also verifies that 

data in received EMP packets match with applied VRR. 

VRR Dynamic Test 

Verify that VRR is set correctly when frame rate is changing with each frame. For example, change 

VRR from 60 to 120 Hz with step 1 each frame. 

After configuring the parameters operator starts the test. Test waits until DUT Source starts VRR 

mode. When VRR mode is detected, test verifies that VRR is changed between each frame. Test also 

verifies that data in received EMP packets match with applied VRR. 
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VRR  i k   T T     –      Tx 

Role: Product: 

HDMI Reference Source (HDMI TX) UCD-422, UCD-412, UCD-452 

Configure 

 

VRR Max value: Maximum VRR frame rate 

VRR Min value: Minimum VRR frame rate 

VRR Static value: Static VRR frame rate 

VRR Step value: Change of current VRR value during a test 

VRR Time step value: Change of current VRR value during a test 

VRR Enable and M_Const: Click to open dialog for enabling VRR Enable and 

M_CONST 

VFront value: Click to open dialog for enabling Base VFront and RB 

Base Refresh Rate: Set Base Refresh Rate 

Static VRR Test 

Test verifies that DUT Sink correctly applies a static VRR value. 

After configuring the parameters operator starts the test. Operator verifies that DUT Sink has applied 

VRR correctly and provides the information in the dialog of the test. 

Quick Media Switching (QMS) Test 

Verify that VRR is set correctly when frame rate is changing with a set time interval. For example, 

change VRR from 30 to 60 Hz with step 1 each 1 second. 

After configuring the parameters operator starts the test. Operator verifies that DUT Sink has applied 

VRR correctly and frame rate is changing as expected. Operator provides the information in the dialog 

of the test. 

Dynamic Test 

Verify that VRR is set correctly when frame rate is changing with each frame. For example, change 

VRR from 60 to 120 Hz with step 1 each frame. 

After configuring the parameters operator starts the test. Operator verifies that DUT Sink has applied 

VRR correctly and frame rate is changing as expected. Operator provides the information in the dialog 

of the test. 
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      T    

Role: Product: 

HDMI Reference Source (HDMI TX) UCD-422 

 

Cable Check Test 

 

Test is intended to check that cable can be properly used with UCD-422. Cable should be connected 

in loopback mode. 

 

Test tries to pass Link training on different rates. If errors are presented on the lanes, then TE applies 

different FFE level to find configuration where is the best quality (minimum of errors). 

If Link training can be done without errors on all link rates then cable quilified as acceptable for usage 

with UCD-422. 

 

Configure 

 

 

 

Test timeout, in seconds: Timelimit for the test 

Cable test mode: High speed can include detection errors on the high 

speed lanes. Low speed - detect that i2c and ddc lanes 

are working properly. All modes checks both High 

speed and low speed. 

Minimum FRL rate: Determine minimum of range for detection of cable 

quility 

Maxmum FRL rate: Determine maximum of range for detection of cable 

quility 

Treshold of allowed errors per lane: Determine allowed number of errors 

Timeout for capturing errors, in 

seconds: 

Determine period for screening errors 

Low speed line select: Configure witch lines of Low speed will be checked. 
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APPENDIX F: VTP PATTERN LANGUAGE 

General 
The Vpattern definition language (in the following simply “VTP”) is a straightforward yet flexible way 

of describing test patterns for UCD Generators. This description is providing an introduction and 

examples of the most usable instructions and parameters.  

The VTP language uses text command syntax. Each row represents one drawing instruction. The 

coordinate system can be either absolute or scaled. In the absolute mode the actual pixel position is 

referred while in the scaled mode the coordinates refer to the “Drawing resolution” used while 

drawing. For both absolute and scaling coordinates the origin is the upper left hand corner of the 

screen. 

Terminology 

The following terms are used in this document: 

Coordinate system: two numerical ranges of integer, positive numbers. E.g. {0,799},{0,599} or 

{0,10000},{0,10000}. 

Coordinates: a tuple of integer, positive numbers used to address a position on an image, e.g. 

(100,250). The first number is the horizontal position, the second one the vertical position. The actual 

position is always related to the coordinate system currently in use. 

Drawing resolution: the width and height of the space that can be used for drawing, expressed in 

pixels. E.g., 2560 by 1600. 

Drawing area: a 2-dimensional area spanning all of the drawing resolution, expressed in the current 

coordinate system notation. E.g., if the drawing resolution is 800 x 600 pixels, the drawing area 

includes all points (x,y) where x = 0 to 799 and y = 0 to 599 in ABSOLUTE mode or x = 0 to 10000 

and y = 0 to 10000 in SCALED mode. 

Notation 

The following notation is used in this document: 

• A token is enclosed by characters ‘<’ and ‘>’. For instance, <variable> represents a generic 

variable. 

• Different legal choices for a command parameter are separated by character ‘|’. For instance, 

<variable> | <number> means that either variable or number can be used as parameters. 

• Items that can be repeated  , 1 or more times are preceded by ‘{‘ and followed by ‘}*’. For 

instance {<number>}* means zero, one or more occurrences of a number.  

Syntax rules 

The following general syntax rules apply to VTP language files: 

• The VTP is a text-based, interpreted language. 

• Commands, variables, and constant names are not case-sensitive. 

• All text to the right of a semicolon (‘;’) is treated as a comment. 

• All strings are delimited by quotation marks (“a string”).  

• Quotation mark and backslash characters must be prefixed by a backslash character 

(a quotation mark character = \”) (a backslash character = \\). 

• Filenames cannot contain pathnames. 
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Commands 

Scaling commands 

All drawing commands using coordinates can refer either to absolute or scaled coordinates. The 

absolute coordinate system starts at 0 and its measurement unit is the pixel (vertically the line). It 

extends up to the maximum drawing resolution in use minus one, expressed in pixels too. 

Conversely, the scaled coordinate system ranges from 0 to 10000, independently from the drawing 

resolution. Its measurement unit is thus a flexible, virtual pixel. 

Absolute coordinates provide the fastest drawing speed, but they are resolution specific. Scaled 

coordinates are resolution independent while introducing a slight speed penalization. 

For both systems, the origin (0,0) refers to the upper left hand corner of the screen. 

ABSOLUTE 

Syntax: ABSOLUTE 

This command is normally used in the beginning of the VTP file. All drawing commands issued after 

ABSOLUTE will have absolute coordinate values, i.e., their coordinates will be interpreted as pixels 

and lines.  

The allowed coordinate values are from 0 to the maximum drawing resolution minus one. For 

instance, for a drawing resolution of 2560 x 1600 pixels, the allowed coordinate range (x,y) for x is 0 

to 2559 and for y 0 to 1599. 

Constants MAXX and MAXY can be used in place of the numeric values to achieve basic scaling 

capabilities.  

SCALED 

Syntax: SCALED 

All drawing commands issued after the SCALED command will have their coordinates interpreted as 

within a range from 0 to 10000 (10001 possible coordinate values), regardless of the current drawing 

resolution. Positioning can be calculated as percentages. If you wanted to address a point at 50% of 

the drawing resolution, then you would use the number 5000. If you wanted 75% you would simply 

use the 7500. 
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Graphics Drawing Commands 

All of the following graphics drawing commands use the currently selected foreground color for shape 

perimeter and filling. 

LINE 

Syntax: LINE x1 y1 x2 y2 

Draws a line from point (x1,y1) to point (x2,y2). 

Example: 

You can draw a white diagonal cross using either ABSOLUTE and SCALED coordinate mode and get 

the same result. 

ABSOLUTE ; Set scaling mode to absolute 

COLORDEPTH 8 ; 8 bits per color 

COLORRGB 255 255 255 ; white 

LINE 0 0 MAXX MAXY ; Draw a line from upper left to lower right corner 

LINE 0 MAXY MAXX 0 ; Draw a line from lower left to upper right corner  

Or if you want a fixed size for 640 x 480 resolution 

LINE 0 0 639 479 

LINE 0 479 639 0 

 

The pattern will look like this:  

Using SCALED instead of ABSOLUTE. 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

LINE 0 0 10000 10000 

LINE 0 10000 10000 0 

BOX 

Syntax: BOX x1 y1 x2 y2 

Draws a filled rectangle with upper left corner (x1,y1) and lower right corner (x2,y2). 

Example: 

This code will create a full white screen with all resolutions. 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

BOX 0 0 10000 10000 

  

(0,0) (MAXX,0) 

(MAXX,MAXY) (0,MAXY) 
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DOT 

Syntax: DOT x y 

Draws a single dot at location (x,y). 

FILL 

Syntax FILL x y 

Initiates a flood fill (or seed fill) with foreground color starting from position (x,y).  

CIRCLE 

Syntax: CIRCLE x y r 

Draws a circle with center point at (x,y) and radius r. Please, note that when using SCALED 

coordinates radius r is expressed using reference to vertical maximum. 

Example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

CIRCLE 5000 5000 2500 

The pattern will look like this:  

FCIRCLE 

Syntax: FCIRCLE x y r 

Draws a circle with center point at (x,y) and radius r. Filled with foreground color. Please, note that 

when using SCALED coordinates radius r is expressed using reference to vertical maximum. 

The pattern will look like this: 
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ELLIPSE 

Syntax: ELLIPSE x y hr vr 

Draws an ellipse with center point at (x,y), horizontal radius hr and vertical radius vr. 

You can use ELLIPSE instead of CIRCLE for example for compensating the stretching in applications 

where the displayed pixel is not square. 

Example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

ELLIPSE 5000 5000 3000 4000 

The pattern will look like this: 

Text Drawing Commands 

All of the following commands use the currently selected foreground color for the “foreground” pixels 

of the font and the currently selected background color for “background” pixels. 

TEXTPOS 

Syntax: TEXTPOS x y 

Sets the text drawing position to point (x,y).  

TEXT 

Syntax: TEXT <string> | <var> | <const> { <string> | <var> | <const> }* 

The command executes a CR and LF (carriage return and line feed) and then draws a text string 

<string>, a variable <var>, a constant <const> or a combination of them starting from the current text 

position.  

<string> parameter is a quoted sequence of characters. If the string contains a quote character (“) or 

a backslash character (\) then it must be preceded with a back slash character (\). 

<var> is a parameter variable (A – Z, MAXX, MAXY) defined by SET command. 

<const> one of the Timing Variables. Timing variables are defined by currently loaded timing 

parameters. Please refer to Chapter 3. 

 

Example: 

ABSOLUTE 

COLORDEPTH 8 

COLORRGB 255 255 255 

TEXTPOS 100 100  ; Text starting point 100 pixels from left edge and  

 ; 100 display lines down from top 

TEXT “HRES=” HR “ PIXELS” ; This will draw the text HRES then the value of variable HR  

; and PIXELS 

TEXT “Quote character \” and backslash \\” 
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Program Flow Commands 

REPEAT 

Syntax: REPEAT <variable> a b s 

All commands after between REPEAT and END command are repeated the number of times defined 

by <variable>. <variable> is set to value a before starting the first iteration loop. At the end of each 

iteration, variable is incremented by s (variable = variable + s). The REPEAT is terminated when 

variable reaches or exceeds value b, and the execution continues from the command following the 

END command. For example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

REPEAT W 0 10000 200 

LINE W 0 W 10000 

END 

A maximum of 2 REPEAT loops can be nested (placed inside each other). 

END 

Syntax: END 

This command follows a REPEAT command and defines a group of instructions to be repeated. 
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Color Commands 

The user can assign the used colors in two basic ways: either by giving the actual Red, Green and 

Blue (or R, G and B) color component values or using pre-defined color palettes. The first method is 

referred as True Color Mode and the latter as Palette Mode. 

In True Color Mode the numerical values given for R, G and B will be the actual output signal intensity 

values for the pixel in question. The numerical color value in Palette Mode will act as an address (or 

index) to a pre-defined color in a 256 color table. The output signal intensity will be the R, G and B 

value entry in the cell where the address points to. 

Palette mode can only be used with True Color Mode is . 

COLORDEPTH 

Syntax: COLORDEPTH n 

The command is used in True Color Mode (COLORMODE 2), to define the number of bits used for 

each color component (R, G and B) of the data to be displayed. Possible values for the parameter n 

are 6, 8, 10 and 12. If COLORDEPTH command is not used, 10 bits per color is used.  

Example: To display a bitmap that uses 8 bits for r, g and b (24-bit colors) you have to use 

COLORDEPTH 8.  

Command Nr of color bits Range of values for R, G and B 

COLORDEPTH 6 18 0 to 63 

COLORDEPTH 8 24 0 to 255 

COLORDEPTH 10 30 0 to 1023 

COLORDEPTH 12 36 0 to 4095 

 

COLORDEPTH can be used only once in a VTP file, and it has to be placed before all drawing 

instructions it is supposed to affect. 

COLORRGB 

Syntax: COLORRGB r g b 

The command defines the foreground color used for the following drawing commands. The command 

is used in True Color Mode only. 

The range of values for r, g and b depends on the bits per color used. If not changed with 

COLORDEPTH command, 10 bits per color is used. Please refer to COLORDEPTH command for 

range of values. 

Various Commands 

SET 

Syntax: SET <variable> n 

Assigns value n to programming variable called variable. n must be a positive number or zero. 
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Variables 

Timing Variables 

 

Timing Variable Value name 

HF  Drawing resolution horizontal size minus one 

HP  Drawing resolution vertical size minus one 

HR  Current timing horizontal frequency (MHz?) 

HA  Current timing horizontal period (pixels) 

HS  Current timing horizontal resolution (pixels) 

HBP  Current timing horizontal active time (pixels) 

HFP  Current timing horizontal sync length (pixels) 

VF  Current timing horizontal back porch length (pixels) 

VP  Current timing horizontal front porch length (pixels) 

VR  Current timing vertical frequency (MHz?) 

VA  Current timing vertical period (lines) 

VS  Current timing vertical resolution (lines) 

VBP  Current timing vertical active time (lines) 

VFP  Current timing vertical sync length (lines) 

PF  Current timing vertical back porch length (lines) 

HLB  Current timing vertical front porch length (lines) 

HRB  Pixel frequency (Mpps?) 

VTB Drawing resolution horizontal size minus one 

VBB  Drawing resolution vertical size minus one 

 

Expressions 

Any command numeric parameter can be replaced by an expression, according to the syntax below: 

<term> ::= <variable> | <constant> | <number> 

<expression> ::= <term> { ‘+’ | ‘-‘ | ‘*’ | ‘/’ | ‘%’ }  <term> 

<parameter> ::= <term> | <expression> 

Some example of legal parameter values: 

B 

MAXX 

342 

B + MAXX 

B / 2 

B * C 

Expressions have always positive integers or zero value. When an expression evaluates to a negative 

value, it is set automatically to zero. Number values are also always positive integers or zero. 
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Assignments 

A variable can be assigned a numerical value by using the SET command. 

The second parameter of the SET command can be replaced by an expression thus allowing 

commands like those here below: 

SET C B+MAXX 

SET K K+1 

SET K A+B 

Default state at VTP execution startup 

 

Coordinate system: ABSOLUTE 

Foreground color: 1023 1023 1023 

Background color: 0 0 0 

Image: Output image is cleared (all black) 

Variables: All variables are initialized to zero 

Color depth: COLORDEPTH 10 
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APPENDIX G: FIRMWARE UPDATE WITH QUARTUS 
The chapter below describes a procedure for updating UCD-4XX Series Firmware when the normal 

FW Update procedure fails. 

Note The firmware recovery procedure is only available for Windows operating system. 

Downloading Tools 
The Recovery patch is programmed to UCD Device with a separate tool called  

Intel® Quartus® Prime Lite Edition Design Software Version 18.1 for Windows. The tool can be 

downloaded from the Intel® FPGA website: 

https://www.intel.com/content/www/us/en/software-kit/665990/intel-quartus-prime-lite-edition-

design-software-version-18-1-for-windows.html 

1. On the download page, please select section “Individual Files”. Please download the software 

under “Intel® Quartus® Prime (includes Nios® II EDS)”. 

2. Please download and install the tool using defaults on the PC. 

 

 

Step 1 
1. Connect the UCD device to the power supply and switch on power.  

2. Connect the UCD device with a USB cable to the PC through USB connector (Please refer to 

chapter Product Description > Connections earlier in this document). 

3. Please locate the UCD-4xx_recovery.zip file. By default the file is at C:\Program 

Files\Unigraf\Unigraf UCD Tools\recovery. 

https://www.intel.com/content/www/us/en/software-kit/665990/intel-quartus-prime-lite-edition-design-software-version-18-1-for-windows.html
https://www.intel.com/content/www/us/en/software-kit/665990/intel-quartus-prime-lite-edition-design-software-version-18-1-for-windows.html
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4. Extract the content of the ZIP file in a folder on your PC (e.g., C:\Temp). 

5. Open Windows Command Prompt application. 

6. Navigate to the directory to where the ZIP file was extracted (e.g. cd \Temp). 

7. Connect a micro-USB cable to the JTAG connector on the UCD device (Please refer to chapter 

Product Description > Connections earlier in this document). 

8. In the directory where the ZIP file was extrected (e.g. c:\Temp) please edit file recovery.bat 

9. On line three, the parameter “QUARTUS_DIR” is set to point to the folder where the Qartus 

Programmer was installed (by default C:\intelFPGA_lite\18.1). Edit and save as needed. 

10. In the  Command Prompt application make sure that the current directory is still the same (e.g. 

C:\temp). 

11. Launch batch recovery.bat by typing “recovery.bat” at the prompt. 

12. Please wait until the batch file has been completed (may take up to several minutes). 

Step 2 
Perform FW update procedure as described in section Installation > Firmware Update Procedure 

earlier in this manual. 

After Recovery procedure has completed, you can delete the files (in e.g., C:\Temp). 

 



  Appendix H: Playlists and Scenarios 

UCD-4XX User Manual • UCD Console 3.6 254 

APPENDIX H: PLAYLISTS AND SCENARIOS 
 UCD Console’s Playback enables you to run scripts called playlists. Use playlists to stream video, 

audio and metadata. See the Unigraf UCD Console Playback Tutorial at 

www.unigraf.fi/resource/tutorial-run-edit-and-create-sdr-and-hdr-scenarios-with-unigrafs-playback-

tool/ 

Playlist 

A Playlist is a text script consisting of a [Device] block and [Scenario] block(s). A [Device] block lists 

the serial number of the device and connectortype (such as a displayport transmitter). [Scenarios] 

blocks have a caption (which are used to display sample content), a period (Scenario duration in 

milliseconds) and a relative path to a script text file (ex. Scenario_PSR1_Entry_N.txt). Scenarios are 

played in sequence. 

Scenario 

A scenario is a script text file to specify a sequence of video frames, metadata packets and audio to 

be transmitted. 

Frame Memory 

Before transmission content is loaded to frame memory buffer of the UCD device. Frame buffer 

memory limits content (number of frames) that can be played. UCD-5XX devices by default feature 

16 gigabytes of memory. This enables loading up to 320 4K or 80 8K video frames. Contact Unigraf 

for information for larger frame buffer sizes.  

Sample Content 

You can us sample content as a basis for creating custom test sequences: see UCD Console Playback 

tab. Sample content is stored by default (on Windows) at C:\Program Files\Unigraf\Unigraf UCD 

Tools\Resources\playback\content. See Sample Content in Playback in this Appendix. 

  

https://unigraf.sharepoint.com/sites/Products/Jaetut%20asiakirjat/General/User%20Manuals%203.5/www.unigraf.fi/resource/tutorial-run-edit-and-create-sdr-and-hdr-scenarios-with-unigrafs-playback-tool
https://unigraf.sharepoint.com/sites/Products/Jaetut%20asiakirjat/General/User%20Manuals%203.5/www.unigraf.fi/resource/tutorial-run-edit-and-create-sdr-and-hdr-scenarios-with-unigrafs-playback-tool
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A playlist defines the UCD device to be used and the output destination for transmission. It lists 

scenarios the played (video and audio sequences including metadata) to be transmitted and their 

duration. 

Note: Playlists and Scenarios are technology dependent. Metadata (or packets) differ for HDMI and 

DisplayPort. 

Device block  

Section describes what device and what output connector to use. 

Key  Description  Possible values  

[Device] Required. Start of the Device block.  

serialnumber  Required. Specifies serial number of the UCD device.  

Th  ‘*’ wi                   i     y                

device is connected to the PC.  

‘*’  

‘1722    ’  

connectortype  Required. Specifies output connector type to be used. 

Playlists shall not contain scenarios for different 

connector types.  

‘        ’  

‘ i p  y        ’  

‘        ’  

reset  Only applies to UCD-323.  

Scenario block  

Section describes selected scenario and its playback parameters. Playlist runs scenarios in the order 

they are listed. 

Key  Description  Possible values  

[Scenario] Required. Start of a Scenario block. Playlists can have 

multiple Scenario blocks. 

 

caption  

 

Optional. Title. Any character string accepted. ‘      i  1’  

path  Required. Specifies relative path to scenario file.  Any valid path  

period  Required. Duration of Scenario in msec. The duration 

is ignored if close-after- p     i         ‘1’   

‘6    ’  

‘5   ’  

close-after-upload   p i      Wh          ‘1’,          i   v   i      

the Playback tool will exit after loading scenario 

content and starting playback.  

‘ ’    ‘1’  

        ‘ ’ 

execute-after-upload  

 

Optional. Executes provided command in cmd.exe or 

bash and waits for its completion. Calculation of 

‘p  i  ’               h          i   x        

‘   ip          i ’  

‘   i  

 h              ’  

prompt Optional. Prompt text. Launches a dialog with prompt 

text and Ok and Abort buttons: 

‘R      vi    wi h 

camera and click 

OK or Abort’ 
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A Scenario is text file for specifying a specific sequence of video frames, events (packets) and audio 

to be played in order. Scenarios also set up the device state for transmission.  

Parameters 
Scenario parameters are defined below. items. 

Scenario item Description 

video Path and file name format of video frame files 

audio Path and file name of the audio file 

packets Path and file name format of metadata packet files 

porder Content Playing Order. Please see Content Playing Order below. 

mappin  

align1  Alignment of 12-bit binary pixel data. ‘1’ aligned to LSB; ‘ ’   ig            

audioswap ‘1’     Li     E  i      i     p    

audiocompressed ‘1’ compressed audio; ‘0’ uncompressed audio 

audiosampling Audio sampling rate. E.g., 44100 

audiochannels Nr. of audio channels 

audiobits Audio bits per sample (usually 16 or 24) 

scrambler  ‘1’ scrambling enabled; ‘0’ scrambling disabled 

audiosync Audio sync  

colorspace Video color space: RGB; YUV444; YUV422; YUV420 

bitspercolor  Video color depth (bits per color) 

timing.hactive Timing: Horizontal active 

timing.vactive Timing: Vertical active 

timing.htotal Timing: Horizontal total 

timing.vtotal Timing: Vertical total 

timing.hstart Timing: Horizontal start 

timing.vstart Timing: Vertical start 

timing.hsync Timing: Horizontal sync width 

timing.vsync Timing: Vertical sync width 

timing.frate Timing: frame rate 

hdcp  HDCP version used (       1 4 2      ‘    ’) 

loadingRGB 
The R, G and B color components of solid color pattern shown when content is 

being uploaded to the device before playback (e.g., 0,0,0) 

linkRate 

Default link rate.  

HDMI: 0 = TMDS; 1 – 5 = FRL with 3, 6, 8, 10 and 12 Gbps link rate. 

DP: Link rate = Value × 0.27 Gbps. (E.g., 20 = 5.4 Gbps/lane (HBR2)). 

linkRateMin Minimum link rate desired. Scenario will fail if not achieved 

DSC timing 

parameters 

 

Parameters are different for DP and HDMI. See below. 
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DSC Timing parameters for HDMI 

dscFrameRate DSC Timing: Frame rate [fps] × 1000 

dscHcactive DSC Timing: Horizontal active 

dscHcblank DSC Timing: Horizontal blank 

dscVtotal DSC Timing: Vertical total 

dscVsync DSC Timing: Vertical sync 

dscVstart DSC Timing: Vertical start 

dscVactive DSC Timing: Vertical active 

 

DSC Timing parameters for DP 

dscFrameRate DSC Timing: Frame rate [fps] × 1000 

dscVtotal DSC Timing: Vertical total 

dscVsync DSC Timing: Vertical sync 

dscVstart DSC Timing: Vertical start 

dscVactive DSC Timing: Vertical active 

dscHtotal DSC Timing: Horizontal total 

dscHsync DSC Timing: Horizontal sync 

dscHstart DSC Timing: Horizontal start 

dscHactive DSC Timing: Horizontal active 
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Content Playing Order 

Play order is a sequence of steps. Steps are delimited with semicolons (;).  

Each step has:  

Range (possibly numbered e.g. allm_000.jpg, allm_001.jpg, …) of video frame(s)  

How many times the frame(s) are played 

Packet(s) (possibly numbered e.g. allm_0.bin, allm_1.bin, …) indices to be sent during the video 

frame(s) transmission  

Color format 

Optional frame rate when VRR/Adaptive-Sync is enabled 

Format 

Each scenario step is of the form : 

pV:R:E:FvXX; 

Parameters  

Please see table below for description of used parameters. 

Сh    Description  Possible 

values  

Examples  

:  Separator between step parameters.  ‘:’  See below 

;  Step delimiter. ‘;’  See below  

p  Optional. Indicates assertion of a HPD pulse on  

HDMI RX connector of UCD device during current step.  

Preceding video frame index. Only for HDMI playback.  

‘p’  ‘p1:6 :1:256;’  

‘p -59:6 :1:256;’  

V  Required. Video frame indices (zero based). Parameters 

are applied to all frames in the step. Images (possibly 

numbered) are loaded from the video file path. 

‘1’ 

‘1,2,5’  

‘ -59’  

‘1:6 :16:256;’ 

 ‘1,2,5:6 :16:256;’ 

‘ -59:6 :16:256;’  

R  Required. Repetitions of current step.  

For example, ‘1’ wi h 6                        h   

current step will be played only for 1/60 of a second.  

‘  ’  

‘1’  

‘1:  :16:256;’  

‘1:1:16:256;’  

E  Optional. Metadata packet indices (zero based): A single 

packet or a comma separated list of packets. 

The index may be of the form 3l15 (  w        ‘ ’)    

At which vertical line do we want to put our packet in. 

3l15 means insert packet 3 at line 15. 

Packets are loaded from the packets path. 

‘ ’  

‘4,1,29’  

none  

3l15 

‘1:  : :256;’  

‘1:  :4,1,29:256;’  

‘1:  ::256;’ 

0:10000:3l15:256;  

F  Required. Color format and color depth.  

See Color Format below.  

‘256’  

‘51 ’  

‘1:  : :256;’ 

‘1:  : :51 ;’  

vXX  Optional. Control of frame rate when VRR/Adaptive-Sync 

is enabled. To enable VRR/Adaptive-Sync, the 

corresponding HDMI VSIF event must be included. The 

parameter is in the      ‘vXX’, wh    ‘XX’ is the frame 

rate. 

‘v6 ’  

‘v  ’  

‘1:  : :256v6 ;’  

‘1:  : :256v  ;’  
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Color Format  

Color format is a two-byte value presented in decimal. The lower byte provides an index to used color 

space and the higher byte an index to the color depth. Please find the indexes in the table below. 

Index Color Depth  

(bits/color) 

Color Space 

0 6 RGB 

1 8 YCbCr 4:4:4 

2 10 YCbCr 4:2:2 

3 12 YCbCr 4:2:0 

4 16 – 

 

The parameter value is encoded as follows:  

[Color Depth] × 256 + [Color Space],  

where [Color Depth] and [Color Space] are indexes obtained from the table above. 

For example, parameter for YCbCr 4:4:4, 10 bits is ( 2 × 256 + 1 ) = 513.  

Pre-calculated values for available color formats are shown below: 

 6 BPC 8 BPC 10 BPC 12 BPC 16 BPC 

RGB  0 256 512 768 1024 

YCbCr 4:4:4  N/A 257 513 769 1025 

YCbCr 4:2:2  N/A 258 514 770 1026 

YCbCr 4:2:0  N/A 259 515 771 1027 
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Example 
Please find below description of Playlist SDR-HDR-HLG – HDMI. 

Playlist file (Playlist SDR-HDR-HLG - HDMI.txt) 

Playlist item and example content Description 

[Device] Start of device section 

serialnumber=* Only one UCD device present. 

connectortype=HDMI Out HDMI output 

[Scenario] Start of Scenario 1 

caption = SDR       i   i    “  R” 

period = 10000 Duration 10 sec 

path = Scenario_SDR_HDMI.txt Scenario file: Scenario_SDR_HDMI.txt in current folder 

[Scenario] Start of Scenario 2 

caption = HDR       i   i    “  R” 

period = 10000 Duration 10 sec 

path = Scenario_HDR_HDMI.txt Scenario file: Scenario_HDR_HDMI.txt in current folder 

[Scenario] Start of Scenario 3 

caption = HLG       i   i    “ L ” 

period = 10000 Duration 10 sec 

path = Scenario_HLG_HDMI.txt Scenario file: Scenario_HLG_HDMI.txt in current folder 

[Scenario] Start of Scenario 4 

caption = SDR – HDR       i   i    “  R –   R” 

period = 10000 Duration 10 sec 

path = Scenario_SDR-HDR_HDMI.txt Scenario file: Scenario_SDR-HDR_HDMI.txt in current folder 

[Scenario] Start of Scenario 5 

caption = SDR – HLG       i   i    “  R –  L ” 

period = 10000 Duration 10 sec 

path = Scenario_HDR_HDMI.txt Scenario file: Scenario_SDR-HLG_HDMI.txt in current folder 
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Scenario File (Scenario_SDR-HDR-HDMI.txt) 

Scenario item and example content Description 

video=goldenGate0.jpg Video files in current folder, file name format goldenGate0.jpg 

( …) 

audio=<Audio not selected> Audio not selected 

packets=HDMI\Infoframes_0000.bin Packet files in folder HDMI\, file name format 

          _      i  ( …) 

porder=0:180:2:256;1:180:2,0:256; 180 frames of image index 0, Packet index 2, RGB 8 bpc 

180 frames of image index 1, Packets index 2 and 0, RGB 8 bpc 

align12=1 Pixel data is aligned to LSB 

audioswap=0 - 

audiocompressed=0 - 

audiosampling=0 - 

audiochannels=0 - 

audiobits=0 - 

scrambler=0 scrambling disabled 

colorspace=RGB444 Video color space: RGB 4:4:4 

bitspercolor=8 Video color depth: 8 (bpc) 

timing.hactive=1920 Timing: Horizontal active 

timing.vactive=1080 Timing: Vertical active 

timing.htotal=2200 Timing: Horizontal total 

timing.vtotal=1125 Timing: Vertical total 

timing.hstart=192 Timing: Horizontal start 

timing.vstart=41 Timing: Vertical start 

timing.hsync=44 Timing: Horizontal sync width 

timing.vsync=5 Timing: Vertical sync width 

timing.frate=60000 Timing: Frame rate 60 fps 

hdcp=none HDCP not enabled 

loadingRGB=52,127,150 Solid color pattern shown when content is being uploaded to the 

device before playback is R=52, G=127, B=150. 
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Use UCD Console’s Playback examples to create custom test content. On Windows, examples can 

typically be found at C:\Program Files\Unigraf\Unigraf UCD Tools\Resources\playback\content. 

Note: Playlists and Scenarios are interface technology dependent.  

The provided examples are different for HDMI and DisplayPort. 

Provided examples include: 

HDMI 

 Playlist Name Description 

Basic Video & Audio Example Example playlist for demonstrating the use of video and audio files. 

VRR Example 
Playlist for demonstrating Variable Refresh Rate (VRR) capability of 

a DUT monitor. 

QMS-VRR Example  
Playlist for demonstrating Quick Media Switching VRR (QMS-VRR)  

capability of a DUT monitor. 

ALLM  
Playlist for demonstrating Auto Low-latency Mode (ALLM) 

capability of a DUT monitor 

HDR & Metadata Example Example playlist that demonstrates the use of video files and 

metadata packets in testing a DUT monitor 

 

DP 

Playlist Name Description 

Basic Video & Audio Example Example playlist for demonstrating the use of video and audio files. 

HDR & Metadata Example 
Example playlist that demonstrates the use of video files and 

metadata packets in testing a DUT monitor 

Frame Rate Example 
Playlist for demonstrating use of multiple frame rates with FHD and 

UHD resolution. 
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Playlist: Basic Video & Audio Example 
The playlist transmits video and audio as described below. 

Video 

Frames used for Scenario 1 and Scenario 2 (Image1.jpg, Image 2.jpg) 

Frame used for Scenario 3 and Scenario 4 (Philips.svg) 

Description of Scenarios 

 Name Duration Repeated sequence 

1 
Flip-flop with LPCM 

Audio 
60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC,  

60 frames Image1.jpg, 60 frames Image2.jpg,  

Audio: Rhythm.wav 

2 
Flip-flop with AC3 

Audio 
60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC,  

60 frames Image1.jpg, 60 frames Image2.jpg,  

Audio: 

44100Hz_16bit_AC3_2channels_60sec_sine.iec61937.bin 

3 Flip-flop Silent 60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, 

60 frames Image1.jpg, 60 frames Image2.jpg,  

No Audio. 

4 
Philips 1920x1080p + 

1kHz 
60 s 

CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, 

60 Frames Philips.svg, 

Audio: 1 kHz sine wave (1kHz.wav) 

5 
Philips 3840x2160p + 

1kHz 
60 s 

CTA 3840 x 2160 @ 60Hz (VIC 97), RGB 8 BPC 

60 Frames Philips.svg, 

Audio: 1 kHz sine wave (1kHz.wav) 
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Playlist: HDR & Metadata Example 
Example demonstrates the use of metadata packets. 

Video: 

The Scenarios use four versions of the same image: GoldenGate0.jpg, GoldenGate1.jpg, 

GoldenGate2.jpg and GoldenGate3.jpg. 

All four images use the same dynamic range in pixel data but contain a text label indicating pixel 

dynamic range applied in the metadata. If DUT behaves correctly, applying different metadata 

changes the appearance of the image on DUT screen.  

Scenarios for HDMI Output 

Video mode in all steps: CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, No audio. 

Name Duration Repeated sequence 

SDR 10 sec 180 frames GoldenGate0.jpg, Packet: Infoframes_0002; 

HDR 10 sec 
180 frames GoldenGate1.jpg, Packets: Infoframes_0002, 

Infoframes_0000 

HLG 10 sec 
180 frames GoldenGate2.jpg, Packets: Infoframes_0001, 

Infoframes_0002 

HDR10+ 10 sec 
180 frames GoldenGate3.jpg, Packets: Infoframes_0002, 

Infoframes_0003, Infoframes_0000 

SDR – HDR 10 sec 

180 frames GoldenGate0.jpg, Packets: Infoframes_0002; 

180 frames GoldenGate1.jpg, Packets: Infoframes_0002, 

Infoframes_0000 

SDR – HLG 10 sec 

180 frames GoldenGate0.jpg, Packet: – ; 

180 frames GoldenGate2.jpg, Packets: Packets: Infoframes_0001, 

Infoframes_0002 

SDR – HDR10+ 10 sec 

180 frames GoldenGate0.jpg, Packet: Infoframes_0002; 

180 frames GoldenGate3.jpg, Packets: Infoframes_0002, 

Infoframes_0003, Infoframes_0000 
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Playlist: VRR Example (HDMI) 
Playlist demonstrates controlling VRR (Variable Refresh Rate) in Scenarios when using HDMI output. 

Video 

The image used for the test contains a combination of color bars, gray scales, and rotating items. The 

test uses a sequence of images creating a full rotation in 60 frames. 
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Scenario with Video Mode 1920×1080 60 Hz 

The scenario uses 1920×1080 59.94/60 Hz video timing (VIC 16). No audio. 

 Name Duration Repeated sequence 

1 
FHD VRR 48..59 

switch 
60 s 

VRR enabled. RGB 8 BPC. Packets: infoframe_00, 

infoframe_01 

300 frames with 48 Hz frame rate,  

300 frames with 59 Hz frame rate. 

 

 

                Scenario with Video Mode 3840×2160 60 Hz 

The scenario uses 3840×2160 59.94/60 video timing (VIC 97). No audio. 

 Name Duration Repeated sequence 

1 
UHD VRR 48..59 

switch 
60 s 

VRR enabled. RGB 8 BPC.  

Packets: infoframe_00, infoframe_02 

300 frames with 48 Hz frame rate,  

300 frames with 59 Hz frame rate. 
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Playlist: Frame Rate Example (DP) 
Playlist for demonstrating use of multiple frame rates with FHD and UHD resolution when using 

DisplayPort output.  

Video 

The image used for the test contains a combination of color bars, gray scales, and rotating items. The 

test uses a sequence of images creating a full rotation in 60 frames 

Executed Scenarios 

The test is using four scenarios (RGB 8 BPC, No audio) 

 Name Duration Repeated sequence 

1 Spinners FHD 59fps 60 s 
1920×1080 59.94/60 Hz video timing (VIC 16), 

6         ‘          pi  i g-X  vg’ X=      59 

2 Spinners FHD 119fps 60 s 
1920×1080 119.88/120 Hz video timing (VIC 63),  

6         ‘          pi  i g-X  vg’ X=      59 

3 Spinners UHD 59fps 60 s 
3840×2160 59.94/60 Hz video timing (VIC 97) 

6         ‘          pi  i g-X  vg’ X=      59 

4 Spinners UHD 119fps 60 s 
3840×2160 119.88/120 Hz Hz video timing (VIC 120) 

6         ‘          pi  i g-X  vg’ X=      59 
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Playlist: ALLM (HDMI) 
Playlist for demonstrating Auto Low-latency Mode (ALLM) capability of a DUT monitor.  

Video: 

The Scenarios use a series of images: allm_on_off_000.jpg to allm_on_off_0011.jpg. Text panel on 

the images indicate if ALLM is enabled or not. The first scenario is presented with ALLM enabled and 

the second by switching ALLM on and off sequentially. 

Scenarios for HDMI Output 

Video mode in all steps: CTA 1920×1080 60 Hz (VIC 16), RGB 8 BPC, No audio. 

Name Duration Repeated sequence 

ALLM Static 60 sec 

10 frames allm_on_off_000.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_001.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_002.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_003.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_004.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_005.jpg, Packet: allm_0.bin 

ALLM Toggle 60 sec 

10 frames allm_on_off_000.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_001.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_002.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_003.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_004.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_005.jpg, Packet: allm_0.bin; 

10 frames allm_on_off_006.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_007.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_008.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_009.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_0010.jpg, Packet: allm_1.bin; 

10 frames allm_on_off_0011.jpg, Packet: allm_1.bin 
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